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END USER LICENSE AGREEMENT

READ THIS END USER LICENSE AGREEMENT (“AGREEMENT”) BEFORE DOWNLOADING, INSTALLING, OR USING THE SOFTWARE. BY DOWNLOADING,
INSTALLING, OR USING THE SOFTWARE OR OTHERWISE EXPRESSING YOUR AGREEMENT TO THE TERMS CONTAINED HEREIN, YOU (AS CUSTOMER
OR IF YOU ARE NOT THE CUSTOMER, AS A REPRESENTATIVE/AGENT AUTHORIZED TO BIND THE CUSTOMER) CONSENT TO BE BOUND BY THIS
AGREEMENT. IF YOU DO NOT OR CANNOT AGREE TO THE TERMS CONTAINED HEREIN, THEN (A) DO NOT DOWNLOAD, INSTALL, OR USE THE SOFTWARE,
AND (B) YOU MAY CONTACT JUNIPER NETWORKS REGARDING LICENSE TERMS.

1. The Parties. The parties to this Agreement are (i) Juniper Networks, Inc. (if the Customer’s principal office is located in the Americas) or Juniper Networks
(Cayman) Limited (if the Customer’s principal office is located outside the Americas) (such applicable entity being referred to herein as “Juniper”), and (ii)
the person or organization that originally purchased from Juniper or an authorized Juniper reseller the applicable license(s) for use of the Software (“Customer”)
(collectively, the “Parties”).

2. The Software. In this Agreement, “Software” means the program modules and features of the Juniper or Juniper-supplied software, for which Customer
has paid the applicable license or support fees to Juniper or an authorized Juniper reseller, or which was embedded by Juniper in equipment which Customer
purchased from Juniper or an authorized Juniper reseller. “Software” also includes updates, upgrades and new releases of such software. “Embedded
Software” means Software which Juniper has embedded in or loaded onto the Juniper equipment and any updates, upgrades, additions or replacements
which are subsequently embedded in or loaded onto the equipment.

3. License Grant. Subject to payment of the applicable fees and the limitations and restrictions set forth herein, Juniper grants to Customer a non-exclusive
and non-transferable license, without right to sublicense, to use the Software, in executable form only, subject to the following use restrictions:

a. Customer shall use Embedded Software solely as embedded in, and for execution on, Juniper equipment originally purchased by Customer from Juniper
or an authorized Juniper reseller.

b. Customer shall use the Software on a single hardware chassis having a single processing unit, or as many chassis or processing units for which Customer
has paid the applicable license fees; provided, however, with respect to the Steel-Belted Radius or Odyssey Access Client software only, Customer shall use
such Software on a single computer containing a single physical random access memory space and containing any number of processors. Use of the
Steel-Belted Radius or IMS AAA software on multiple computers or virtual machines (e.g., Solaris zones) requires multiple licenses, regardless of whether
such computers or virtualizations are physically contained on a single chassis.

c. Product purchase documents, paper or electronic user documentation, and/or the particular licenses purchased by Customer may specify limits to
Customer’s use of the Software. Such limits may restrict use to a maximum number of seats, registered endpoints, concurrent users, sessions, calls,
connections, subscribers, clusters, nodes, realms, devices, links, ports or transactions, or require the purchase of separate licenses to use particular features,
functionalities, services, applications, operations, or capabilities, or provide throughput, performance, configuration, bandwidth, interface, processing,
temporal, or geographical limits. In addition, such limits may restrict the use of the Software to managing certain kinds of networks or require the Software
to be used only in conjunction with other specific Software. Customer’s use of the Software shall be subject to all such limitations and purchase of all applicable
licenses.

d. For any trial copy of the Software, Customer’s right to use the Software expires 30 days after download, installation or use of the Software. Customer
may operate the Software after the 30-day trial period only if Customer pays for a license to do so. Customer may not extend or create an additional trial
period by re-installing the Software after the 30-day trial period.

e. The Global Enterprise Edition of the Steel-Belted Radius software may be used by Customer only to manage access to Customer’s enterprise network.
Specifically, service provider customers are expressly prohibited from using the Global Enterprise Edition of the Steel-Belted Radius software to support any
commercial network access services.

The foregoing license is not transferable or assignable by Customer. No license is granted herein to any user who did not originally purchase the applicable
license(s) for the Software from Juniper or an authorized Juniper reseller.

4. Use Prohibitions. Notwithstanding the foregoing, the license provided herein does not permit the Customer to, and Customer agrees not to and shall
not: (a) modify, unbundle, reverse engineer, or create derivative works based on the Software; (b) make unauthorized copies of the Software (except as
necessary for backup purposes); (c) rent, sell, transfer, or grant any rights in and to any copy of the Software, in any form, to any third party; (d) remove
any proprietary notices, labels, or marks on or in any copy of the Software or any product in which the Software is embedded; (e) distribute any copy of
the Software to any third party, including as may be embedded in Juniper equipment sold in the secondhand market; (f) use any ‘locked’ or key-restricted
feature, function, service, application, operation, or capability without first purchasing the applicable license(s) and obtaining a valid key from Juniper, even
if such feature, function, service, application, operation, or capability is enabled without a key; (g) distribute any key for the Software provided by Juniper
to any third party; (h) use the Software in any manner that extends or is broader than the uses purchased by Customer from Juniper or an authorized Juniper
reseller; (i) use Embedded Software on non-Juniper equipment; (j) use Embedded Software (or make it available for use) on Juniper equipment that the
Customer did not originally purchase from Juniper or an authorized Juniper reseller; (k) disclose the results of testing or benchmarking of the Software to
any third party without the prior written consent of Juniper; or (l) use the Software in any manner other than as expressly provided herein.

5. Audit. Customer shall maintain accurate records as necessary to verify compliance with this Agreement. Upon request by Juniper, Customer shall furnish
such records to Juniper and certify its compliance with this Agreement.
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6. Confidentiality. The Parties agree that aspects of the Software and associated documentation are the confidential property of Juniper. As such, Customer
shall exercise all reasonable commercial efforts to maintain the Software and associated documentation in confidence, which at a minimum includes
restricting access to the Software to Customer employees and contractors having a need to use the Software for Customer’s internal business purposes.

7. Ownership. Juniper and Juniper’s licensors, respectively, retain ownership of all right, title, and interest (including copyright) in and to the Software,
associated documentation, and all copies of the Software. Nothing in this Agreement constitutes a transfer or conveyance of any right, title, or interest in
the Software or associated documentation, or a sale of the Software, associated documentation, or copies of the Software.

8. Warranty, Limitation of Liability, Disclaimer of Warranty. The warranty applicable to the Software shall be as set forth in the warranty statement that
accompanies the Software (the “Warranty Statement”). Nothing in this Agreement shall give rise to any obligation to support the Software. Support services
may be purchased separately. Any such support shall be governed by a separate, written support services agreement. TO THE MAXIMUM EXTENT PERMITTED
BY LAW, JUNIPER SHALL NOT BE LIABLE FOR ANY LOST PROFITS, LOSS OF DATA, OR COSTS OR PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES,
OR FOR ANY SPECIAL, INDIRECT, OR CONSEQUENTIAL DAMAGES ARISING OUT OF THIS AGREEMENT, THE SOFTWARE, OR ANY JUNIPER OR
JUNIPER-SUPPLIED SOFTWARE. IN NO EVENT SHALL JUNIPER BE LIABLE FOR DAMAGES ARISING FROM UNAUTHORIZED OR IMPROPER USE OF ANY
JUNIPER OR JUNIPER-SUPPLIED SOFTWARE. EXCEPT AS EXPRESSLY PROVIDED IN THE WARRANTY STATEMENT TO THE EXTENT PERMITTED BY LAW,
JUNIPER DISCLAIMS ANY AND ALL WARRANTIES IN AND TO THE SOFTWARE (WHETHER EXPRESS, IMPLIED, STATUTORY, OR OTHERWISE), INCLUDING
ANY IMPLIED WARRANTY OF MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE, OR NONINFRINGEMENT. IN NO EVENT DOES JUNIPER
WARRANT THAT THE SOFTWARE, OR ANY EQUIPMENT OR NETWORK RUNNING THE SOFTWARE, WILL OPERATE WITHOUT ERROR OR INTERRUPTION,
OR WILL BE FREE OF VULNERABILITY TO INTRUSION OR ATTACK. In no event shall Juniper’s or its suppliers’ or licensors’ liability to Customer, whether
in contract, tort (including negligence), breach of warranty, or otherwise, exceed the price paid by Customer for the Software that gave rise to the claim, or
if the Software is embedded in another Juniper product, the price paid by Customer for such other product. Customer acknowledges and agrees that Juniper
has set its prices and entered into this Agreement in reliance upon the disclaimers of warranty and the limitations of liability set forth herein, that the same
reflect an allocation of risk between the Parties (including the risk that a contract remedy may fail of its essential purpose and cause consequential loss),
and that the same form an essential basis of the bargain between the Parties.

9. Termination. Any breach of this Agreement or failure by Customer to pay any applicable fees due shall result in automatic termination of the license
granted herein. Upon such termination, Customer shall destroy or return to Juniper all copies of the Software and related documentation in Customer’s
possession or control.

10. Taxes. All license fees payable under this agreement are exclusive of tax. Customer shall be responsible for paying Taxes arising from the purchase of
the license, or importation or use of the Software. If applicable, valid exemption documentation for each taxing jurisdiction shall be provided to Juniper prior
to invoicing, and Customer shall promptly notify Juniper if their exemption is revoked or modified. All payments made by Customer shall be net of any
applicable withholding tax. Customer will provide reasonable assistance to Juniper in connection with such withholding taxes by promptly: providing Juniper
with valid tax receipts and other required documentation showing Customer’s payment of any withholding taxes; completing appropriate applications that
would reduce the amount of withholding tax to be paid; and notifying and assisting Juniper in any audit or tax proceeding related to transactions hereunder.
Customer shall comply with all applicable tax laws and regulations, and Customer will promptly pay or reimburse Juniper for all costs and damages related
to any liability incurred by Juniper as a result of Customer’s non-compliance or delay with its responsibilities herein. Customer’s obligations under this
Section shall survive termination or expiration of this Agreement.

11. Export. Customer agrees to comply with all applicable export laws and restrictions and regulations of any United States and any applicable foreign
agency or authority, and not to export or re-export the Software or any direct product thereof in violation of any such restrictions, laws or regulations, or
without all necessary approvals. Customer shall be liable for any such violations. The version of the Software supplied to Customer may contain encryption
or other capabilities restricting Customer’s ability to export the Software without an export license.

12. Commercial Computer Software. The Software is “commercial computer software” and is provided with restricted rights. Use, duplication, or disclosure
by the United States government is subject to restrictions set forth in this Agreement and as provided in DFARS 227.7201 through 227.7202-4, FAR 12.212,
FAR 27.405(b)(2), FAR 52.227-19, or FAR 52.227-14(ALT III) as applicable.

13. Interface Information. To the extent required by applicable law, and at Customer's written request, Juniper shall provide Customer with the interface
information needed to achieve interoperability between the Software and another independently created program, on payment of applicable fee, if any.
Customer shall observe strict obligations of confidentiality with respect to such information and shall use such information in compliance with any applicable
terms and conditions upon which Juniper makes such information available.

14. Third Party Software. Any licensor of Juniper whose software is embedded in the Software and any supplier of Juniper whose products or technology
are embedded in (or services are accessed by) the Software shall be a third party beneficiary with respect to this Agreement, and such licensor or vendor
shall have the right to enforce this Agreement in its own name as if it were Juniper. In addition, certain third party software may be provided with the
Software and is subject to the accompanying license(s), if any, of its respective owner(s). To the extent portions of the Software are distributed under and
subject to open source licenses obligating Juniper to make the source code for such portions publicly available (such as the GNU General Public License
(“GPL”) or the GNU Library General Public License (“LGPL”)), Juniper will make such source code portions (including Juniper modifications, as appropriate)
available upon request for a period of up to three years from the date of distribution. Such request can be made in writing to Juniper Networks, Inc., 1194
N. Mathilda Ave., Sunnyvale, CA 94089, ATTN: General Counsel. You may obtain a copy of the GPL at http://www.gnu.org/licenses/gpl.html, and
a copy of the LGPL at http://www.gnu.org/licenses/lgpl.html.

15. Miscellaneous. This Agreement shall be governed by the laws of the State of California without reference to its conflicts of laws principles. The provisions
of the U.N. Convention for the International Sale of Goods shall not apply to this Agreement. For any disputes arising under this Agreement, the Parties
hereby consent to the personal and exclusive jurisdiction of, and venue in, the state and federal courts within Santa Clara County, California. This Agreement
constitutes the entire and sole agreement between Juniper and the Customer with respect to the Software, and supersedes all prior and contemporaneous
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agreements relating to the Software, whether oral or written (including any inconsistent terms contained in a purchase order), except that the terms of a
separate written agreement executed by an authorized Juniper representative and Customer shall govern to the extent such terms are inconsistent or conflict
with terms contained herein. No modification to this Agreement nor any waiver of any rights hereunder shall be effective unless expressly assented to in
writing by the party to be charged. If any portion of this Agreement is held invalid, the Parties agree that such invalidity shall not affect the validity of the
remainder of this Agreement. This Agreement and associated documentation has been written in the English language, and the Parties agree that the English
version will govern. (For Canada: Les parties aux présentés confirment leur volonté que cette convention de même que tous les documents y compris tout
avis qui s'y rattaché, soient redigés en langue anglaise. (Translation: The parties confirm that this Agreement and all related documentation is and will be
in the English language)).
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About This Guide

■ Objectives on page xi

■ Audience on page xi

■ Conventions on page xi

■ List of Technical Publications on page xiii

■ Requesting Technical Support on page xiv

Objectives

Network and Security Manager (NSM) is a software application that centralizes control
and management of your Juniper Networks devices. With NSM, Juniper Networks
delivers integrated, policy-based security and network management for all security
devices.

Intrusion Detection and Prevention (IDP) system uses eight detection methods to
detect malicious network traffic. It is able to drop attacks to prevent damage to your
network and can operate inline as a forwarding gateway, directly in the path of traffic
coming and going on your network.

This guide provides the various steps to configure and manage IDP devices using
NSM. This guide also helps in understanding of how to configure basic and advanced
NSM functionality, including adding new devices, deploying new device configurations,
updating device firmware, viewing log information, and monitoring the status of IDP
devices.

Audience

This guide is intended for the system administrators who are responsible for
configuring IDP devices.

Conventions

This section provides all the documentation conventions that are followed in this
guide. Table 1 on page xiidefines notice icons used in this guide.
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Table 1: Notice Icons

DescriptionMeaningIcon

Indicates important features or instructions.Informational note

Indicates a situation that might result in loss of data or hardware damage.Caution

Alerts you to the risk of personal injury or death.Warning

Alerts you to the risk of personal injury from a laser.Laser warning

Table 2 on page xii defines text conventions used in this guide.

Table 2: Text Conventions

ExamplesDescriptionConvention

■ Issue the clock source command.

■ Specify the keyword exp-msg.

■ Click User Objects

■ Represents commands and keywords
in text.

■ Represents keywords

■ Represents UI elements

Bold typeface like this

user inputRepresents text that the user must type.Bold typeface like this

host1# 
show ip ospf
Routing Process OSPF 2 with Router
 ID 5.5.0.250
Router is an area Border Router 
(ABR)

Represents information as displayed on
the terminal screen.

fixed-width font

Ctrl + dIndicates that you must press two or more
keys simultaneously.

Key names linked with a plus (+)
sign

■ The product supports two levels of
access, user and privileged.

■ clusterID, ipAddress.

■ Emphasizes words

■ Identifies variables

Italics

Object Manager > User Objects > Local
Objects

Indicates navigation paths through the UI
by clicking menu options and links.

The angle bracket (>)

Table 3 on page xiii defines syntax conventions used in this guide.
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Table 3: Syntax Conventions

ExamplesDescriptionConvention

terminal lengthRepresent keywordsWords in plain text

mask, accessListNameRepresent variablesWords in italics

diagnostic | lineRepresent a choice to select one keyword or
variable to the left or right of this symbol. The
keyword or variable can be optional or
required.

Words separated by the pipe ( | )
symbol

[ internal | external ]Represent optional keywords or variables.Words enclosed in brackets ( [ ] )

[ level1 | level2 | 11 ]*Represent optional keywords or variables that
can be entered more than once.

Words enclosed in brackets followed
by and asterisk ( [ ]*)

{ permit | deny } { in | out } {
clusterId | ipAddress }

Represent required keywords or variables.Words enclosed in braces ( { } )

List of Technical Publications

This section provides the list of the documentations required for any additional
information.

Table 4: Network and Security Manager and IDP Device Publications

Details the steps to install the NSM management system on a single server or on separate
servers. It also includes information on how to install and run the NSM user interface. This
guide is intended for IT administrators responsible for the installation and/or upgrade to
NSM.

Network and Security Manager
Installation Guide

Describes how to use and configure key management features in the NSM. It provides
conceptual information, suggested workflows, and examples where applicable. This guide
is best used in conjunction with the NSM Online Help, which provides step-by-step
instructions for performing management tasks in the NSM UI.

This guide is intended for application administrators or those individuals responsible for
owning the server and security infrastructure and configuring the product for multi-user
systems. It is also intended for device configuration administrators, firewall and VPN
administrators, and network security operation center administrators.

Network and Security Manager
Administration Guide

Describes NSM features that relate to device configuration and management. It also explains
how to configure basic and advanced NSM functionality, including deploying new device
configurations, managing Security Policies and VPNs, and general device administration.

Network and Security Manager
Configuring Firewall/VPN Devices
Guide

Provides task-oriented procedures describing how to perform basic tasks in the NSM user
interface. It also includes a brief overview of the NSM system and a description of the GUI
elements.

Network and Security Manager
Online Help

Details the physical features of Juniper Networks Intrusion Detection and Prevention (IDP)
devices. It also explains how to install, configure, update/reimage, and service the IDP
system.

IDP Installation Guide

List of Technical Publications ■ xiii
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Table 4: Network and Security Manager and IDP Device Publications (continued)

Details about the Juniper Networks Intrusion Detection and Prevention (IDP) system that
uses multiple methods to detect and prevent network attacks. IDP is designed to reduce
false positives to ensure that only actual malicious traffic is detected and stopped.

IDP Concepts & Examples Guide

Details about the IDP Reporter that enables you to analyze your enterprise network
thoroughly so you can assess attacks, attackers, and resource utilization.

IDP Reporter User's Guide

Details about how to complete the IDP QuickStart and ACM Wizard which is available
through the IDP Appliance Configuration Manager (ACM) as context-sensitive online help.

IDP ACM Online Help

Details about IDP Detector Engine features and resolved issues in the recent releases. It
also helps you to decide to update the IDP Detector Engine version in your deployment.

IDP Detector Engine Release
Notes

Requesting Technical Support

Technical product support is available through the Juniper Networks Technical
Assistance Center (JTAC). If you are a customer with an active J-Care or JNASC support
contract, or are covered under warranty, and need post-sales technical support, you
can access our tools and resources online or open a case with JTAC.

■ JTAC policies—For a complete understanding of our JTAC procedures and policies,
review the JTAC User Guide located at
http://www.juniper.net/customers/support/downloads/710059.pdf.

■ Product warranties—For product warranty information, visit
http://www.juniper.net/support/warranty/.

■ JTAC Hours of Operation —The JTAC centers have resources available 24 hours
a day, 7 days a week, 365 days a year.

Self-Help Online Tools and Resources

For quick and easy problem resolution, Juniper Networks has designed an online
self-service portal called the Customer Support Center (CSC) that provides you with
the following features:

■ Find CSC offerings: http://www.juniper.net/customers/support/

■ Search for known bugs: http://www2.juniper.net/kb/

■ Find product documentation: http://www.juniper.net/techpubs/

■ Find solutions and answer questions using our Knowledge Base:
http://kb.juniper.net/

■ Download the latest versions of software and review release notes:
http://www.juniper.net/customers/csc/software/

■ Search technical bulletins for relevant hardware and software notifications:
https://www.juniper.net/alerts/

■ Join and participate in the Juniper Networks Community Forum:
http://www.juniper.net/company/communities/

■ Open a case online in the CSC Case Management tool: http://www.juniper.net/cm/
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To verify service entitlement by product serial number, use our Serial Number
Entitlement (SNE) Tool located at https://tools.juniper.net/SerialNumberEntitlementSearch/.

Opening a Case with JTAC

You can open a case with JTAC on the Web or by telephone.

■ Use the Case Management tool in the CSC at http://www.juniper.net/cm/ .

■ Call 1-888-314-JTAC (1-888-314-5822 toll-free in the USA, Canada, and Mexico).

For international or direct-dial options in countries without toll-free numbers, see
http://www.juniper.net/support/requesting support.html

Requesting Technical Support ■ xv
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Part 1

Getting Started

■ Intrusion Detection and Prevention Device and NSM Installation
Overview on page 3

■ Understanding Intrusion Detection and Prevention Device Configuration and
Integration Overview on page 5
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Chapter 1

Intrusion Detection and Prevention Device
and NSM Installation Overview

■ Intrusion Detection and Prevention Device Installation Overview on page 3

■ NSM Installation Overview on page 3

Intrusion Detection and Prevention Device Installation Overview

The Intrusion Detection and Prevention (IDP) device consists of hardware and software
components. You can install the IDP device and start configuring your system using
the following steps:

1. Decide on the physical location of the device.

2. Install the device into your equipment rack.

3. Connect power cables and power on.

4. Perform some initial configuration steps.

5. Install the device license key.

See the installation documentation for your IDP model to install, configure, update,
and service a Juniper Networks IDP device.

Related Topics NSM Installation Overview on page 3■

■ NSM and Intrusion Detection and Prevention Device Management Overview on
page 5

NSM Installation Overview

NSM is a software application that enables you to integrate and centralize
management of your Juniper Networks environment. You need to install two main
software components to run NSM: the NSM management system and the NSM user
interface (UI).

See the Network Security Manager Installation Guide for the steps to install the NSM
management system on a single server or on separate servers. It also includes
information on how to install and run the NSM user interface. The Network Security
Manager Installation Guide is intended for IT administrators responsible for installing
or upgrading to the NSM.
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Related Topics ■ Intrusion Detection and Prevention Device Installation Overview on page 3

■ NSM and Intrusion Detection and Prevention Device Management Overview on
page 5

4 ■ NSM Installation Overview

Configuring Intrusion Detection and Prevention Devices Guide



Chapter 2

Understanding Intrusion Detection and
Prevention Device Configuration and
Integration Overview

■ NSM and Intrusion Detection and Prevention Device Management
Overview on page 5

■ Intrusion Detection and Prevention Services and Device Configurations Supported
in NSM on page 6

■ Adding Intrusion Detection and Prevention Devices in NSM Overview on page 6

■ Adding Intrusion Detection and Prevention Clusters in NSM Overview on page 7

■ Using Templates and Configuration Groups in NSM Overview on page 7

NSM and Intrusion Detection and Prevention Device Management Overview

NSM is the Juniper Networks network management tool that allows distributed
administration of network appliances. You can use the NSM application to centralize
status monitoring, logging, and reporting, and to administer Intrusion Detection
Prevention (IDP) device configurations.

With NSM, you can manage most of the parameters that you can configure through
the IDP admin console. The configuration screens rendered through NSM are similar
to the screens in the IDP admin console. NSM incorporates a broad configuration
management framework that allows co-management using other methods.

After you have completed installation, follow the below steps to get started with
managing IDP device with NSM:

1. Add IDP device to NSM. When you add the IDP device to NSM in first instance,
NSM pushes the policy named Recommended to the device.

2. Update the IDP detector engine and attack object database.

3. Update software version (if necessary).

4. Run the profiler.

5. Examine the logs.

6. Create address objects for IDP rulebase rules.

NSM and Intrusion Detection and Prevention Device Management Overview ■ 5



7. Optionally, configure additional rulebases.

8. If adding these device changes your plan to distribute administrative
responsibility, create NSM users with the access privileges.

Related Topics Intrusion Detection and Prevention Services and Device Configurations Supported
in NSM on page 6

■

■ Adding Intrusion Detection and Prevention Devices in NSM Overview on page
6

Intrusion Detection and Prevention Services and Device Configurations Supported
in NSM

The Intrusion Detection and Prevention (IDP) device supports the following services
in NSM:

■ Inventory management service—NSM enables upgrading license and management
of the IDP hardware details. Adding or deleting licenses or upgrading or
downgrading software are not supported.

■ Status monitoring service—Allows the IDP device’s status to be obtained,
including name, domain, OS version, synchronization status, connection details,
current alarms, CPU, memory, and swap.

■ Logging service—Allows the IDP device’s logs to be obtained in a time-generated
order. Logging configuration details that are set on the IDP device will apply to
NSM.

■ Packaging log files or debug files for remote analysis

■ Managing interface settings such as setting IP addresses, settings IDP device host
and network information, interoperability with NSM, Infranet Controllers, Secure
Access devices, settings deployment mode, enabling layer 2 processing, and so
on. For more information see the ACM online Help.

The following device configurations are not supported:

■ Editing licensing information, although licenses can be viewed

■ Rebooting the IDP device

Related Topics Adding Intrusion Detection and Prevention Clusters in NSM Overview on page
7

■

■ Using Templates and Configuration Groups in NSM Overview on page 7

■ NSM and Intrusion Detection and Prevention Device Management Overview on
page 5

Adding Intrusion Detection and Prevention Devices in NSM Overview

Before NSM can manage IDP devices, you must first add the IDP devices to the
management system using the NSM UI. To add an IDP device, you create an object

6 ■ Intrusion Detection and Prevention Services and Device Configurations Supported in NSM
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in the UI that represents the physical device, and then create a connection between
the UI object and the device so that their information is linked. When you make a
change to the UI device object, you can push that information to the real device so
the two remain synchronized. You can add a single IDP device at a time or add
multiple IDP devices all at once.

For complete details on adding IDP devices, see the Network and Security Manager
Administration Guide.

Related Topics Adding Intrusion Detection and Prevention Clusters in NSM Overview on page
7

■

■ Using Templates and Configuration Groups in NSM Overview on page 7

Adding Intrusion Detection and Prevention Clusters in NSM Overview

In IDP, maximum of two clusters join together to ensure continued network uptime.
The device configurations are synchronized, meaning all cluster members share the
same configuration settings, enabling an IDP device to handle traffic for another if
one device fails.

Adding a cluster is a two-stage process:

■ Add the cluster device object.

■ Add the members of the cluster to the cluster device object.

For complete details on adding IDP clusters, see the Network and Security Manager
Administration Guide.

Related Topics Using Templates and Configuration Groups in NSM Overview on page 7■

■ NSM and Intrusion Detection and Prevention Device Management Overview on
page 5

Using Templates and Configuration Groups in NSM Overview

Use templates to define an IDP device configuration and then reuse that configuration
information across multiple IDP devices. In a template, you need to define only those
configuration parameters that you want to set; you do not need to specify a complete
device configuration.

Templates provide these benefits:

■ You can configure parameter values for an IDP device by referring to one or
more templates when configuring the device.

■ When you change a parameter value in a template and save the template, the
value also changes for all the IDP device configurations that refer to that template,
unless specifically overridden in the device object.

For complete details on using device templates and configuration groups, see the
Network and Security Manager Administration Guide.
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Related Topics ■ NSM and Intrusion Detection and Prevention Device Management Overview on
page 5

■ Intrusion Detection and Prevention Services and Device Configurations Supported
in NSM on page 6

8 ■ Using Templates and Configuration Groups in NSM Overview
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Part 2

Configuring Intrusion Detection and
Prevention Devices

■ Configuring Profiler Settings on page 11

■ Configuring Security Policies on page 25

■ Working with Attack Objects on page 57

■ Configuring SNMP and Syslog Settings on page 75

■ Configuring Anti-Spoof Settings on page 77

■ Configuring Intrusion Detection and Prevention Device Settings on page 79

■ Configuring Additional Intrusion Detection and Prevention Features on page 103
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Chapter 3

Configuring Profiler Settings

■ Configuring Profiler Options (NSM Procedure) on page 11

■ Viewing Profiler Logs (NSM Procedure) on page 15

■ Modifying Profiler Settings (NSM Procedure) on page 20

■ Configuring Profiler Database Preferences (NSM Procedure) on page 21

■ Displaying Profiler Database Information (NSM Procedure) on page 22

■ Querying the Profiler Database (NSM Procedure) on page 22

■ Purging the Profiler Database (NSM Procedure) on page 23

Configuring Profiler Options (NSM Procedure)

You configure Profiler options to enable Profiler features, set network addresses and
applications subject to profiling, and set alerts.

The following topics describe how to configure Profiler options:

■ Specifying General Options on page 11

■ Specifying Tracked Hosts on page 12

■ Specifying Context Targets on page 14

■ Specifying Alert Options on page 14

Specifying General Options

You configure Profiler general options to enable Profiler features.

To specify Profiler general options:

1. From Device Manager, double-click a device and then click Profiler Settings.

2. Click the General tab.

3. Configure Profiler general options using Table 5 on page 12.

4. Click Apply.
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Table 5: Profiler Settings: General Tab

DescriptionSetting

Enables the Profiler.Enable Profiling

Application profiling enables the profiler to collect and track application data. This setting can be
started when you disable it in the profiler setting.

Enable Application
Profiling

Enables the Profiler to perform application volume tracking.Enable Application
Volume Tracking

Enables the Profiler to collect and track specific probes and attempts.Include Probe and
Attempt

Enables the Profiler to collect and track data from external hosts.Include Non-tracked IP
Profiles

Sets the maximum Profiler database size. By default, the maximum database size is 3 GB.db limit (in MB)

Enables the Profiler to perform OS fingerprinting.

OS fingerprinting detects the operating system of an end-host by analyzing TCP handshake packets.

The OS fingerprinting process depends on an established TCP connection (one that has a SYN and
a SYN/ACK).

The OS fingerprinting process is capable of detecting the operating systems listed in
/usr/idp/device/cfg/fingerprints.set.

Enable OS fingerprinting

Sets the time interval (in seconds) that the Profiler refreshes OS fingerprinting. By default, the
Profiler refreshes OS fingerprinting data every 3600 seconds (60 minutes).

Refresh Interval(in secs)

NOTE: If you change Profiler settings, you must push a configuration update to the
device before the new settings take effect. From the Device Manager, right-click the
device, select Update Device, select the Restart IDP Profiler After Device Update
checkbox, and click OK.

Specifying Tracked Hosts

You configure Profiler tracked host and excluded host settings to determine the
network segments where Profiler gathers data.

To configure the tracked host and exclude lists:

1. From Device Manager, double-click a device and then click Profiler Settings.

2. Click the Tracked Hosts tab.

3. Click the + icon and then select Add Host > Add Network or Add Group. A
dialog box appears where you create your tracked hosts list.

4. Configure Profiler tracked host settings using Table 6 on page 13.
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Table 6: Profiler Tracked Hosts/Exclude List Dialog Boxes

DescriptionSetting

Name—Enter the name of the host.Add Host

Color—Select any color from the drop-down list.

Comment—Enter any additional comments.

IP/IP Address—Enter the IP address when you select IP.

Domain/Domain name—Enter the domain name when you select domain name.

Resolve—Resolve the domain name with the IP and vice versa.

Name—Enter the name of the host.Add Network

IP Address—Enter the IP address of the network.

Use Wildcard Mask—Enable this feature of you want to use wildcard mask.

Netmask—Enter the netmask for the IP.

Color—Select any color from the drop-down list.

Comment—Enter any additional comments.

Name—Enter the name of the group.Add Group

Color—Select any color from the drop-down list.

Comment—Enter any additional comments.

Member List—Add or remove the members from the non-members list.

5. Click the Exclude List tab.

6. Click the + icon and then select Add Host > Add Network or Add Group. A
dialog box appears where you create your exclude list.

Table 6 on page 13 describes these dialog box settings.

7. Configure profiler settings using Table 6 on page 13.

8. Click Apply.

NOTE: If you change Profiler settings, you must push a configuration update to the
device before the new settings take effect. From the Device Manager, right-click the
device, select Update Device, select the Restart IDP Profiler After Device Update
checkbox, and click OK.
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Specifying Context Targets

You configure Profiler context settings to determine whether Profiler logs include
not only host and application data but also data pulled from application contexts.
For example, if you specify context targets for FTP usernames, the Profiler logs will
include the username specified for the FTP connection in addition to the host name
and service (FTP).

To specify Profiler context targets:

1. From Device Manager, double-click a device and then click Profiler Settings.

2. Click the Contexts To Profile tab.

3. Browse and select from the predefined list of contexts.

4. Click Apply.

NOTE: If you change Profiler settings, you must push a configuration update to the
device before the new settings take effect. From the Device Manager, right-click the
device, select Update Device, check Restart IDP Profiler After Device Update, and
click OK.

Specifying Alert Options

You configure Profiler alert options to determine whether you receive alerts when
Profiler detects new hosts, protocols, or ports in use.

If you are configuring the Profiler for the first time, do not enable the new host,
protocol, or port alerts. As the Profiler runs, the device views all network components
as new, which can generate unnecessary log records. After the Profiler has learned
about your network and has established a baseline of network activity, you should
reconfigure the device to record new hosts, protocols, or ports discovered on your
internal network.

To specify Profiler alert options:

1. From Device Manager, double-click a device and then click Profiler Settings.

2. Click the Alert tab.

3. Configure alert settings using Table 7 on page 14.

4. Click Apply.

5. Click OK.

Table 7: Profiler Alert Tab

DescriptionSetting

Sends an alert when Profiler detects a new host.New Host Detected
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Table 7: Profiler Alert Tab (continued)

DescriptionSetting

Sends an alert when Profiler detects a new protocol. New Protocol detection alerts are used only
for Layer3 protocols.

New Protocol Detected

Sends an alert when Profiler detects a new port.New Port Detected

Sends an alert to indicate the maximum database size has been reached. After a device reaches
this limit, it begins purging the database.

Database Limit Exceeded

NOTE: If you change Profiler settings, you must push a configuration update to the
device before the new settings take effect. From the Device Manager, right-click the
device, select Update Device, select the Restart IDP Profiler After Device Update
checkbox, and click OK.

Related Topics ■ Configuring Profiler Database Preferences (NSM Procedure) on page 21

■ Querying the Profiler Database (NSM Procedure) on page 22

■ Purging the Profiler Database (NSM Procedure) on page 23

■ Viewing Profiler Logs (NSM Procedure) on page 15

Viewing Profiler Logs (NSM Procedure)

The Profiler Viewer contains multiple tabs with different views of Profiler data. The
following topics describe these views:

■ Application Profiler on page 15

■ Protocol Profiler on page 17

■ Network Profiler on page 18

■ Violation Viewer on page 20

Application Profiler

The Application Profiler tab displays Application Volume Tracking (AVT) data. The
Application Profiler tab is a table of information such as the NSM Log Viewer which
enables you to view and analyze dynamic application (Layer-7) traffic within a specific
context.

The Application Profiler view is divided into two sections:

■ In the left pane, the Application Profiler tab displays a hierarchical tree of
application categories. Applications are grouped by common functionality. For
example, Peer-to-Peer applications include Chat and File Sharing applications.
Under Chat, you can display Yahoo messenger, MSN, and AIM; under File Sharing,
you can display Kazaa, Bittorrent, and Gnutella.
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The left pane also displays aggregate statistics for volume (bytes) and packet
count for the application category, application group, or application you select
in the tree.

■ In the right pane, the Application Profiler tab displays tables of session logs
related to the application category or application you select in the left pane.

Table 8 on page 16 describes Application Profiler session table.

Table 8: Application Profiler Session

DescriptionColumn

Source IP address of the traffic profiled.Src IP

Destination IP address of the traffic profiled.Dst IP

The user associated with the traffic profiled.User

The role group to which the user that is associated with the traffic profiled belongs.Role

All contexts of traffic that the devices selected in the Device table recorded.Context

When you select a context, the values that your devices recorded for a selected context.Value

Source MAC addresses of traffic profiled.Src MAC

Destination MAC addresses of traffic profiled.Dst MAC

Source OUIs of traffic profiled.

NOTE: The Organizationally Unique Identifier (OUI) value is a mapping of the first three bytes of
the MAC address and the organization that owns the block of MACs. You can obtain a list of OUIs
at http://standards.ieee.org/regauth/oui/oui.txt.

Src OUI

Destination OUIs of traffic profiled.Dst OUI

Operating-system version running on the source IP of the traffic profiled.Src OS Name

Operating-system version running on the destination IP of the traffic profiled.Dst OS Name

Number of occurrences that match the traffic profiled.Hits

Timestamp for the first time the device logged the event (within the specified time interval).First Time

Timestamp for the last time the device logged the event (within the specified time interval).Last Time

Domain in which the device is managed in NSM.Domain

Device that profiled the data displayed.Device

By default, the Application Profiler view contains only the data collected during the
configured time interval.
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To display the Application Profiler view:

1. Navigate to Investigate > Security Monitor > Profiler.

2. Click the Application Profiler tab.

TIP: You can jump from the Application Profiler tab to the APE rulebase editor by
right-clicking an application in the left pane and selecting a policy editor option. For
information about using NSM features to sort, filter, and drill down on records, see
the NSM online help.

Protocol Profiler

The Protocol Profiler tab displays information about applications that are running
on your network.

Table 9 on page 17 describes the protocol profiler data.

Table 9: Protocol Profiler Data

DescriptionColumn

Source IP address of the session.

NOTE: Profiler tracks all traffic through the IDP appliance, including traffic for hosts not in your
tracked hosts list. It records a value of 73.78.69.84 for the IP address for hosts not defined in
the Tracked Hosts tab, such as external hosts you would not know and therefore could not
configure.

Src IP

Destination IP address.

NOTE: Communication between an internal host and an external host is recorded only once.
For example, the device records internal host A communicating to http://ca.yahoo.com and
http://edition.cnn.com as one entry in the Profiler DB.

Dst IP

The user associated with the session.User

The role to which the user belongs.Role

Matching contexts.Context

Value retrieved from matching context.Value

Source MAC addresses.Src MAC

Destination MAC addresses.Dst MAC

Source OUI.

NOTE: The Organizationally Unique Identifier (OUI) value is a mapping of the first three bytes
of the MAC address and the organization that owns the block of MACs. You can obtain a list of
OUIs at http://standards.ieee.org/regauth/oui/oui.txt.

Src OUI

Destination OUI.Dst OUI
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Table 9: Protocol Profiler Data (continued)

DescriptionColumn

Operating-system version running on the source IP.Src OS Name

Operating-system version running on the destination IP.Dst OS Name

Number of occurrences that match the session.Hits

Timestamp for the first time the device logged the event (within the specified time interval).First Time

Timestamp for the last time the device logged the event (within the specified time interval).Last Time

NSM domain.Domain

Device through which the session was forwarded.Device

By default, the Protocol Profiler tab contains only the data collected during the
configured time interval.

To display the Protocol Profiler tab:

1. In the NSM navigation tree, select Investigate > Security Monitor > Profiler.

2. Click the Protocol Profiler tab.

TIP: For information about using NSM features to sort, filter, and drill down in records,
see the NSM online Help.

Network Profiler

The Network Profiler view is a table of information such as the NSM Log Viewer
which enables you to view and analyze data related to static traffic (Layer-3, Layer-4,
and RPC protocols, ports, and program numbers) within the context of data
corresponding to peer, host, and operating system.

Table 10 on page 18 describes Network Profiler data.

Table 10: Network Profiler Data

DescriptionColumn

Source IP address of the traffic profiled.Src IP

Destination IP address of the traffic profiled.Dst IP

The user associated with the traffic profiled.User

The role group to which the user that is associated with the traffic profiled belongs.Role
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Table 10: Network Profiler Data (continued)

DescriptionColumn

All services of traffic profiled.Service

Type of the traffic profiled:

■ Access indicates a successful connection, during which the device recorded valid requests and
responses from the server to a client.

■ Attempt indicates a request that did not receive a reply. The device recorded a packet from a
client to a server, but never saw a reply.

■ Probe indicates a request that does not expect a reply. For non-TCP sessions, the device recorded
an ICMP error; for TCP sessions, the device recorded a SYN packet from the client followed by
a RST from the server.

Access Type

Source MAC addresses of traffic profiled.Src MAC

Destination MAC addresses of traffic profiled.Dst MAC

Source OUIs of traffic profiled.

NOTE: OUI stands for Organizationally Unique Identifier. This value is a mapping of the first three
bytes of the MAC address and the organization that owns the block of MACs. You can obtain a list
of OUIs at http://standards.ieee.org/regauth/oui/oui.txt.

Src OUI

Destination OUIs of traffic profiled.Dst OUI

Operating-system version running on the source IP of the traffic profiled.Src OS Name

Operating-system version running on the destination IP of the traffic profiled.Dst OS Name

Number of occurrences that match the traffic profiled.Hits

Timestamp for the first time the device logged the event (within the specified time interval).First Time

Timestamp for the last time the device logged the event (within the specified time interval).Last Time

Domain in which the device is managed in NSM.Domain

Device that profiled the data displayed.Device

To display the Network Profiler view:

1. Navigate to Investigate > Security Monitor > Profiler.

2. Click the Network Profiler tab.

TIP: For information about using NSM features to sort, filter, and drill down on
records, see the NSM online Help.
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Violation Viewer

The Violation Viewer is a filtered view of the Network Profiler view. In the Violation
Viewer, you configure permitted objects. Permitted objects are filtered from the
display, allowing you to focus on unpermitted traffic.

To configure permitted objects:

1. Navigate to Investigate > Security Monitor > Profiler.

2. Click the Violation Viewer tab.

3. Click on the + icon that appears on the top of the right-hand window to display
the New Permitted Object dialog box.

4. Type a name for the permitted object.

5. Within the New Permitted Object dialog box, click the + icon to add a rule to
match source, destination, and services values for the permitted object.

6. To change the source, destination, or service value from Any, right-click the
value and select Add Source, Add Destination, or Add Service.

7. Use the selection controls to select the desired address objects or service objects
and click OK.

8. Click OK to save the permitted object.

The object appears in the filters windows within the Violation Viewer tab.

9. Select the object and click Apply to hide all matching objects from the Violation
Viewer.

TIP: For information about using additional NSM features to sort, filter, and drill
down on records, see the NSM online Help.

Related Topics Configuring Profiler Options (NSM Procedure) on page 11■

■ Displaying Profiler Database Information (NSM Procedure) on page 22

■ Querying the Profiler Database (NSM Procedure) on page 22

Modifying Profiler Settings (NSM Procedure)

You can use the Profiler Settings dialog box to modify Profiler database settings and
default settings for application volume tracking reports.

To modify profiler database and application volume tracking settings:

1. From the NSM main menu, select Tools > Preferences. The New Preferences
dialog box is displayed.

2. Click Profiler Settings.
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3. Modify settings as described in Table 11 on page 21.

4. Click OK.

Table 11: Profiler Settings

DescriptionSetting

Removes the profiler database for the selected size in MB. The default value is
1000 MB.

Purge profiler database if size exceeds (in
MB)

Specifies the maximum size of the purged profiler database. The default value
is 750 MB.

Max profiler database size after purging (in
MB)

Specifies the timeout entry for a profiler query. The default value is 120 seconds.Profiler query timeout (in seconds)

Specifies the time to perform the database optimization. The default value is
00:00 GMT.

Hour of day to perform db optimization
(local time)

Determines the number of sessions displayed in the Application Profiler
application volume tracking session tables.

The default value is 10 sessions. You can specify from 5 to 10,000 sessions.

Number of sessions to display per
application

Determines the hours of application volume tracking data displayed in the
Application Profiler tab session tables.

The default value is 1 hour. You can specify from 1 to 24 hours.

This setting is also a data retention policy. By default, data older than 1 hour is
deleted. If your change to 12 hours, data older than 12 hours is deleted.

Hours of session data to display from
present time

Related Topics Configuring Profiler Options (NSM Procedure) on page 11■

■ Querying the Profiler Database (NSM Procedure) on page 22

Configuring Profiler Database Preferences (NSM Procedure)

Data discovered by Profiler is stored in a database located on the NSM GUI server.

To configure Profiler database preferences:

1. From the NSM main menu, select Tools > Preferences. The New Preferences
dialog box is displayed.

2. Click Profiler Settings.

3. Modify settings as described in Table 11 on page 21.

4. Click OK.
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Table 12: Profiler Database Preferences

DescriptionSetting

Removes the profiler database for the selected size in MB. The default value is
1000 MB.

Purge profiler database if size exceeds (in
MB)

Specifies the maximum size of the purged profiler database. The default value
is 750 MB.

Max profiler database size after purging (in
MB)

Specifies the timeout entry for a profiler query. The default value is 120 seconds.Profiler query timeout (in seconds)

Specifies the time to perform the database optimization. The default value is
00:00 GMT.

Hour of day to perform db optimization
(local time)

Determines the number of sessions displayed in the Application Profiler
application volume tracking session tables.

The default value is 10 sessions. You can specify from 5 to 10,000 sessions.

Number of sessions to display per
application

Determines the hours of application volume tracking data displayed in the
Application Profiler tab session tables.

The default value is 1 hour. You can specify from 1 to 24 hours.

This setting is also a data retention policy. By default, data older than 1 hour is
deleted. If your change to 12 hours, data older than 12 hours is deleted.

Hours of session data to display from
present time

Related Topics Configuring Profiler Options (NSM Procedure) on page 11■

■ Displaying Profiler Database Information (NSM Procedure) on page 22

■ Viewing Profiler Logs (NSM Procedure) on page 15

Displaying Profiler Database Information (NSM Procedure)

Purpose Data discovered by Profiler is stored in a database located on the NSM GUI server.
Use the steps in this procedure to display information about the Profiler database.

Action To display Profiler database information:

1. In the NSM Navigation tree select Investigate > Security Monitor > Profiler.

2. Click the Show DB Information icon in the upper right corner to view specific
details about the Profiler database, including the database size.

Related Topics Configuring Profiler Options (NSM Procedure) on page 11■

■ Configuring Profiler Database Preferences (NSM Procedure) on page 21

■ Querying the Profiler Database (NSM Procedure) on page 22

Querying the Profiler Database (NSM Procedure)

Purpose Data discovered by Profiler is stored in a database located on the NSM GUI server.
Use the steps in this procedure to query the Profiler database.
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Action To query records in the database:

1. Log into the NSM GUI server as the Postgres SQL user. By default, the Postgres
SQL user is netscreen.

2. Navigate to the directory where the Profiler DB is located: /usr/local/nsmpsql/bin.

3. Run any Postgres SQL command. For example, you can type the following
command:

./psql -d profilerDb

Related Topics ■ Configuring Profiler Database Preferences (NSM Procedure) on page 21

■ Configuring Profiler Options (NSM Procedure) on page 11

■ Displaying Profiler Database Information (NSM Procedure) on page 22

■ Purging the Profiler Database (NSM Procedure) on page 23

Purging the Profiler Database (NSM Procedure)

Data discovered by Profiler is stored in a database located on the NSM GUI server.
When the database reaches a maximum size (4 GB by default), it begins purging
records (oldest first) automatically. The Profiler stops purging records when it reaches
a certain set minimum size (3 GB by default).

Use the steps in this procedure to purge the Profiler database, if needed.

To change automatic purge settings, from the NSM main menu select Tools >
Preferences and modify the Profiler database settings.

To manually purge the database:

1. In the NSM Navigation tree, select Investigate > Security Monitor > Profiler.

2. Click the Clear All DB icon in the upper right corner.

Related Topics ■ Configuring Profiler Options (NSM Procedure) on page 11

■ Configuring Profiler Database Preferences (NSM Procedure) on page 21

■ Displaying Profiler Database Information (NSM Procedure) on page 22

■ Querying the Profiler Database (NSM Procedure) on page 22

Purging the Profiler Database (NSM Procedure) ■ 23

Chapter 3: Configuring Profiler Settings



24 ■ Purging the Profiler Database (NSM Procedure)

Configuring Intrusion Detection and Prevention Devices Guide



Chapter 4

Configuring Security Policies

■ Intrusion Detection and Prevention Devices and Security Policies
Overview on page 25

■ Configuring Predefined Security Policies (NSM Procedure) on page 27

■ Creating a New Security Policy (NSM Procedure) on page 28

■ Modifying IDP Rulebase Rules (NSM Procedure) on page 30

■ Configuring Exempt Rulebase Rules (NSM Procedure) on page 39

■ Configuring Backdoor Rulebase Rules (NSM Procedure) on page 41

■ Configuring SYN Protector Rulebase Rules (NSM Procedure) on page 44

■ Configuring Traffic Anomalies Rulebase Rules (NSM Procedure) on page 47

■ Configuring Network Honeypot Rulebase Rules (NSM Procedure) on page 50

■ Configuring Application Rulebase Rules (NSM Procedure) on page 53

Intrusion Detection and Prevention Devices and Security Policies Overview

An IDP security policy defines how the IDP device handles network traffic. It allows
you to enforce various attack detection and prevention techniques on traffic that
traverses your network.

For a detailed explanation of security policy features and components, and for
examples, see the IDP Concepts & Examples Guide.

To create an effective security policy, follow these basic steps:

1. Run the New Policy wizard to create a new security policy object. The new
security policy can be based on a predefined template.

2. Use the Security Policy editor to add one or more rulebases.

A rulebase is an ordered set of rules that use a particular detection method to
identify and prevent attacks.

Table 13 on page 26 describes the IDP security policy rulebases. A security policy
can contain only one instance of any rulebase type.
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Table 13: IDP Security Policy Rulebases

DescriptionRulebase

Enables you to limit bandwidth for specified users and applications and thus helps to manage
network traffic. APE rules do not use attack objects..

Application Rulebase

Protects your network from attacks by using attack objects to detect known and unknown attacks.
Juniper Networks provides predefined attack objects that you can use in IDP rules. You can also
configure your own custom attack objects.

IDP Rulebase

You configure rules in this rulebase to exclude known false positives or to exclude a specific source,
destination, or source/destination pair from matching an IDP rule. If traffic matches a rule in the
IDP rulebase, IDP attempts to match the traffic against the Exempt rulebase before performing
the action specified.

Exempt Rulebase

Protects your network from mechanisms installed on a host computer that facilitates unauthorized
access to the system. Attackers who have already compromised a system typically install backdoors
(such as Trojans) to make future attacks easier. When attackers send and retrieve information to
and from the backdoor program (as when typing commands), they generate interactive traffic
that IDP can detect.

Backdoor Rulebase

Protects your network from SYN-floods by ensuring that the three-way handshake is performed
successfully for specified TCP traffic. If you know that your network is vulnerable to a SYN-flood,
use the SYN-Protector rulebase to prevent it.

SYN Protector Rulebase

Protects your network from attacks by using traffic flow analysis to identify attacks that occur
over multiple connections and sessions (such as scans).

Traffic Anomalies
Rulebase

Protects your network by impersonating open ports on existing servers on your network, alerting
you to attackers performing port scans and other information-gathering activities.

Network Honeypot
Rulebase

3. Within rulebases, configure rules.

Rules are instructions that provide context to detection methods. Rules specify:

■ A source/destination/service match condition that determines which traffic
to inspect

■ Attack objects that determine what to look for (IDP rulebase and Exempt
rulebase)

■ Actions that determine what to do when an attack is detected

■ Notification options, including logs, alerts, and packet captures

Each rulebase can contain up to 40,000 rules.

4. Fine-tune your security policy as you learn more about your network and security
requirements and IDP capabilities.

Related Topics ■ Configuring Predefined Security Policies (NSM Procedure) on page 27

■ Creating a New Security Policy (NSM Procedure) on page 28
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■ Assigning a Security Policy in an Intrusion Detection and Prevention Device (NSM
Procedure) on page 109

■ Troubleshooting Security Policy Validation Errors (NSM Procedure) on page 110

Configuring Predefined Security Policies (NSM Procedure)

The highly respected Juniper Networks Security Center team (J-Security Center)
provides the default IDP security policy—named Recommended. We advise that you
use this policy to protect your network from the likeliest and most dangerous attacks.

Table 14 on page 27 summarizes the properties of the Recommended security policy.

Table 14: Recommended Security Policy Definition

ValueProperty

IDP RulebaseRulebase

9 rules, distinguished by attack objectRules

AnyTraffic source

Default, meaning the matching property is based on the service bindings of the attack object
specified by the rule

Service

AnyDestination

Recommended IP, Recommended TCP, Recommended ICMP, Recommended HTTP,
Recommended SMTP, Recommended DNS, Recommended FTP, Recommended POP3,
Recommended IMAP, Recommended Trojan, Recommended Virus, Recommended Worm

Attacks

Recommended, meaning the action is specified by the attack objectAction

LoggingNotification

If you prefer, you can copy this security policy and use it as a template for a custom
security policy tailored for your network.

Table 15 on page 27 describes other IDP security policy templates.

Table 15: IDP Security Policy Templates

DescriptionTemplate

Includes all attack objects and enables packet logging for all rules.all_with_logging

Includes all attack objects but does not enable packet logging.all_without_logging

Protects a typical DMZ environment.dmz_services

Protects DNS services.dns_server
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Table 15: IDP Security Policy Templates (continued)

DescriptionTemplate

Protects file sharing services, such as SMB, NFS, FTP, and others.file_server

Contains very open rules. Useful in controlled lab environments, but should not be deployed
on heavy traffic live networks.

getting_started

Contains a good blend of security and performance.idp_default

Protects HTTP servers from remote attacks.web_server

If you use these templates, we advise you customize them for your deployment. At
a minimum, you should change the destination IP setting from Any to the IP addresses
for specific servers you want to protect. For more information, see the IDP Concepts
& Examples guide.

Related Topics ■ Intrusion Detection and Prevention Devices and Security Policies Overview on
page 25

■ Creating a New Security Policy (NSM Procedure) on page 28

■ Assigning a Security Policy in an Intrusion Detection and Prevention Device (NSM
Procedure) on page 109

■ Modifying IDP Rulebase Rules (NSM Procedure) on page 30

Creating a New Security Policy (NSM Procedure)

You use the security policy wizard to create a new security policy. The security policies
you create with the wizard must have a new name but can be based on existing
policies or templates.

To create a new security policy:

1. In the NSM navigation tree, select Policy Manager > Security Policies.

2. Select File > New Policy to display the New Policy wizard.

3. On the first page, complete the settings and then click Next. Table 16 on page
28 describes page one fields.

Table 16: New Policy Wizard: Page One

DescriptionSetting

A string to identify the policy.Name

Text to further identify the policy. In the security policy list, you can sort on comments.Comments

4. On the second page, complete the settings and then click Next. Table 17 on page
29 describes page two settings.
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Table 17: New Policy Wizard: Page Two

DescriptionSetting

Select this option to create a new security policy.

If you select this option, the wizard displays the following set of device types:

■ Firewall/VPN

■ Firewall/VPN with IDP

■ Standalone IDP

Select Standalone IDP.

Create new Policy for

Use this option to assign an existing policy to one or more IDP devices.

If you select this option, the wizard displays a drop-down list of existing policies.

Select a policy from the list.

NOTE: This procedure involves creating a new policy. For this procedure, do not select Use Existing
Policy.

Use Existing Policy

5. On the next pages, complete pre-configuration options. Table 18 on page 29
describes your choices. Click Next to advance through the pages.

Table 18: New Policy Wizard: Pre-configuration Options

DescriptionSetting

Select this option to create a new security policy based on a predefined template.

If you select this option, the wizard displays a drop-down list of predefined templates.

Select one and click Next.

Use Predefined Policy
Template

Select this option and complete the rule properties on the next page to generate a policy with the
following features:

■ IDP rulebase

■ Multiple rules matching any source, any destination, and default services

■ Multiple rules are distinguished by the attack object severity group, action, and notification
option you configure in the next wizard page.

Configure IDP Policy

Select this option to create an empty policy that you can later modify.Empty Policy

6. On the next to last page, select IDP devices for which you are designing this
policy. Then click Next.

7. Click Finish to save the policy.
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The new policy appears in the security policy list. For more information, see the IDP
Concepts & Examples guide

Related Topics ■ Intrusion Detection and Prevention Devices and Security Policies Overview on
page 25

■ Configuring Predefined Security Policies (NSM Procedure) on page 27

■ Modifying IDP Rulebase Rules (NSM Procedure) on page 30

■ Assigning a Security Policy in an Intrusion Detection and Prevention Device (NSM
Procedure) on page 109

Modifying IDP Rulebase Rules (NSM Procedure)

This procedure assumes you have used the New Policy wizard to create a basic policy
that you can modify.

The primary IDP security policy rulebase is the IDP rulebase. The IDP rulebase enables
the IDP process engine to inspect matching traffic for signs of an attack.

For background on and examples of IDP rulebase rules, see the IDP Concepts &
Examples Guide.

To modify IDP rulebase rules:

1. In the NSM navigation tree, select Configure > Policy Manager  > Security
Policies.

2. Select the security policy you want to edit.

3. In the security policy pane, select IDP tab to display the IDP rulebase table.

4. To add, delete, copy, or reorder rules, right-click the table cell for the rule number
and make your selection.

5. To modify the property of a rule, right-click the table cell for the property and
make your selection. Table 19 on page 30 lists the rule properties you can modify
and provides references documentation for these properties.

Table 19: IDP Rulebase Rule Properties

ReferenceProperty

Identification number of the IDP rules that you add.ID

You can select the zone from which the source sends traffic to the destination zone.Match

You can select the attacks that you want add IDP to match in the monitored traffic.Look For

Specifies the action you want IDP to perform against the current connection.Action

Specifies the action you want IDP to perform against future connections that use the same IP
address.

IP Action

You can choose none, or enable logging and select the logging options that are appropriate for
your network.

Notification
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Table 19: IDP Rulebase Rule Properties (continued)

ReferenceProperty

Specifies the VLAN tags you want to match in applying the rule.VLAN Tag

You can use the default severity settings of the selected attack objects, or you can choose a specific
severity for your rule.

Severity

Specifies the selected source and destination zone that are available on the security device.Install On

Specifies the optional fields that you can configure in the rule.Optional Fields

Describes any additional comments about the rule.Comments

Following are the updates that you can perform on an IDP rulebase rule:

■ Specifying Rule Match Conditions on page 31

■ Specifying IDP Rulebase Attack Objects on page 33

■ Specifying Rule Session Action on page 34

■ Specifying Rule IP Action on page 35

■ Specifying Rule Notification Options on page 36

■ Specifying Rule VLAN Matches on page 37

■ Specifying Rule Targets on page 37

■ Specifying Rule Severity on page 38

■ Specifying Rule Optional Fields on page 38

■ Specifying Rule Comments on page 39

Specifying Rule Match Conditions

To specify rule match conditions, right-click the table cell and select your setting.

Table 20 on page 31 describes match condition columns for IDP rulebase rules.

Table 20: IDP Rulebase Match Condition Settings

DescriptionColumn

Not applicable for standalone IDP devices.From zone / To zone
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Table 20: IDP Rulebase Match Condition Settings (continued)

DescriptionColumn

Select Address–Display the Select Address dialog box where you can select address objects for
traffic sources.

Source

Any–Matches any source of traffic. To guard against incoming attacks, you typically specify Any.

Negate–Matches any except those specified.

To use address negation:

1. Add the address object.

2. Right-click the address object and select Negate.

Select User Role–Displays the Select User Roles dialog box where you can select or configure user
role matches.

If a value for User Role matches, the Source parameter is not consulted.

User role-based rules are evaluated before IP source rules. If a user role matches, and if the other
match criteria are met, the rule is applied and IP address-based rules are not consulted.

NOTE: Matching based on user role depends on integration with Juniper Networks Infranet
Controllers.

User Role

Select Address–Display the Select Address dialog box where you can select address objects for
destination servers.

Destination

Any–Matches any destination address.

Negate–Specifies any except those specified.

To use address negation:

1. Add the address object.

2. Right-click the address object and select Negate.

Default–Matches the service(s) specified in the rule attack object(s).

If you have enabled the Application Identification (AI) feature, the IDP process engine identifies
services even if they are running on nonstandard ports.

If you have not enabled AI and specify Default, the IDP process engine assumes that standard
ports are used for the service.

NOTE: If you do not enable AI and your service uses nonstandard ports, you must create a custom
service objects.

Service

Any–Matches any service.

Select Service–Display the Select Service dialog box where you can select predefined or custom
service objects.
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Table 20: IDP Rulebase Match Condition Settings (continued)

DescriptionColumn

Enable or Disable–Marks the rule a terminal rule (or clears the mark). If a session matches a
terminal rule, the IDP process engine does not load any subsequent rules. It takes action, if any,
according to the terminal rule.

Terminate

Specifying IDP Rulebase Attack Objects

To add attack objects:

1. Right-click the table cell for attacks and select Select Attacks.

2. In the All Attacks/Groups box, expand Attack Groups.

3. To add attack objects recommended by Juniper Networks Security Center
(J-Security Center), expand Recommended Attacks, browse groups, and select
groups or individual attack objects.

4. To add other predefined attack objects, expand All Attacks, browse groups, and
select groups or individual attack objects.

5. To add attack objects that belong to custom groups, expand the node for the
custom group, browse subgroups, and select groups or individual attack objects.

6. To add custom attack objects that do not belong to groups, expand Attack List
and select from custom attack objects.

7. Click OK.

Table 21 on page 33 describes the attack object group hierarchy for recommended
and predefined attack objects provided by J-Security Center.

Table 21: Attack Object Group Hierarchy

ContentsGroup

Contains two subgroups: anomaly and signature. Within each subgroup, attack objects are grouped
by severity.

Attack Type

Contains subgroups based on category. Within each category, attack objects are grouped by severity.Category

Contains the following subgroups: BSD, Linux, Solaris, and Windows. Within each operating system,
attack objects are grouped by services and severity.

Operating System

Contains the following subgroups: Critical, Major, Minor, Warning, Info. Within each severity,
attack objects are grouped by category.

NOTE: Our severity rating is not based on CVSS (Common Vulnerability Scoring System). We do
include data from Bugtraq (Symantec) and CVE (Common Vulnerabilities and Exposures).

Severity

Contains subgroups based on Web services. Within services, attacked objects are grouped by
severity.

Web Services

Contains attack objects that have a significant affect on IDP performance.Miscellaneous
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Specifying Rule Session Action

Actions are responses to sessions that match the source/destination condition and
attack object pattern. Actions protects your network from attacks.

If a packet triggers multiple rule actions, the IDP device takes the most severe action.
For example, if the rules dictate that a packet will receive a DiffServ marking and be
dropped, and then the packet will be dropped.

To specify a rule action, right-click the table cell and select your setting.

Table 22 on page 34 describes the actions you can set for IDP rulebase rules.

Table 22: IDP Rulebase Actions

DescriptionAction

Predefined attack objects include a recommended action. The recommended action is related to
severity. Table 23 on page 35 lists the recommended actions by severity.

Recommended

IDP inspects for attacks but takes no action against the connection if an attack is found.None

IDP does not inspect for attacks and ignores the connection.Ignore

IDP assigns the indicated service-differentiation value to the packet, and then passes it on normally.
Set the service-differentiation value in the dialog box that appears when you select this action in
the rulebase.

NOTE: The marking has no effect in sniffer mode.

Diffserv Marking

IDP drops a matching packet before it can reach its destination but does not close the connection.
Use this action to drop packets for attacks in traffic that is prone to spoofing, such as UDP traffic.
Dropping a connection for such traffic could result in a DoS that prevents you from receiving traffic
from a legitimate source address.

Drop Packet

IDP drops the connection without sending an RST packet to the sender, preventing the traffic from
reaching its destination. Use this action to drop connections for traffic that is not prone to spoofing.

Drop Connection

IDP closes the connection and sends an RST packet to both the client and the server. If IDP is in
sniffer mode, IDP sends an RST packet to both the client and server but does not close the
connection.

Close Client and Server

IDP closes the connection to the client but not to the server.Close Client

IDP closes the connection to the server but not to the client.Close Server

Table 23 on page 35 describes the logic applied to the value Recommended, a setting
coded in predefined attack objects provided by Juniper Networks Security Center.
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Table 23: IDP Rulebase Actions: Recommended Actions by Severity

Recommended ActionDescriptionSeverity

Drop Packet, Drop ConnectionAttacks attempt to evade an IPS, crash a machine,
or gain system-level privileges.

Critical

Drop Packet, Drop ConnectionAttacks attempt to crash a service, perform a
denial of service, install or use a Trojan, or gain
user-level access to a host.

Major

NoneAttacks attempt to obtain critical information
through directory traversal or information leaks.

Minor

NoneAttacks attempt to obtain noncritical information
or scan the network. They can also be obsolete
attacks (but probably harmless) traffic.

Warning

NoneAttacks are normal, harmless traffic containing
URLs, DNS lookup failures, and SNMP public
community strings. You can use informational
attack objects to obtain information about your
network.

Info

NOTE: Our severity rating is not based on CVSS (Common Vulnerability Scoring
System). We do include data from Bugtraq (Symantec) and CVE (Common
Vulnerabilities and Exposures).

Specifying Rule IP Action

If the IDP device matches an attack, it can take action not only against the current
session but also against future network traffic that uses the same IP address. Such
actions are called IP actions. By default, the specified IP action is permanent (timeout
= 0). If you prefer, you can set a timeout.

To specify an IP action, right-click the table cell and configure options.

Table 24 on page 36 describes IDP rulebase IP actions.
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Table 24: IDP Rulebase IP Actions

DescriptionIP Action

IDP blocks the matching connection and future connections that match combinations of the
following properties you specify:

■ Source IP address

■ Source subnet

■ Protocol

■ Destination IP Address

■ Destination Subnet

■ Destination Port

■ From Zone

IP Block

IDP closes the matching connection and future connections that match combinations of the
following properties you specify:

■ Source IP address

■ Source subnet

■ Protocol

■ Destination IP Address

■ Destination Subnet

■ Destination Port

■ From Zone

IP Close

IDP does not take any action against future traffic but logs the event or sends an alert.IP Notify

Specifying Rule Notification Options

Notification options determine how events that match the rule are logged.

To specify notification options, right-click the table cell and configure options.

Table 25 on page 36 describes IDP rulebase notification options.

Table 25: IDP Rulebase Notification Options

DescriptionOption

You can enable the following delivery and handling options for logs:

■ Send to NSM Log Viewer

■ Send to NSM Log Viewer and flag as an alert

■ Send to an e-mail address list

■ Send to syslog

■ Send to SNMP trap

■ Save in XML format

■ Save in CVS format

■ Process with a script

Event logs and alerts

36 ■ Specifying Rule Notification Options

Configuring Intrusion Detection and Prevention Devices Guide



Table 25: IDP Rulebase Notification Options (continued)

DescriptionOption

Viewing the packets used in an attack on your network can help you determine the extent of the
attempted attack, its purpose, whether or not the attack was successful, and any possible damage
to your network.

If multiple rules with packet capture enabled match the same attack, IDP captures the maximum
specified number of packets. For example, you configure rule 1 to capture 10 packets before and
after the attack, and you configure rule 2 to capture 5 packets before and after the attack. If both
rules match the same attack, IDP attempts to capture 10 packets before and after the attack.

You can capture up to 256 packets before the event and 256 packets after the event.

NOTE: If necessary, you can improve performance by logging only the packets received after the
attack.

Packet captures

Specifying Rule VLAN Matches

If you deploy an IDP device in a virtual local area network (VLAN), you can specify
VLAN tags for traffic in IDP rulebase rules.

Normally, rules match source, destination, and service. If your rule specifies a VLAN
tag, then the rule must also match the VLAN tag.

To specify that rules match a VLAN tag, right-click the table cell and configure your
setting.

Table 26 on page 37 describes VLAN tag settings.

Table 26: IDP Rulebase VLAN Tag Settings

DescriptionOption

Matches only traffic that has no VLAN tag.None

Matches traffic with any or no VLAN tag (default).Any

Displays the Select VLAN Tags dialog box where you can set a single VLAN tag or a range of VLAN
tags.

Select VLAN Tags

Displays a dialog box that prompts you to confirm you want to delete the VLAN tag match setting.Delete VLAN Tags

Specifying Rule Targets

By default, IDP security policy rules can be applied to any IDP device. If you desire,
you can specify that the rule applies to only specified IDP devices.

To specify that the rule only applies to specified devices, right-click the table cell and
select Select Target to display the Select Targeted Devices dialog box, where you
can select the specify devices on which the rule is to be applied.
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Specifying Rule Severity

Severity is a rating of the danger posed by the threat the rule is designed to prevent.

To specify a rule severity, right-click the table cell and select a severity.

Table 27 on page 38 describes rule severity settings.

Table 27: IDP Rulebase Severity

DescriptionSeverity

Select Default to inherit severity from that specified in the attack object.Default

Attacks that attempt to evade an IPS, crash a machine, or gain system-level privileges.

We recommend that you drop the packets or drop the connection for such attacks.

Critical

Attacks that attempt to crash a service, perform a denial of service, install or use a Trojan, or gain
user-level access to a host.

We recommend that you drop the packets or drop the connection for such attacks.

Major

Attacks that attempt to obtain critical information through directory traversal or information leaks.

We recommend that you log such attacks.

Minor

Attacks that attempt to obtain noncritical information or scan the network. They can also be obsolete
attacks (but probably harmless) traffic.

We recommend that you log such attacks.

Warning

Attacks that are normal, harmless traffic containing URLs, DNS lookup failures, and SNMP public
community strings. You can use informational attack objects to obtain information about your
network.

We recommend that you log such attacks.

Info

NOTE: Our severity rating is not based on CVSS (Common Vulnerability Scoring
System). We do include data from Bugtraq (Symantec) and CVE (Common
Vulnerabilities and Exposures).

Specifying Rule Optional Fields

Optional fields are user-defined name-value pairs you can configure if you want to
be able to sort rules based on these fields. Optional fields do not affect the
functionality of the security policy rule.
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To specify optional fields, right-click the table cell and select Edit Options to display
the Select Policy Custom Options dialog box, where you can configure name-value
pairs.

Specifying Rule Comments

Comments are notations about the rule. Comments do not affect the functionality
of the security policy rule.

To specify comments, right-click the table cell and select Edit Comments to display
the Edit Comments dialog box, where you can enter a comment up to 1024 characters
in length.

Related Topics ■ Intrusion Detection and Prevention Devices and Security Policies Overview on
page 25

■ Configuring Predefined Security Policies (NSM Procedure) on page 27

■ Configuring Exempt Rulebase Rules (NSM Procedure) on page 39

■ Assigning a Security Policy in an Intrusion Detection and Prevention Device (NSM
Procedure) on page 109

Configuring Exempt Rulebase Rules (NSM Procedure)

The exempt rulebase contains rules that prevent rules in the Intrusion Detection and
Prevention (IDP) rulebase from matching specific source or destination pairs for
specific attack objects.

The exempt rulebase works in conjunction with the IDP rulebase. Before you can
create exempt rules, you must first create rules in the IDP rulebase. If traffic matches
a rule in the IDP rulebase, the IDP sensor attempts to match the traffic against the
exempt rulebase before performing the specified action or creating a log record for
the event.

NOTE: The exempt rulebase is a non-terminal rulebase. The IDP device checks all
rules in the exempt rulebase and executes all matches.

To configure an exempt rulebase rule:

1. In the NSM navigation tree, select Policy Manager > Security Policies.

2. Select and double-click the security policy for which you want to add an exempt
rulebase rule.

3. Click New in the upper right corner of the policy viewer and select Add Exempt
Rulebase.

4. Click the New button within the rules viewer to add a rule.
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5. Modify the property of the rule by right-clicking the table cell for the property
and making your modifications.

6. Configure or modify the rule using the settings described in Table 28 on page
40.

Table 28:  Exempt Rulebase Rule Properties

Your ActionFunctionOption

Right-click the table cell for the
rule number and make your
required modifications.

Specifies if you want to add,
delete, copy, or reorder rules.

No

Select one or more zones for the
source zone, or you can specify
any for all source zones.

NOTE: The selected zone must be
available on the security device
specified in the Install On column.

Specifies the zone from
where the source sends
traffic.

Match > From Zone

Select any to monitor network
traffic originating from any IP
address.

NOTE: You can also negate one
or more address objects to specify
all sources except the excluded
object.

Specifies the address object
that is the source of the
traffic.

Match > Source

Select the destination zone.Specifies the destination
zone.

Match > To Zone

Select the destination object.

NOTE: You can also negate one
or more address objects to specify
all destinations except the
excluded object.

Specifies the address object
that is the destination of the
traffic, typically a server or
other device on your
network.

Match > Destination

Select the attack objects or groups.

NOTE: You must include at least
one attack object in an exempt
rule.

Specifies the attack(s) you
want the IDP to exempt for
the specified source or
destination addresses.

Attacks
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Table 28:  Exempt Rulebase Rule Properties (continued)

Your ActionFunctionOption

Set a value by selecting any of the
following options:

■ Any—This rule is applied to
messages in any VLAN and
to messages without a VLAN
tag.

■ None—This rule is applied
only to messages that do not
have a VLAN tag.

■ Select VLAN Tags—This rule
pecifies which VLAN tags the
rule applies to.

Specifies that you can
configure a rule to only apply
to messages in certain VLANs.

VLAN Tag

Select the target security device.

NOTE: You can also select
multiple security devices on which
to install the rule.

Specifies the security devices
or templates that receive and
use this rule.

Install On

Enter any additional comments
about the rule.

Specifies any miscellaneous
comment about the rule's
purpose.

Comments

For more information, see the IDP Concepts & Examples guide.

Related Topics ■ Intrusion Detection and Prevention Devices and Security Policies Overview on
page 25

■ Creating a New Security Policy (NSM Procedure) on page 28

■ Assigning a Security Policy in an Intrusion Detection and Prevention Device (NSM
Procedure) on page 109

■ Configuring Backdoor Rulebase Rules (NSM Procedure) on page 41

Configuring Backdoor Rulebase Rules (NSM Procedure)

The backdoor rulebase detects if there exists any interactive traffic introduced during
backdoor attacks.

To configure a backdoor rulebase rule:

1. In the NSM navigation tree, select Policy Manager > Security Policies.

2. Select and double-click the security policy to which you want to add the backdoor
rulebase rule.

3. Click New in the upper right corner of the policy viewer and select Add Backdoor
Rulebase.

4. Click the New button within the rules viewer to add a rule.
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5. Modify the property of the rule by right-clicking the table cell for the property
and making your modifications.

6. Configure or modify the rule using the settings described in Table 29 on page
42.

Table 29:  Backdoor Rulebase Rule Properties

Your ActionFunctionOption

Right-click the table cell for the
rule number and make your
required modifications.

Specifies if you want to add,
delete, copy, or reorder rules.

No

Select any to monitor network
traffic originating from any IP
address.

NOTE: You can also negate one
or more address objects to specify
all sources except the excluded
object.

Specifies the address object
that is the source of the
traffic.

Match > Source

Select the destination object.

NOTE: You can also negate one
or more address objects to specify
all destinations except the
excluded object.

Specifies the address object
that is the destination of the
traffic, typically a server or
other device on your
network.

Match > Destination

Set a service by selecting any of
the following options:

■ Any—Sets any service.

■ Default—Accepts the service
specified by the attack object.

■ Select Service—Chooses
specific services from the list
of defined service objects.

Specifies service objects in
rules to service an attack to
access your network.

Match > Service

Select either Detect or Ignore.Specifies whether to detect or
ignore the backdoor traffic.

Operation

Select any type of action.Specifies an action of the IDP
to detect any interactive
traffic.

Action

Select Configure to create log
records.

Allows you to create log
records with attack
information that you can view
real-time in the Log Viewer.

Notification
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Table 29:  Backdoor Rulebase Rule Properties (continued)

Your ActionFunctionOption

Set a value by selecting any of the
following options:

■ Any—This rule is applied to
messages in any VLAN and
to messages without a VLAN
tag.

■ None—This rule is applied
only to messages that do not
have a VLAN tag.

■ Select VLAN Tags—This rule
specifies which VLAN tags
the rule applies to.

Specifies that you can
configure a rule to only apply
to messages in certain VLANs.

VLAN Tag

Set the severity to Default, Info,
Warning, Minor, Major, or
Critical.

NOTE: This column only appears
when you view the Security Policy
in Expanded Mode.

Specifies if you can override
the inherent attack severity
on a per-rule basis within the
IDP rulebase.

Severity

Select the target security device.

NOTE: You can also select
multiple security devices on which
to install the rule.

Specifies the security devices
or templates that receive and
use this rule.

Install On

Enter any additional comments
about the rule.

Specifies any miscellaneous
comment about the rule's
purpose.

Comments

For more information, see the IDP Concepts & Examples guide.

Related Topics ■ Intrusion Detection and Prevention Devices and Security Policies Overview on
page 25

■ Modifying IDP Rulebase Rules (NSM Procedure) on page 30

■ Configuring SYN Protector Rulebase Rules (NSM Procedure) on page 44

■ Assigning a Security Policy in an Intrusion Detection and Prevention Device (NSM
Procedure) on page 109
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Configuring SYN Protector Rulebase Rules (NSM Procedure)

The SYN protector rulebase protects your network from malicious SYN-flood attacks.

To configure a SYN protector rulebase rule:

1. In the NSM navigation tree, select Policy Manager > Security Policies.

2. Select and double-click the security policy to which you want to add the SYN
protector rulebase rule.

3. Click New in the upper right corner of the policy viewer and select Add SYN
Protector Rulebase.

4. Click the New button within the rules viewer to add a rule.

5. Modify the property of the rule by right-clicking the table cell for the property
and making your modifications.

6. Configure or modify the rule using the settings described in Table 30 on page
44.

Table 30:  SYN Protector Rulebase Rule Properties

Your ActionFunctionOption

Right-click the table cell for the
rule number and make your
required modifications.

Specifies if you want to add,
delete, copy, or reorder rules.

No

Select any to monitor network
traffic originating from any IP
address.

NOTE: You can also negate one
or more address objects to specify
all sources except the excluded
object.

Specifies the address object
that is the source of the
traffic.

Match > Source

Select the destination object.

NOTE: You can also negate one
or more address objects to specify
all destinations except the
excluded object.

Specifies the address object
that is the destination of the
traffic, typically a server or
other device on your
network.

Match > Destination

Set a service by selecting any of
the available options.

NOTE: We recommend that you
do not change the default value,
TCP-ANY.

Specifies service objects in
rules to service an attack to
access your network.

Match > Service
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Table 30:  SYN Protector Rulebase Rule Properties (continued)

Your ActionFunctionOption

Select any of the following
options:

■ None—Specifies that IDP
takes no action and does not
participate in the three-way
handshake.

■ Relay—Specifies that IDP
acts as the middleman or
relay, for the connection
establishment, performing
the three-way handshake
with the client host on behalf
of the server.

NOTE: Relay mode might note
work as expected for MPLS traffic.
When the IDP engine processes
MPLS traffic, it stores the MPLS
label information for traffic in
each direction. In the case of
traffic that matches SYN Protector
rules in relay mode, the IDP
appliance is programmed to send
a SYN-ACK before the traffic has
reached the server. In these cases,
the IDP engine does not have
server-to-client MPLS label
information. Therefore, the
SYN-ACK packet does not include
an MPLS label. Some MPLS routers
can add packets without a label to
an existing MPLS tunnel; others
drop such packets.

■ Passive—Specifies that IDP
handles the transfer of
packets between the client
host and the server, but does
not actively prevent the
connection from being
established.

Specifies the mode that
indicates how IDP handles
TCP traffic.

Mode
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Table 30:  SYN Protector Rulebase Rule Properties (continued)

Your ActionFunctionOption

Select Configure to create log
records.

NOTE: The Configure menu option
does not appear if the Mode
column is set to None.

■ Select Logging to have a log
record created each time the
rule is matched.

■ Select Alert to have an alert
flag placed in the Alert
column of the Log Viewer for
the matching log record.

■ In the Log Actions tab, select
desired log actions, if any.

Allows you to create log
records with attack
information that you can view
real-time in the Log Viewer.

NOTE: For more critical
attacks, you can also set an
alert flag to appear in the log
record.

Notification

Set a value by selecting any of the
following options:

■ Any—This rule is applied to
messages in any VLAN and
to messages without a VLAN
tag.

■ None—This rule is applied
only to messages that do not
have a VLAN tag.

■ Select VLAN Tags—This rule
specifies which VLAN tags
the rule applies to.

Specifies that you can
configure a rule to only apply
to messages in certain VLANs.

VLAN Tag

Set the severity to Default, Info,
Warning, Minor, Major, or
Critical.

NOTE: This column only appears
when you view the Security Policy
in Expanded Mode.

Specifies if you can override
the inherent attack severity
on a per-rule basis within the
IDP rulebase.

Severity

Select the target security device.

NOTE: You can also select
multiple security devices on which
to install the rule.

Specifies the security devices
or templates that receive and
use this rule.

Install On

Enter any additional comments
about the rule.

Specifies any miscellaneous
comment about the rule's
purpose.

Comments

For more information, see the IDP Concepts & Examples guide.
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Related Topics ■ Intrusion Detection and Prevention Devices and Security Policies Overview on
page 25

■ Modifying IDP Rulebase Rules (NSM Procedure) on page 30

■ Configuring Traffic Anomalies Rulebase Rules (NSM Procedure) on page 47

■ Assigning a Security Policy in an Intrusion Detection and Prevention Device (NSM
Procedure) on page 109

Configuring Traffic Anomalies Rulebase Rules (NSM Procedure)

The traffic anomalies rulebase employs a traffic flow analysis method to detect attacks
that occur over multiple connections and sessions (such as scans).

To configure a traffic anomalies rulebase rule:

1. In the NSM navigation tree, select Policy Manager > Security Policies.

2. Select and double-click the security policy to which you want to add the traffic
anomalies rulebase rule.

3. Click New in the upper right corner of the policy viewer and select Add Traffic
Anomalies Rulebase.

4. Click the New button within the rules viewer to add a rule.

5. Modify the property of the rule by right-clicking the table cell for the property
and making your modifications.

6. Configure or modify the rule using the settings described in Table 31 on page
47.

Table 31:  Traffic Anomalies Rulebase Rule Properties

Your ActionFunctionOption

Right-click the table cell for the
rule number and make your
required modifications.

Specifies if you want to add,
delete, copy, or reorder rules.

No

Select any to monitor network
traffic originating from any IP
address.

NOTE: You can also negate one
or more address objects to specify
all sources except the excluded
object.

Specifies the address object
that is the source of the
traffic.

Match > Source

Select the destination object.

NOTE: You can also negate one
or more address objects to specify
all destinations except the
excluded object.

Specifies the address object
that is the destination of the
traffic, typically a server or
other device on your
network.

Match > Destination
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Table 31:  Traffic Anomalies Rulebase Rule Properties (continued)

Your ActionFunctionOption

Set a service by selecting any of
the available options.

NOTE: We recommend that you
do not change the default value,
TCP-ANY.

Specifies service objects in
rules to service an attack to
access your network.

Match > Service

Select any of the following
options:

■ Ignore—IDP ignores this
traffic. This option excludes
traffic from trusted sources
that might be falsely
construed as a scan.

■ Detect—IDP matches this
traffic and takes the IP action
that you have set.

When you select this option,
the Traffic Anomalies dialog
box appears. Select the scans
or sweep you want to detect
and enter values for Port
Count and Time Threshold
(in seconds) or Session
Count.

Specifies how IDP is to treat
the matching traffic.

Traffic Anomaly

Select Configure to do any one of
the following actions:

■ Enabled—Enables IP actions.

■ Action—Specifies the action
you want the IDP to take.

■ Block—Specifies which
parameters IDP will use to
close or block further
connections from the drop
down list.

■ Logging—Specifies the log
action for a matching event.

■ Timeout (sec)—Specifies the
number of seconds that this
action remains in effect on
IDP after a traffic match.

Allows you to log, drop, or
close the current connection
for each attack that matches
a rule.

IP Action
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Table 31:  Traffic Anomalies Rulebase Rule Properties (continued)

Your ActionFunctionOption

Select Configure to create log
records.

NOTE: The Configure menu option
does not appear if the Mode
column is set to None.

■ Select Logging to have a log
record created each time the
rule is matched.

■ Select Alert to have an alert
flag placed in the Alert
column of the Log Viewer for
the matching log record.

■ In the Log Actions tab, select
desired log actions, if any.

Allows you to create log
records with attack
information that you can view
real-time in the Log Viewer.

NOTE: For more critical
attacks, you can also set an
alert flag to appear in the log
record.

Notification

Set a value by selecting any of the
following options:

■ Any—This rule is applied to
messages in any VLAN and
to messages without a VLAN
tag.

■ None—This rule is applied
only to messages that do not
have a VLAN tag.

■ Select VLAN Tags—Specifies
which VLAN tags the rule
applies to.

Specifies that you can
configure a rule to only apply
to messages in certain VLANs.

VLAN Tag

Set the severity to Default, Info,
Warning, Minor, or Critical.

NOTE: This column only appears
when you view the Security Policy
in Expanded Mode.

Specifies if you can override
the inherent attack severity
on a per-rule basis within the
IDP rulebase.

Severity

Select the target security device.

NOTE: You can also select
multiple security devices on which
to install the rule.

Specifies the security devices
or templates that receive and
use this rule.

Install On

Enter any additional comments
about the rule.

Specifies any miscellaneous
comment about the rule's
purpose.

Comments

For more information, see the IDP Concepts & Examples guide.

Related Topics ■ Intrusion Detection and Prevention Devices and Security Policies Overview on
page 25

■ Modifying IDP Rulebase Rules (NSM Procedure) on page 30
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■ Configuring Network Honeypot Rulebase Rules (NSM Procedure) on page 50

■ Assigning a Security Policy in an Intrusion Detection and Prevention Device (NSM
Procedure) on page 109

Configuring Network Honeypot Rulebase Rules (NSM Procedure)

The network honeypot rulebase is a method to detect investigation activities.

To configure a network honeypot rulebase rule:

1. In the NSM navigation tree, select Policy Manager > Security Policies.

2. Select and double-click the security policy to which you want to add the network
honeypot rulebase rule.

3. Click New in the upper right corner of the policy viewer and select Add Network
Honeypot Rulebase.

4. Click the New button within the rules viewer to add a rule.

5. Modify the property of the rule by right-clicking the table cell for the property
and making your modifications.

6. Configure or modify the rule using the settings described in Table 32 on page
50.

Table 32: Network Honeypot Rulebase Rule Properties

Your ActionFunctionOption

Right-click the table cell for the
rule number and make your
required modifications.

Specifies if you want to add,
delete, copy, or reorder rules.

No

Select any source address or
group.

Specifies the address object
that is the source of the
traffic.

Source Address

Select the destination object.

NOTE: You can also negate one
or more address objects to specify
all destinations except the
excluded object.

Specifies the address object
that is the destination of the
traffic, typically a server or
other device on your
network.

Impersonate > Destination

Select the services you want to
monitor.

Specifies the services running
on your network.

Impersonate > Service
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Table 32: Network Honeypot Rulebase Rule Properties (continued)

Your ActionFunctionOption

Select any of the following
options:

■ Ignore—This option allows
free passage on your network
when creating rules for
trusted traffic.

■ Impersonate—IDP creates a
fake port open to the public
based on the destination IP
addresses and service you
selected.

Specifies whether or not IDP
fakes open ports.

Operation

Select Configure to do any one of
the following actions:

■ Enabled—Enable IP actions.

■ Action—Specifies the action
you want the IDP to take.

■ Block—Specifies which
parameters IDP will use to
close or block further
connections from the
drop-down list.

■ Logging—Specifies the log
action for a matching event.

■ Timeout (sec)—Specifies the
number of seconds that this
action remains in effect on
IDP after a traffic match.

Allows you to log, drop, or
close the current connection
for each attack that matches
a rule.

IP Action

Select Configure to create log
records.

NOTE: The Configure menu option
does not appear if the Mode
column is set to None.

■ Select Logging to have a log
record created each time the
rule is matched.

■ Select Alert to have an alert
flag placed in the Alert
column of the Log Viewer for
the matching log record.

■ In the Log Actions tab, select
desired log actions, if any.

Allows you to create log
records with attack
information that you can view
real-time in the Log Viewer.

NOTE: For more critical
attacks, you can also set an
alert flag to appear in the log
record.

Notification
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Table 32: Network Honeypot Rulebase Rule Properties (continued)

Your ActionFunctionOption

Set a value by selecting any of the
following options:

■ Any—This rule is applied to
messages in any VLAN and
to messages without a VLAN
tag.

■ None—This rule is applied
only to messages that do not
have a VLAN tag.

■ Select VLAN Tags—This rule
specifies which VLAN tags
the rule applies to.

Specifies that you can
configure a rule to only apply
to messages in certain VLANs.

VLAN Tag

Set the severity to Default, Info,
Warning, Minor, Major, or
Critical.

NOTE: This column only appears
when you view the Security Policy
in Expanded Mode.

Specifies if you can override
the inherent attack severity
on a per-rule basis within the
IDP rulebase.

Severity

Select the target security device.

NOTE: You can also select
multiple security devices on which
to install the rule.

Specifies the security devices
or templates that receive and
use this rule.

Install On

Enter any additional comments
about the rule.

Specifies any miscellaneous
comment about the rule's
purpose.

Comments

NOTE: The IDP drops MPLS traffic that matches a Network Honeypot rule. When the
IDP engine processes MPLS traffic, it stores the MPLS label information. It stores
separate labels for client-to-server and server-to-client communication. In the case
of traffic that matches Network Honeypot rules, there is no genuine server-to-client
communication, so the IDP engine does not have server-to-client MPLS label
information. Therefore, the impersonation operation is not supported.

For more information, see the IDP Concepts & Examples guide.

Related Topics ■ Intrusion Detection and Prevention Devices and Security Policies Overview on
page 25

■ Modifying IDP Rulebase Rules (NSM Procedure) on page 30

■ Assigning a Security Policy in an Intrusion Detection and Prevention Device (NSM
Procedure) on page 109

■ Validating a Security Policy (NSM Procedure) on page 110
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Configuring Application Rulebase Rules (NSM Procedure)

The Application Policy Enforcement (APE) rulebase enables you to limit bandwidth
for specified users and/or applications. You can configure APE rules to detect network
traffic based on application signatures. The APE rules are sent as part of the IDP
rulebase, and the attacks are mapped from the corresponding application.

To configure an APE rulebase rule:

1. In the NSM navigation tree, select Policy Manager > Security Policies.

2. Select and double-click the security policy to which you want to add the APE
rulebase rule.

3. Click New in the upper right corner of the policy viewer and select Add
Application Rulebase.

4. Click the New button within the rules viewer to add a rule

5. Modify the property of the rule by right-clicking the table cell for the property
and making your modifications.

6. Configure or modify the rule using the settings described in Table 33 on page
53.

7. Click OK to save your changes.

Table 33:  APE Rulebase Rule Properties

Your ActionFunctionOption

Right-click the table cell for the rule number
and make your required modifications.

Specifies if you want to add, delete, copy,
or reorder rules.

No.

Select any to monitor network traffic
originating from any IP address.

NOTE: For guidelines on specifying match
parameters, see the IDP Concepts and Examples
Guide.

Specifies the address object that is the
source of the traffic.

Match > Source

Right-click the table cell to select user roles.Specifies the user roles to match the
session for the rule to be applied. If a value
for User Role matches, the Source
parameter is not consulted.

Matching based on user role depends on
integration with a compatible Juniper
Networks IC Series Unified Access Control
appliance.

Match > User Role

Select the destination object.

NOTE: You can also negate one or more
address objects to specify all destinations
except the excluded object.

Specifies the address object that is the
destination of the traffic, typically a server
or other device on your network.

Match > Destination
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Table 33:  APE Rulebase Rule Properties (continued)

Your ActionFunctionOption

Right-click the table cell and select any one of
the required options.

If you specify named values for both service
and application, only the application value is
used.

It is recommended to specify Default for the
service parameter and configure the
application parameter instead.

Specify Any to not use service as a key to your
match.

NOTE: To apply an APE action to all traffic
matching source and destination parameters,
set both the service parameter and the
application parameter to Any..

Requires one of the specified services to
match the session for the rule to be
applied. Services are Application Layer
protocols that define how data is structured
as it travels across the network. The IDP
engine can inspect services that use TCP,
UDP, RPC, and ICMP transport layer
protocols. If the application running on the
destination server uses standard ports, you
can select from predefined services. If the
application running on the destination
server uses nonstandard ports, you must
create a custom service object.

Match > Service

Right-click the table cell and make your
required modifications.

If you specify named values for both service
and application, only the application value is
used.

Specify Any to not use application as a key to
your match.

NOTE: To apply an APE action to all traffic
matching source and destination parameters,
set both the service parameter and the
application parameter to Any.

Requires one of the specified applications
to match the session for the rule to be
applied. The predefined list of applications
is populated by the application
identification feature. The application
identification feature identifies the
application regardless of port.
Port-independent application identification
simplifies rule configuration and ensures
that you do not miss applications running
on nonstandard ports. Hence it is
recommended to use the application
parameter instead of the service parameter
whenever possible.

Match > Application
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Table 33:  APE Rulebase Rule Properties (continued)

Your ActionFunctionOption

Right-click the table cell and select any one of
the following options:

■ None — IDP takes no action against the
connection.

■ Drop Packet — IDP drops a matching
packet before it can reach its destination
but does not close the connection.

■ Drop Connection — IDP drops the
connection without sending an RST
packet to the sender, preventing the
traffic from reaching its destination.

■ Close Client — IDP closes the connection
to the client and not to the server.

■ Close Server — IDP closes the connection
to the server and not to the client.

■ Close Client and Server — IDP closes the
connection and sends a RST packet to
both the client and the server.

■ Diffserv Marking — Assigns the service
differentiation value indicated to the
packet, then passes it on normally.

■ Rate Limiting — IDP enforces a rate limit
for all current sessions that match the rule
(separate limits for client-to-server and
server-to-client traffic). If the limit has not
been reached, IDP forwards the packets.
If the limit has been reached, IDP behaves
as if no bandwidth is available.

Specifies which actions to perform against
attacks that match rules in your security
policy.

Action

Right-click the table cell and select Configure
to display a dialog box where you can
configure logging options.

Specifies logging options. Packet capture
is not applicable for APE rulebase rules.

Notification

Right-click the table cell to assign a VLAN
object to a rule or to set the VLAN tag value to
none.

Specifies rules to traffic on certain VLANs.
Normally, for a rule to take effect, it must
match the packet source, destination,
service, and attack objects. If the VLAN cell
is populated with a value other than any,
then the rule will also consider the packet’s
VLAN tag when determining a match.

VLAN Tag

Right-click the table cell and select Select
Target to display a dialog box to specify the
IDP devices to which the rule can be installed.

Specifies target IDP devices for the rule.
By default, IDP security policy rules can
be applied to any IDP device.

Install On

Right-click the table cell and select Edit
Comments to display a dialog box where you
can make notations about the rule.

Adds notations about the rule. This setting
is optional and does not affect the
functionality of the security policy rule.

Comments

You can verify the APE rulebase functionality in your lab and view APE related
statistics in the Command-Line Interface (CLI). It is recommended that you retain
defaults for APE rulebase. By default:
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■ IDP does not limit the rate of sessions that do not match APE rules. Rate limiting
is done by service based till application is identified in the session i.e. default
services running on the port.

■ When the application identification feature fails to identify the application, IDP
does not try to match the rule but instead applies the default rate limit (if any).
You can modify this so that in cases where application identification fails, IDP
attempts to match the session to the standard protocol and port for the
application.

For more information, see the IDP Concepts & Examples guide.

Related Topics ■ Intrusion Detection and Prevention Devices and Security Policies Overview on
page 25

■ Modifying IDP Rulebase Rules (NSM Procedure) on page 30
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Chapter 5

Working with Attack Objects

■ Attack Objects in Intrusion Detection and Prevention Security Policies
Overview on page 57

■ Loading J-Security-Center Updates (NSM Procedure) on page 58

■ Viewing Predefined Attack Objects (NSM Procedure) on page 60

■ Working with Attack Groups (NSM Procedure) on page 60

■ Creating Custom Attack Objects (NSM Procedure) on page 63

■ Verifying the Attack Object Database Version (NSM Procedure) on page 71

■ Updating the IDP Detector Engine (NSM Procedure) on page 72

Attack Objects in Intrusion Detection and Prevention Security Policies Overview

You use the NSM Object Manager to manage NSM administrative objects, including
the attack objects used in IDP security policies.

For more explanation of attack objects and examples, see the Network and Security
Manager Administration Guide.

For details on how to use NSM Object Manager features to copy objects, find
references to objects, search for unused objects, or configure object versions, see
the NSM online Help.

IDP administration using attack objects can include the following tasks related to
attack objects:

■ Updating IDP detector engine and the NSM attack database

■ Viewing predefined attack object definitions

■ Viewing attack object groups

■ Creating custom attack objects

■ Updating predefined IDP attack objects and groups

Related Topics Working with Attack Groups (NSM Procedure) on page 60■

■ Viewing Predefined Attack Objects (NSM Procedure)

■ Loading J-Security-Center Updates (NSM Procedure) on page 58
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Loading J-Security-Center Updates (NSM Procedure)

The Juniper Networks Security Center (J-Security Center) routinely makes important
updates available to IDP security policy components, including updates to the IDP
detector engine and NSM attack database.

The IDP detector engine is a dynamic protocol decoder that includes support for
decoding more than 60 protocols and more than 500 service contexts. You should
update IDP detector engine when you first install the IDP device, whenever you
upgrade, and whenever alerted to do so by Juniper Networks.

The NSM attack database stores data definitions for the attack objects that are key
components of IDP security policies. Updates can include new attack objects, revised
severity settings, or removed attack objects. You should schedule daily updates to
the NSM attack database.

After you have completed the update, any new attack objects are available in the
security policy editor. If you use dynamic groups to your IDP rulebase rules and a
new attack object belongs to the dynamic group, the rule automatically inherits the
new attacks.

Table 34 on page 58 provides procedures for updating IDP detector engine and the
NSM attack database.

Table 34: IDP Detector Engine and NSM Attack Database Update Procedures

ProcedureTask

From the NSM main menu, select Tools > View/Update NSM attack database and complete the
wizard steps.

NOTE: The default URL from which to obtain updates is
https://services.netscreen.com/restricted/sigupdates/nsm-updates/NSM-SecurityUpdateInfo.dat. If
you encounter connection errors, ensure this setting has not been inadvertently changed.

1. From the NSM main menu, select Tools > Preferences.

2. Click Attack Object.

3. Click Restore Defaults.

NSM restores the URL in the Download URL for ScreenOS Devices text box.

4. Click OK.

To download IDP
detector engine and NSM
attack database updates
to the NSM GUI server

From the NSM main menu, select Devices > IDP Detector Engine > Load IDP Detector Engine
for ScreenOS and complete the wizard steps.

NOTE: Updating the IDP detector engine on a device does not require a reboot of the device.

To push an IDP detector
engine update from the
NSM GUI server to IDP
devices
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Table 34: IDP Detector Engine and NSM Attack Database Update Procedures (continued)

ProcedureTask

1. From the NSM main menu, select Devices > Configuration > Update Device Config.

2. Select the devices that you want to push configuration updates to and to set update job options
on.

3. Click OK.

NOTE: Only the attack objects that are used in IDP rules for the device are pushed from the GUI
server to the device.

To push predefined
attack object updates
from the NSM GUI server
to IDP devices

1. Log in to the NSM GUI server command line.

2. Change directory to /usr/netscreen/GuiSvr/utils.

3. Create a shell script called attackupdates.sh with the following contents:

■ Set the NSMUSER environment variable with an NSM domain/user pair. The command
for setting environment variables depends on your OS. Example:

export NSMUSER=domain/user

■ Set the NSMPASSWD environment variable with an NSM password. The command for
setting environment variables depends on your OS and shell. Example:

export NSMPASSWD=password 

■ Specify a guiSvrCli command string. Example:

/usr/netscreen/GuiSvr/utils/guiSvrCli.sh --update-attacks --post-action
--update-devices --skip

4. Make the script executable by the user associated with the cron job:

chmod 700 attackupdates.sh

5. Run the crontab editor:

crontab -e

6. Add an entry for the shell script:

minutes_after_hour
hour * * * /usr/netscreen/GuiSvr/utils/attackupdates.sh

During the update, the guiSvrCli utility updates the attack object database, then performs the post
actions. After updating and executing actions, the system generates an exit status code of 0 (no
errors) or 1 (errors).

To schedule regular
updates

Related Topics Attack Objects in Intrusion Detection and Prevention Security Policies Overview
on page 57

■

■ Viewing Predefined Attack Objects (NSM Procedure)

■ Working with Attack Groups (NSM Procedure) on page 60
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Viewing Predefined Attack Objects (NSM Procedure)

Purpose Juniper Networks Security Center (J-Security Center) develops predefined attack
objects and attack object groups for IDP rulebase rules.

In most cases, the predefined attack objects are the only attack objects you need to
protect your network.

The predefined attack object list in the NSM Object Manager provides the following
summary of each attack object:

■ Name of the attack object

■ Severity of the attack: critical, major, minor, warning, info

■ Category

■ Keywords

■ Common Vulnerabilities and Exposures database (CVE) number

■ Security Focus Bugtraq database number

Action To view predefined attack object details:

1. In the Object Manager, click Attack Objects > IDP Objects to display the IDP
Objects dialog box.

2. Click either the Predefined Attacks or Predefined Attack Groups tab to view
the predefined attack object list.

3. Double-click the table row entry for the attack object to display its details.

NOTE: You cannot create, edit, or delete predefined attack objects.

Related Topics ■ Attack Objects in Intrusion Detection and Prevention Security Policies Overview
on page 57

■ Working with Attack Groups (NSM Procedure) on page 60

■ Loading J-Security-Center Updates (NSM Procedure) on page 58

■ Viewing Predefined Attack Objects (NSM Procedure)

Working with Attack Groups (NSM Procedure)

NSM groups are administrative objects that facilitate configuration and monitoring
tasks. You can add attack groups or individual attack objects to IDP rulebase rules
and Exempt rulebase rules.

■ Creating Dynamic Groups on page 61

■ Creating Static Groups on page 62
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Creating Dynamic Groups

A dynamic group contains attack objects that are automatically added or deleted
based on specified criteria for the group. The NSM Object Manager includes predefined
dynamic groups that work with recommended attack objects, predefined attack
objects, the recommended security policy, and predefined policy templates.

When you run an NSM attack database update job, the process automatically performs
the following tasks:

■ For all new attack objects, compares the predefined attributes of each attack
object to each dynamic group criteria and adds the attack objects that match.

■ For all updated attack objects, removes attack objects that no longer meet their
dynamic group criteria.

■ Reviews updated attack objects to determine if they now meet any other dynamic
group criteria, and adds them to those groups if necessary.

■ For all deleted attack objects, removes the attack objects from their dynamic
groups.

Use of dynamic groups eliminates the need to review each new signature to determine
if you need to use it in your existing security policy.

A predefined or custom dynamic group can contain only attack objects and not attack
groups. Dynamic group members can be either predefined or custom attack objects.

To create a custom dynamic group:

1. In Object Manager, select Attack Objects > IDP Objects to display the IDP
Objects dialog box.

2. Click the Custom Attack Groups tab, then click the + icon and select Add
Dynamic Group to display the New Dynamic Group dialog box.

3. Enter a name and description for the static group. Select a color for the group
icon.

4. In the Filters tab, click the + icon and add select filters that determine which
attack objects should be in the group using Table 35 on page 61.

2. Click the Members tab to view the attack objects now belonging to the group.

3. Click OK to save your settings.

Table 35: Dynamic Attack Group Filters

DescriptionFilter

Filters attack objects based on the application that is vulnerable to the attack.Add Products Filter
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Table 35: Dynamic Attack Group Filters (continued)

DescriptionFilter

Filters attack objects based on attack severity.

NOTE: All predefined attack objects are assigned a severity level by Juniper Networks. However,
you can edit this setting to match the needs of your network.

Add Severity Filter

Filters attack objects based on category.Add Category Filter

Filters attack objects based on their last modification date.Add Last Modified Filter

Filters attack objects based on whether they have been marked Recommended.Add Recommended Filter

Creating Static Groups

A static group contains a specific, finite set of attack objects or groups. There are two
types of static groups: predefined static groups and custom static groups.

A custom static group can include the same members as a predefined static group
(predefined attack objects, predefined static groups, and predefined dynamic groups),
plus the following members:

■ Custom attack objects

■ Custom dynamic groups

■ Other custom static groups

Use static groups to define a specific set of attacks to which you know your network
is vulnerable, or to group custom attack objects. For example, you might want to
create a group for a specific set of informational attack objects that keep you aware
of what is happening on your network.

Static groups require more maintenance than dynamic groups because you must
manually add or remove attack objects in a static group to change the members.
However, you can include a dynamic group within a static group to automatically
update some attack objects. For example, the predefined attack object group
Operating System is a static group that contains four predefined static groups: BSD,
Linux, Solaris, and Windows. The BSD group contains the predefined dynamic group
BSD-Services-Critical, to which attack objects can be added during an attack database
update.

To create a custom static group:

1. In Object Manager, select Attack Objects > IDP Objects to display the IDP
Objects dialog box.

2. Click the Custom Attack Groups tab, then click the + icon and select Add Static
Group to display the New Static Group dialog box.

3. Enter a name and description for the static group.
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4. Select a color for the group icon.

5. Select the attack or group from the Attacks/Group list and click Add .

6. Click OK.

Related Topics ■ Attack Objects in Intrusion Detection and Prevention Security Policies Overview
on page 57

■ Creating Custom Attack Objects (NSM Procedure) on page 63

■ Viewing Predefined Attack Objects (NSM Procedure)

■ Verifying the Attack Object Database Version (NSM Procedure) on page 71

Creating Custom Attack Objects (NSM Procedure)

This section includes the following:

■ Configuring General Properties for Attack Objects on page 63

■ Creating a Signature Attack Object on page 65

Configuring General Properties for Attack Objects

To create a custom attack object:

1. In the Object Manager, click Attack Objects > IDP Objects to display the IDP
Objects dialog box.

2. Click the Custom Attacks tab.

3. Click the + icon to display the Custom Attack dialog box.

4. Configure general attack object settings using Table 36 on page 63 on the General
tab.

Table 36: Custom Attack Dialog Box: General Tab Settings

DescriptionSetting

Specifies the name to be displayed in the UI.

TIP: You might want to include the protocol the attack uses as part of the attack name.

Name

Specifies details about the attack. Entering a description is optional when creating a new attack
object, but it can help you remember important information about the attack. View the attack
descriptions for predefined attacks for examples.

Description

Specifies a severity rating: Info, Warning, Minor, Major, or Critical. Critical attacks are the most
dangerous—typically these attacks attempt to crash your server or gain control of your network.
Informational attacks are the least dangerous and typically are used by network administrators
to discover holes in their own security system.

Severity

Specifies a predefined category or defines a new category.Category

Specifies keywords—unique identifiers that can be used to search and sort log records.Keywords
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Table 36: Custom Attack Dialog Box: General Tab Settings (continued)

DescriptionSetting

Specifies that this attack object is part of your highest risk set of attack objects. Later, when you
add this attack object to dynamic groups, you can specify whether only recommended attack
objects will be included.

Recommended

Skip this for now.Attack Versions

Select High, Medium, Low, or Not Defined.Detection Performance

5. On the Extended tab, using Table 37 on page 64. Configure additional attack
details.

Table 37: Custom Attack Dialog Box: Extended Tab Settings

DescriptionSetting

Enter up to three URLs (primary, secondary, tertiary) for external references you used when
researching the attack.

Primary URL

Secondary URL

Tertiary URL

Common Vulnerabilities and Exposures (CVE) is a standardized list of vulnerabilities and other
information security exposures. The CVE number is an alphanumeric code, such as CVE-2209

CVE

A moderated mailing list that discusses and announces computer security vulnerabilities. The
BugTraq ID number is a three-digit code, such as 831 or 120.

Bugtraq

Enter details about the impact of a successful attack, including information on system crashes
and access granted to the attacker.

Impact

Enter a description of the custom attacks.Description

Enter details on the vulnerability, the commands used to execute the attack, which files are
attacked, registry edits, and other low-level information.

Tech Info

List any patches available from the product vendor, as well as information on how to prevent the
attack.

Patches

6. Return to the General tab.

7. Under Attack Versions, click the + icon to display the New Attack wizard.

8. On the Target Platform and Type page, select a device platform (IDP 4.0, for
example) and attack type.

Table 38 on page 65 summarizes attack types and provides references to the
next steps required to implement the technical configuration of the attack objects
for each type.
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Table 38: Attack Object Types

DescriptionType

Uses a stateful attack signature (a pattern that always exists within a specific section of the attack)
to detect known attacks.

Stateful signature attack objects also include the protocol or service used to perpetrate the attack
and the context in which the attack occurs.

If you know the exact attack signature, the protocol, and the attack context used for a known
attack, select this option.

Signature

Detects unknown or sophisticated attacks that violate protocol specifications (RFCs and common
RFC extensions).

You cannot create new protocol anomalies, but you can configure a new attack object that controls
how the security device handles a predefined protocol anomaly when detected.

If you do not know that exact attack signature, but you do know the protocol anomaly that detects
the attack, select this option.

Protocol Anomaly

Detects attacks that use multiple methods to exploit a vulnerability. This object combines multiple
signatures and/or protocol anomalies into a single attack object, forcing traffic to match all combined
signatures and/or anomalies within the compound attack object before traffic is identified as an
attack.

By combining and even specifying the order in which signatures or anomalies must match, you
can be very specific about the events that need to take place before IDP identifies traffic as an
attack.

If you need to detect an attack that uses several benign activities to attack your network, or if you
want to enforce a specific sequence of events to occur before the attack is considered malicious,
select this option

Compound Attack

9. Click Ok.

Creating a Signature Attack Object

To configure a signature attack object:

1. Configure general attack object properties. For information, see “Configuring
General Properties for Attack Objects” on page 63.

On the Target Platform and Type page, select Signature and click Next.

2. On the Custom Attack–General Properties page, configure the settings described
in Table 39 on page 65.

Table 39: Custom Attack – General Properties

DescriptionProperty

Select the frequency that the attack object produces a false positive on your network: Unknown,
Rarely, Occasionally, Frequently.

False Positives

Creating a Signature Attack Object ■ 65

Chapter 5: Working with Attack Objects



Table 39: Custom Attack – General Properties (continued)

DescriptionProperty

Any–If you are unsure of the correct service, select Any to match the signature in all services.
Because some attacks use multiple services to attack your network, you might want to select the
Any service binding to detect the attack regardless of which service the attack selects for a
connection.

NOTE: You must select a service binding other than Any if you want to select a context for the
attack.

Service Binding

IP–If you are not sure of the correct service, but know the IP protocol type, select IP protocol type
for the service binding.

Specify the protocol type number.

If you select this option, you should also specify an attack pattern and IP header values later in
the wizard. However, if you use a context binding of first packet, you must leave the attack pattern
empty.

TCP, UDP, or ICMP–Attacks that do not use a specific service might use a specific protocol to
attack your network. Some TCP and UDP attacks use standard ports to enter your network and
establish a connection.

For TCP and UDP protocol types, specify the port ranges.

RPC–The remote procedure call (RPC) protocol is used by distributed processing applications to
handle interaction between processes remotely. When a client makes a remote procedure call to
an RPC server, the server replies with a remote program; each remote program uses a different
program number.

To detect attacks that use RPC, configure the service binding as RPC and specify the RPC program
ID.

Service–Most attacks use a specific service to attack your network.

If you select Service, the wizard displays a second selection box where you specify the service
used for the attack.

If you select this option, you are restricted to general attack contexts (packet, first packet, stream,
stream 256, or line context).

Enable–Time attributes control how the attack object identifies attacks that repeat for a certain
number of times.

Time Binding

Scope–Select the scope within which the count occurs:

■ Source– Detects attacks from the source IP address for the specified number of times,
regardless of the destination IP address.

■ Destination–Detects attacks to the destination IP address for the specified number of times,
regardless of the source IP address.

■ Peer–Detects attacks between source and destination IP addresses of the sessions for the
specified number of times.

Count/Min–Enter the number of times per minute that the attack object must detect an attack
within the specified scope before the device considers the attack object to match the attack.
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Click Next.

3. On the Custom Attack – Attack Patterns page, configure the settings described
in Table 40 on page 67.

Table 40: Custom Attack – Attack Patterns

DescriptionSetting

For a direct binary match.\0 <octal_number>Pattern

For a direct binary match.\X<hexadecimal-number>\X

For case insensitive matches.\[<character-set>\]

To match any symbol..

To match 0 or more symbols.*

To match 1 or more symbols.+

To match 0 or 1 symbols.?

Grouping of expressions.()

Alternation. Typically used with ().|

Character range.[<start>-<end>]

Negation of character range.[^<start>-<end>]

Select this option to negate the attack pattern.Negate
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Table 40: Custom Attack – Attack Patterns (continued)

DescriptionSetting

Select the context used by the attack to enter your network.

If you know the service and the specific service context, select that service and then select the
appropriate service contexts.

If you know the service, but are unsure of the specific service context, select Other and then select
one of the following general contexts:

■ Packet–Detects the pattern at the packet level. When you select this option, you should also
specify the Service Binding (in the General tab) and define the service header options (in the
Header Match tab). Although not required, specifying these additional parameters helps to
improve the accuracy of the attack object.

■ First Packet–Inspects only the first packet of a stream. When the flow direction for the Attack
Object is set to any, IDP checks the first packet of both the server-to-client (STC) and
client-to-server (CTS) flows. If you know that the attack signature appears in the first packet
of a session, choosing first packet instead of packet reduces the amount of traffic the security
device needs to monitor, which improves performance.

■ Stream Select–Reassembles packets and extracts the data to search for a pattern match.
However, IDP does not recognize packet boundaries for stream contexts, so data for multiple
packets is combined. Select this option only when no other context option contains the attack.

■ Stream 256–Reassembles packets and searches for a pattern match within the first 256 bytes
of a traffic stream. When the flow direction is set to any, DI checks the first 256 bytes of both
the STC and CTS flows. If you know that the attack signature will appear in the first 256 bytes
of a session, choosing stream 256 instead of stream reduces the amount of traffic that the
security device must monitor and cache, improving performance.

■ Line–Detects a pattern match within a specific line within your network traffic.

Context

Select the direction in which to detect the attack:

■ Client to Server–Detects the attack only in client-to-server traffic.

■ Server to Client –Detects the attack only in server-to-client traffic.

■ Any–Detects the attack in either direction.

Direction

Select the flow in which to detect the attack:

■ Control–Detects the attack in the initial connection that is established persistently to issue
commands, requests, and so on.

■ Auxiliary–Detects the attack in the response connection established intermittently to transfer
requested data.

■ Both–Detects the attack in the initial and response connections.

TIP: Using a single flow (instead of Both) improves performance and increases detection accuracy.

Flow

Click Next.

4. On the Custom Attack – IP Settings and Header Matches page, specify signature
settings as described in Table 41 on page 69.
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NOTE: The IP tab specifies the contents of the IP header in a malicious packet. You
cannot specify IP header contents if you selected a line, stream, stream 256, or a
service context in the Attack Patterns tab.

TIP: If you are unsure of the IP flags and IP fields for the malicious packet, leave all
fields blank. If not values are set, IDP attempts to match the signature for all IP header
contents.

Table 41: Custom Attack: IP Settings and Header Matches

DescriptionSetting

Enter the service type. Common service types are:

■ 0000 Default

■ 0001 Minimize Cost

■ 0002 Maximize Reliability

■ 0003 Maximize Throughput

■ 0004 Minimize Delay

■ 0005 Maximize Security

Type of Service

Enter the number of bytes in the packet, including all header fields and the data payload.Total Length

Enter the unique value used by the destination system to reassemble a fragmented packet.ID

Enter the time-to-live (TTL) value of the packet. This value represents the number of routers the
packet can pass through. Each router that processes the packet decrements the TTL by 1; when
the TTL reaches 0, the packet is discarded.

Time-to-live

Enter the protocol used in the attack.Protocol

Specify the IP address of the attacking device.Source

Specify the IP address of the attack target.Destination

Reserved bit. Specifies that IDP looks for a pattern match whether or not the IP flag is set (none),
only if the flag is set (set), or only if the flag is not set (unset).

RB

More fragments. Specifies that IDP looks for a pattern match whether or not the IP flag is set
(none), only if the flag is set (set), or only if the flag is not set (unset).

MF

Don’t fragment. Specifies that IDP looks for a pattern match whether or not the IP flag is set
(none), only if the flag is set (set), or only if the flag is not set (unset).

DF

5. If you selected TCP for Service Binding and packet or first-data-packet as the
Context, click the Protocols tab, select TCP packet header fields, and configure
TCP Header Match settings as described in Table 42 on page 70.
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Table 42: TCP Header Match Settings

DescriptionSetting

The port number on the attacking device.Source Port

The port number of the attack target.Destination Port

The sequence number of the packet. This number identifies the location of the data in relation to
the entire data sequence.

Sequence Number

The ACK number of the packet. This number identifies the next sequence number; the ACK flag
must be set to activate this field.

ACK Number

The number of bytes in the TCP header.Header Length

The number of bytes in the TCP window size.Window Size

The number of bytes in the data payload. For SYN, ACK, and FIN packets, this field should be
empty.

Data Length

The data in the packet is urgent; the URG flag must be set to activate this field.Urgent Pointer

When set, the urgent flag indicates that the packet data is urgent.URG Bit

When set, the acknowledgment flag acknowledges receipt of a packet.ACK Bit

When set, the push flag indicates that the receiver should push all data in the current sequence
to the destination application (identified by the port number) without waiting for the remaining
packets in the sequence.

PSH Bit

When set, the reset flag resets the TCP connection, discarding all packets in an existing sequence.RST Bit

When set, the final flag indicates that the packet transfer is complete and the connection can be
closed.

FIN Bit

Reserved bit. Unused.R1 Bit, R2 Bit

6. If you selected UDP for Service Binding and packet or first-data-packet as the
Context, click the Protocols tab, select UDP packet header fields, and configure
UDP Header Match settings as described in Table 43 on page 70.

Table 43: UDP Header Match Settings

DescriptionSetting

Enter the port number on the attacking device.Source Port

Enter the port number of the attack target.Destination Port

Enter the number of bytes in the data payload.Data Length
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7. If you selected ICMP for Service Binding and packet or first-data-packet as the
Context, click the Protocols tab, select ICMP packet header fields, and configure
ICMP Header Match settings as described in Table 44 on page 71.

Table 44: ICMP Header Match Settings

DescriptionSetting

Enter the primary code that identifies the function of the request/reply.ICMP Type

Enter the secondary code that identifies the function of the request/reply within a given type.ICMP Code

Enter the sequence number of the packet. This number identifies the location of the request/reply
in relation to the entire sequence.

Sequence Number

Enter the identification number which is a unique value used by the destination system to associate
requests and replies.

ICMP ID

8. Click Finish.

Related Topics ■ Attack Objects in Intrusion Detection and Prevention Security Policies Overview
on page 57

■ Working with Attack Groups (NSM Procedure) on page 60

■ Viewing Predefined Attack Objects (NSM Procedure)

■ Updating the IDP Detector Engine (NSM Procedure) on page 72

Verifying the Attack Object Database Version (NSM Procedure)

Purpose New attack objects are added to the attack object database server frequently;
downloading these updates and installing them on your managed devices regularly
ensures that your network is protected against the latest threats. As new attack objects
are added to the attack object database server, the version number of the database
increments by 1. When you download a version of the attack object database from
the server, NSM stores the version number of that database.

Action Automatic Verification

The management system uses the database version number to detect and notify you
when the stored attack object database on the GUI server is:

■ Older than the most recent database available from the attack object database
server.

■ Newer than the attack object database currently installed on your ScreenOS 5.1
and later managed devices.

When NSM detects that the managed device contains an older attack object database
version than the one stored on the GUI server, the UI displays a warning for that
device, indicating that you should update the attack object database on the device.
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Manual Verification

You can also check to see if the attack object database on the server is more recent
than the one on the security device.

To check the attack object database version:

1. From the Device Manager, select Security Updates > Check Attack Database
Server Version. The Check Attack Database Server Version dialog box appears.

2. Select the devices or group of devices to be checked.

3. Click OK. The Job Information window displays the status of the version check.

Related Topics ■ Attack Objects in Intrusion Detection and Prevention Security Policies Overview
on page 57

■ Creating Custom Attack Objects (NSM Procedure) on page 63

■ Loading J-Security-Center Updates (NSM Procedure) on page 58

■ Viewing Predefined Attack Objects (NSM Procedure)

Updating the IDP Detector Engine (NSM Procedure)

The IDP detector engine is dynamically changeable firmware that runs on ISG security
devices running ScreenOS 5.0.0-IDP1, standalone IDP sensors, J-series devices, and
SRX-series devices. Automatic updates to the IDP detector engine occur when you:

■ Upgrade security device firmware.

■ Load a new detector engine—New detector engines may be downloaded with
normal attack object updates. You must load the new detector engine onto the
device.

NOTE: You cannot downgrade the IDP detector engine version on the device.

To update the IDP detector engine for an IDP device:

1. From the Device Manager, select Security Updates > Update ScreenOS/IDP
Device Detector. The Load IDP Detector Engine wizard starts.

2. Click Next, and then follow the instructions in the wizard to update the IDP
detector engine on the selected device.

NOTE: Updating the IDP detector engine on a device does not require a reboot of
the device.

For more information, see Network and Security Manager Administration Guide.
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Related Topics ■ Attack Objects in Intrusion Detection and Prevention Security Policies Overview
on page 57

■ Working with Attack Groups (NSM Procedure) on page 60

■ Loading J-Security-Center Updates (NSM Procedure) on page 58

■ Viewing Predefined Attack Objects (NSM Procedure)
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Chapter 6

Configuring SNMP and Syslog Settings

■ Configuring an SNMP Agent (NSM Procedure) on page 75

■ Configuring Syslog Collection (NSM Procedure) on page 76

Configuring an SNMP Agent (NSM Procedure)

You configure a Simple Network Management Protocol (SNMP) agent if you want to
send device event logs to an SNMP server.

You have the option of configuring an SNMP agent for NSM (if you want to send the
NSM collection to SNMP) or configuring an SNMP agent for each IDP device.

To configure an SNMP agent for NSM, see the NSM online Help.

To configure an SNMP agent for a single IDP device:

1. In the NSM Device Manager, double-click the IDP device to display the device
configuration editor.

2. Click Report Settings.

3. Add or modify the settings in the SNMP Settings grid as described in the Table
45 on page 75.

4. Click OK.

Table 45: IDP Configuration: SNMP Settings

DescriptionSetting

Enables forwarding to a network management system that reads SNMP.Enable SNMP

Specifies a string. The SNMP read-only community string is like a password used for the
exchange between the IDP device and the network management system.

SNMP Read Only Community

Specifies the IP address of the SNMP server.SNMP Manager IP

Specifies an e-mail address for the IDP administrator contact to be included in SNMP
communications. If the network management system encounters a problem with the SNMP
communication, he/she can use the contact information to follow up.

SNMP Contact

Specifies a location of the IDP device to be included in SNMP communications.SNMP Location

Specifies the network/host IP address and the network/host netmask for the agent.New SNMP allowed hosts
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Related Topics Configuring Syslog Collection (NSM Procedure) on page 76■

■ NSM Logs and Reports Overview on page 119

Configuring Syslog Collection (NSM Procedure)

You configure syslog settings if you want to forward a copy of IDP logs to a syslog
server.

You have the option of configuring NSM to forward a copy of its log collection to a
syslog server or configuring syslog settings for each IDP device.

To configure syslog forwarding for NSM, see the NSM online Help.

To configure syslog forwarding for a single IDP device:

1. In the NSM Device Manager, double-click the IDP device to display the device
configuration editor.

2. Click Report Settings.

3. Select Enable Syslog.

4. Specify the syslog server IP address.

5. Specify whether to forward packet logs to the syslog server.

6. Click OK.

Related Topics ■ NSM Logs and Reports Overview on page 119

■ Viewing Logs on page 119

■ Configuring an SNMP Agent (NSM Procedure) on page 75

76 ■ Configuring Syslog Collection (NSM Procedure)
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Chapter 7

Configuring Anti-Spoof Settings

■ Configuring Anti-Spoof Settings in Intrusion Detection and Prevention Devices
(NSM Procedure) on page 77

Configuring Anti-Spoof Settings in Intrusion Detection and Prevention Devices
(NSM Procedure)

To configure anti-spoof settings:

1. In NSM Device Manager, double-click the IDP device you want to configure
anti-spoof settings. The device configuration editor appears.

2. Click Anti-Spoof Settings.

3. Click the + icon to display the Anti-Spoof Settings dialog box.

4. Configure anti-spoof settings using Table 46 on page 77.

5. Click OK.

Table 46: IDP Device Configuration: Anti-Spoof Settings

DescriptionSetting

Select a forwarding interface to configure.Interface Name

Enable logging for spoofed IP address.Logging

Enable alerts for spoofed IP addresses.Alarm

Indicate whether the device should check the status of other interfaces when determining spoofing.Check Other Interfaces

Specify the action for the IDP device to take: None or Drop Packet.Action

Browse and select the address objects you associate with the selected interface.Network Objects

Related Topics ■ Configuring Additional Intrusion Detection and Prevention Features Overview
on page 103

■ Adding Intrusion Detection and Prevention Devices in NSM Overview on page
6
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■ NSM and Intrusion Detection and Prevention Device Management Overview on
page 5

78 ■ Configuring Anti-Spoof Settings in Intrusion Detection and Prevention Devices (NSM Procedure)
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Chapter 8

Configuring Intrusion Detection and
Prevention Device Settings

■ Configuring Load-Time Parameters (NSM Procedure) on page 79

■ Configuring Run-Time Parameters (NSM Procedure) on page 80

■ Configuring Router Parameters (NSM Procedure) on page 86

■ Configuring Protocol Handling (NSM Procedure) on page 87

Configuring Load-Time Parameters (NSM Procedure)

Load-time parameters include options for tuning IDP performance. In general, you
modify these settings only if you encounter performance issues.

To configure load-time parameters:

1. In NSM Device Manager, double-click the IDP device for which you want to
configure load-time parameters. The device configuration editor appears.

2. Click Sensor Settings.

3. Click the Load Time Parameters tab.

4. Configure load-time parameters using Table 47 on page 79.

5. Click Apply.

6. Click OK.

Table 47: IDP Device Configuration: Load Time Parameters

DescriptionSetting

For improved IDP performance, set the flow table size to limit the size of the connection table.
This setting should reflect the maximum number of concurrent flows you expect to have at any
one time. A TCP connection has about two flows per session, and a UDP connection has about
three flows per session. The default setting is 100,000 concurrent flows. If you change this value,
you have to restart the IDP device.

Flow table size (requires
sensor restart)

Log suppression reduces the number of logs displayed in the Log Viewer by displaying a single
record for multiple occurrences of the same event.

NOTE: If the reporting interval is set too high, log suppression can negatively impact IDP
performance.

Enable log suppression
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Table 47: IDP Device Configuration: Load Time Parameters (continued)

DescriptionSetting

When log suppression is enabled, multiple occurrences of events with the same source IP, service,
and matching attack object generate a single log record with a count of occurrences. If you enable
this option, log suppression combines log records for events with the same destination IP.

Include destination IP’s
while performing log
suppression

This number represents the number of identical log records received before suppression starts.
The default is 1 (meaning log suppression begins with the first redundancy).

Number of log
occurrences after which
log suppression begins

When log suppression is enabled, IDP must cache log records so that it can identify when multiple
occurrences of the same event occur. This number represents the number of log records in the
IDP Management Server that IDP tracks for log suppression. The default is 16384 log records.

Maximum number of logs
that log suppression can
operate on

When log suppression is enabled, the IDP device maintains a count of multiple occurrences of
the same event. This number represents the number of seconds that pass before IDP reports a
single log entry containing the count of occurrences. The default is 10 seconds.

Time (seconds) after
which suppressed logs
will be reported

The application identification feature is used to detect the session application regardless of port.
We recommend you disable this feature only when troubleshooting.

Enable application
identification

Specifies the maximum number of sessions where application identification is in use. The default
is 1,00,000. Valid values are 0 - 200,000. We recommend you tune this setting only if you encounter
issues.

Maximum number of
Application Identification
sessions

Related Topics Pushing Security Policy Updates to an IDP Device (NSM Procedure) on page 111■

■ Troubleshooting Configuration Push Errors (NSM Procedure) on page 113

■ Configuring Run-Time Parameters (NSM Procedure) on page 80

Configuring Run-Time Parameters (NSM Procedure)

Run-time parameters include options for tuning IDP detection methods. In general,
you modify these settings only if you encounter false positives or performance issues.

To configure run-time parameters:

1. In NSM Device Manager, double-click the IDP device for which you want to
configure run-time parameters. The device configuration editor appears

2. Click Sensor Settings.

3. Click the Run-time Parameters tab.

4. Configure run-time settings using Table 48 on page 81.

5. Click Apply.

6. Click OK.
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Table 48: IDP Device Configuration: Run-Time Parameters

DescriptionSetting

Minimum interval between consecutive small packets (microseconds) / Maximum interval
between consecutive small packets (microseconds)–Controls the minimum and maximum
intervals (in microseconds) between the arrival of two consecutive small packets in suspected
interactive traffic. If the IDP device sees small packets arrive in less than the minimum or more
than the maximum number of microseconds, it does not consider the traffic to be interactive.

The defaults are 20,000 and 2,00,00,000. This means that consecutive small packets must arrive
within 20,000 to 2,00,00,000 microseconds to be considered interactive.

Backdoor Detection

Byte threshold for packet sizes in a backdoor connection–Controls the maximum number of
bytes a TCP packet must contain before the IDP device uses the packet for backdoor detection
heuristics. The default is 20 bytes.

Minimum number of data carrying TCP packets–Controls the minimum number of data-carrying
TCP packets in suspected interactive traffic. The default is 20 packets.

Minimum percentage of back-to-back small packets–Controls the minimum percentage of
consecutive small packets in suspected interactive traffic. If the IDP device sees less than this
percentage, it does not report a backdoor event. The default is 20%.

Ratio of small packets to the total packets (percentage)–Controls the minimum percentage of
small packets that the IDP device uses for backdoor detection heuristics. If the IDP device sees
less than this minimum, it does not report a backdoor event. The default is 20%.
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Table 48: IDP Device Configuration: Run-Time Parameters (continued)

DescriptionSetting

Timeout (seconds) for non-UDP/TCP/ICMP flows–Each connection through the security module
typically has two non-UDP/TCP/ICMP flows, one in each direction. If IDP does not see flow activity
for the specified timeout, it removes the idle flow from the flow table. The default is 30 seconds.

Flow Management

Timeout (seconds) for UDP flows–Each connection through the security module typically has
two UDP flows, one in each direction. If IDP does not see flow activity for the specified timeout,
it removes the idle flow from the flow table. The default is 30 seconds.

Timeout (seconds) for TCP flows–Each connection through the security module typically has two
TCP flows, one in each direction. If IDP does not see flow activity for the specified timeout, it
removes the idle flow from the flow table. The default is 30 seconds.

Timeout (seconds) for ICMP flows–Each connection through the security module typically has
two ICMP flows, one in each direction. If IDP does not see flow activity for the specified timeout,
it removes the idle flow from the flow table. The default is 30 seconds.

Maximum TCP Sessions–Controls the maximum number of TCP sessions that IDP maintains. If
IDP reaches the maximum, it drops all new sessions and writes a SESSION_LIMIT_EXCEEDED
log. Defaults vary according to model.

Maximum UDP Sessions–Controls the maximum number of UDP sessions that IDP maintains. If
IDP reaches the maximum, it drops all new sessions and writes a SESSION_LIMIT_EXCEEDED
log. Defaults vary according to model.

Maximum ICMP Sessions–Control s the maximum number of ICMP sessions that IDP maintains.
If IDP reaches the maximum, it drops all new sessions and writes a SESSION_LIMIT_EXCEEDED
log. Defaults vary according to model.

Maximum IP (non-UDP/TCP/ICMP) sessions–Controls the maximum number of IP sessions that
IDP maintains. If IDP reaches the maximum, it drops all new sessions and writes a
SESSION_LIMIT_EXCEEDED log. Defaults vary according to model.

Reset flow table with policy load/unload– Enables IDP to reset the flow table each time you
load or unload a security policy. If you do not enable this option, IDP maintains the flow table
until all flows referencing that security policy go away. This setting is enabled by default. We
recommend that you keep this setting enabled to preserve memory.

Log flow related errors–Enables logging for flow-related errors. This setting is not enabled by
default.

Reset block table with policy load/unload–Allows the IDP device to reset the block table. The
block table maintains the state of active IP actions each time a security policy loads or unloads.
This setting is enabled by default.

IP Actions
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Table 48: IDP Device Configuration: Run-Time Parameters (continued)

DescriptionSetting

Buffer Overflow emulator–Turns on buffer overflow emulation.Intrusion Detection

Attack matches per packet when Signature Hierarchy (0 to disable) take effect–Sets the
threshold for activating Signature Hierarchy calculations.

Common attack can be composed of several known vulnerabilities. Each vulnerability has an
attack object, and each would generate a separate log entry if the signature hierarchy feature were
disabled.

For example, for a policy with critical, high, medium, low, and info attacks and logging enabled,
a single detection of HTTP:IIS:COMMAND-EXEC attack generates the following logs:

■ HTTP:IIS:COMMAND-EXEC [wininnt/system32/cmd.exe] (medium)

■ HTTP:WIN-CMD:WIN-CMD-EXE [cmd.exe] (medium)

■ HTTP:REQERR:REQ-MALFORMED-URL [anomaly for %xx] (medium)

■ HTTP:DIR:TRAVERSE-DIRECTORY (anomaly for ../) (medium)

■ HTTP:REQERR:REQ-LONG-UTF8CODE (anomaly for oe) (medium)

■ TCP:AUDIT:BAD-SYN-NONSYN (info)

■ HTTP:AUDIT:URL (info)

■ TCP:AUDIT:BAD-SYN-NONSYN (info)

If the number of attacks in a packet exceeds the set value, then IDP examines its signature hierarchy
to see if some attacks are actually part of a larger attack. If so, then only the parent attack is
displayed in the logs. In this example, if the value was set to 9 or lower, then only a log for
HTTP:IIS:COMMAND-EXEC would be generated.

An attack in the signature hierarchy may have multiple parents or multiple children. If a child
attack is part of two discovered parents, IDP takes action based on the parent with the highest
severity.

Specify 0 to disable.
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Table 48: IDP Device Configuration: Run-Time Parameters (continued)

DescriptionSetting

RPC program timeout (seconds)–IDP performs a stateful inspection of all RPC messages on port
111, then builds a table of program-to-port mapping for each RPC server that it finds on the
network. This setting indicates how long an entry in the table is maintained. The default is 300
seconds.

Run-time Parameters

RPC transaction timeout (Seconds)–All RPC messages (port 111) are based on a request/response
protocol. When the IDP receives a request, it adds the request to a request table. If IDP does not
receive an RPC reply in the specified timeout, the RPC entry times out. The default is 5 seconds.

Exempt management server flows–Exempts NSM connections from IDP processing. This setting
is enabled by default.

Fragment timeout (seconds)–Controls when IDP drops an incomplete fragment chain because
one or more fragments did not arrive. If IDP does not receive missing fragments in the specified
timeout, it generates a log (FRAGMENT_TIME_EXCEEDED). The default is 5 seconds.

Minimum fragment size (bytes)–IDP drops all IP fragments less than the specified size (bytes).
The default is 0 bytes (no fragments are dropped).

Maximum fragments per IP datagram–An IP datagram can be broken into many fragments
which, when assembled, should not exceed 64 K. Because IP fragment processing is CPU and
memory intensive, this setting controls the size of the IP fragment chain. If the number of fragments
in a chain exceeds this number, IDP drops the entire fragment chain. The default is 65,535 bytes.

Maximum concurrent fragments in queue–IDP can perform pseudo reassembly of IP fragment
chains. This setting controls the maximum number of reassembled fragment chains. Once this
limit is reached, IDP drops all new IP fragment chains and generates a log
(TOO_MANY_FRAGMENTS). If your network produces a large number of IP fragments, such as
those produced by Network File System (NFS), increase the number of fragments per chain to
eliminate unnecessary logs. The default is 16 fragments.

Log fragment related errors–Logs fragment related errors. This setting is not enabled by default.

Enable GRE decapsulation support–Enables IDP to decode generic routing encapsulation (GRE)
tunnels where IP-in-GRE or PPP-in-GRE encapsulation is used. This allows IDP to inspect the packet
in its original form. GRE decapsulation is not enabled by default.

Enable GTP decapsulation support–Enables GPRS Tunneling Protocol (GTP) decapsulation. IDP
supports decapsulation of UDP GTPv0 and GTPv1 only. GTP decapsulation is not enabled by
default.

Enable SSL decryption support–Enables SSL inspection. SSL decryption is not enabled by default.
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Table 48: IDP Device Configuration: Run-Time Parameters (continued)

DescriptionSetting

Timeout for half-open SYN protected flows–A half-open SYN flow occurs during the TCP three-way
handshake, after the client has sent a SYN/ACK packet to the server. The half-open connection is
now in the SYN_RECV state, and is placed into a connection queue while it waits for an ACK or
RST packet. The connection remains in the queue until the connection-establishment timeout
expires and the half-open connection is deleted. This setting controls the connection establishment
timer, which determines the number of seconds that the security module maintains a half-open
SYN protected flow. The default is 5 seconds.

SYN Protector

Lower SYN’s-per-second threshold below which SYN Protector will be deactivated / Upper
SYN’s-per-second threshold above which SYN Protector will be activated–The SYN Protector
rulebase is activated when the number of SYN packets per second is greater than the sum of the
lower SYNs-per-second threshold and the upper SYNs-per-second threshold.

The SYN Protector rulebase is deactivated when the number of SYN packets per second is less
than the lower SYNs-per-second threshold.

The defaults are 1000 and 20. The SYN Protector is activated when SYNs-per-second reach 1020
and deactivated when SYNs-per-second fall below 1000.

Ignore packets in TCP flows where a SYN hasn't been seen (recommended)–The absence of
SYN flags in TCP flows is suspect, yet still a very common occurrence. IDP can ignore packets
within TCP flows that do not yet contain a SYN flag. This is enabled by default.

TCP Reassembler

Close flows as soon as a FIN is seen–Enables when a TCP connection closes, IDP sees a FIN
packet from each side of the connection followed by an ACK packet from each side of the
connection. However, TCP does not guarantee delivery of the final ACK.

Enables IDP to quickly close a TCP connection after receiving a FIN packet. When enabled, IDP
maintains a connection waiting for a final ACK for 5 seconds, then closes the connection. This is
enabled by default and recommended.

Timeout for connected, idle TCP flows (seconds)–Controls the number of seconds that IDP
maintains connected (but idle) TCP flows. The default is 3600 seconds.

Timeout for closed TCP flows (seconds)–Controls when IDP sees a RST packet or FIN/FIN+ACK
packets on a TCP connection, it closes the connection flows. IDP drops any further packets for
the closed flow, but does not delete existing, closed flows from the flow table. Controls the number
of seconds that closed TCP flows are maintained in the flow table. The default is 5 seconds.

Timeout for CLOSE-WAIT/LAST-ACK TCP flows (seconds)–Controls when a TCP connection
closes, IDP sees a FIN packet from each side of the connection followed by an ACK packet from
each side of the connection. However, TCP does not guarantee delivery of the final ACK.

Controls the number of seconds a connection is maintained while waiting for the final ACK.

To improve IDP performance during heavy loads, decrease the timeout—this reduces the size of
the flow table by closing connections sooner. The default is 120 seconds.
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Table 48: IDP Device Configuration: Run-Time Parameters (continued)

DescriptionSetting

Byte threshold for suspicious flows–Specifies a threshold for what IDP considers a small packet.

A scan typically uses small packets to access its targets. You can exclude suspicious flows that
contain large packets to prevent false positives when detecting scans.

If IDP sees more than this maximum, it does not consider the connection to be a scan. The default
is 20 bytes.

Traffic Signatures

Reporting frequency when scan is in progress –Controls how often IDP generates "in progress"
logs for a stealthy scan.

Attackers can perform blatant scans very quickly, mapping your network in just a few seconds,
but these scans typically trigger IDSes and leave evidence behind. Stealthy scans are performed
over much longer time periods, lasting hours, days, or even weeks, making them more difficult
to detect. The default is 30 seconds.

The number of IP tracked for session rate –Controls the number of IP addresses tracked by the
session rate counter. If IDP sees more addresses than the maximum, it does not track the additional
IP addresses.The default is 32,767 IP addresses.

Related Topics Updating the IDP Detector Engine (NSM Procedure) on page 72■

■ Configuring SYN Protector Rulebase Rules (NSM Procedure) on page 44

■ Configuring Router Parameters (NSM Procedure) on page 86

Configuring Router Parameters (NSM Procedure)

Router parameters control how the security module handles address resolution
protocol (ARP) requests/replies and media access control (MAC) address issues. These
settings apply to proxy-ARP and bridge mode deployments.

To configure router parameters:

1. In NSM Device Manager, double-click the IDP device for which you want to
configure router parameters. The device configuration editor appears.

2. Click Sensor Settings.

3. Click the Router Parameters tab.

4. Configure the router parameters using Table 49 on page 87.

5. Click Apply.

6. Click OK.
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Table 49: IDP Device Configuration: Router Parameter Settings

DescriptionSetting

When the virtual router is in proxy-ARP mode, this setting controls how long an ARP entry is
maintained in the virtual router. If IDP does not receive an ARP reply before the timeout expires,
the ARP entry times out. The default is 3600 seconds.

ARP timeout (seconds)

In proxy-ARP mode, IDP sends out proxy ARPs on all interfaces except the one on which an ARP
request was received. This setting indicates how long the original ARP entry is maintained in the
virtual router if IDP does not receive an ARP reply through that interface. The default is 20 seconds.

ARP proxy timeout
(seconds)

When selected, IDP detects and logs all spoofed ARP requests/replies and other ARP anomalies.
This setting is enabled by default.

Log ARP attacks

When the virtual router is in bridge mode, this setting controls how long a MAC entry is maintained
in the virtual router. The default is 3600 seconds.

MAC timeout (seconds)

In bridge mode, IDP performs MAC discovery if the target MAC address is not in its MAC table.
This setting controls how long the entry is maintained in the virtual router until a reply comes
back. The default is 20 seconds.

MAC proxy timeout
(seconds)

Related Topics Configuring Protocol Handling (NSM Procedure) on page 87■

■ Configuring Load-Time Parameters (NSM Procedure) on page 79

Configuring Protocol Handling (NSM Procedure)

The protocol anomaly detection methods identify traffic that deviates from RFC
specifications. In general, you modify protocol thresholds and configuration settings
only if you encounter false positives or performance issues.

To tune protocol anomaly detection thresholds:

1. In NSM Device Manager, double-click the IDP device that you want to modify.
The device configuration editor appears.

2. Click Sensor Settings.

3. Click the Protocol Thresholds and Configuration tab.

4. Configure the protocol thresholds using Table 50 on page 88.

5. Click Apply.

6. Click OK.
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Table 50: IDP Device Configuration: Protocol Thresholds and Configuration Settings

DescriptionSetting

Maximum header length–Raises a protocol anomaly if IDP detects a header containing more bytes than
the specified maximum. The default is 10,000 bytes.

AIM

Maximum type-length-value length–Raises a protocol anomaly if IDP detects an AIM/ICQ type-length-value
(TLV) containing more bytes than the specified maximum. A TLV is a tuple used for passing typed information
to the protocol. The default is 8000 bytes.

Maximum inter-client-message-block length–Raises a protocol anomaly if IDP detects an AIM/ICQ
inter-client-message-block (ICMB) containing more bytes than the specified maximum. The default is 2000
bytes.

Maximum filename length–Raises a protocol anomaly if IDP detects an AIM/ICQ file name containing more
bytes than the specified maximum. The default is 10,000 bytes.

Check to see if the source port of client's packets is 68—Raises a protocol anomaly if IDP detects DHCP
traffic that originates from a port other than 68. This setting is not enabled by default.

DHCP

Report unknown DNS parameters (high noise)–Detects and reports unknown DNS parameters.

You must also configure an IDP rulebase rule to detect DNS anomalies. This setting is not enabled by default.

DNS

Report unexpected DNS parameters (high noise) –Detects and reports unexpected DNS parameters. This
setting is not enabled by default.

You must also configure an IDP rulebase rule to detect DNS anomalies.

Maximum length of a DNS UDP packet –Raises a protocol anomaly if IDP detects a DNS UDP packet
containing more bytes than the specified maximum. The default is 512 bytes.

Maximum size of a NXT resource record –Raises a protocol anomaly if IDP detects an NXT resource record
in a DNS request or response message of a greater size. The default is 4096 bytes.

This setting tunes the following protocol anomaly attack object: DNS_BIND_NXT_OVERFLOW (key is
DNS:OVERFLOW:NXT-OVERFLOW).

Maximum time of a dns cache –Controls the maximum amount of time for a DNS query and reply. The
default is 60 seconds.

Maximum number of logs in a session –Controls the maximum number of DNS queries kept to match a
reply. The default is 1000 queries.
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Table 50: IDP Device Configuration: Protocol Thresholds and Configuration Settings (continued)

DescriptionSetting

Maximum Line length–Raises a protocol anomaly if IDP detects an FTP username containing more bytes
than the specified maximum. The default is 32 bytes.

FTP

Maximum Username length–Raises a protocol anomaly if IDP detects an FTP password containing more
bytes than the specified maximum. The default is 64 bytes.

Maximum Password length –Raises a protocol anomaly if IDP detects an FTP pathname containing more
bytes than the specified maximum. The default is 512 bytes.

Maximum Pathname length –Raises a protocol anomaly if IDP detects an FTP pathname containing more
bytes than the specified maximum. The default is 512 bytes.

Maximum Sitestring length –Raises a protocol anomaly if IDP detects an FTP sitestring containing more
bytes than the specified maximum. The default is 512 bytes.

Maximum number of login failures per-minute–Raises a protocol anomaly if IDP detects more FTP login
failures in one minute than the specified maximum. The default is 4 FTP login failures per minute.

Maximum TTL hops–Raises a protocol anomaly if IDP detects a number of TTL hops that is higher than the
specified maximum. The default is 8 TTL hopes.

GNUTELLA

Maximum Line length–Raises a protocol anomaly if IDP detects, in a Gnutella connection, a line that contains
more bytes than the specified maximum. The default is 2048 bytes.

Maximum Query size–Raises a protocol anomaly if IDP detects a Gnutella client query that contains more
bytes than the specified maximum. The default is 256 bytes.

Maximum line length–Raises a protocol anomaly if IDP detects, in a Gopher server-to-client connection, a
line sent by a Gopher server to a client that contains more bytes than the specified maximum. The default
is 512 bytes.

GOPHER

Maximum hostname length–Raises a protocol anomaly if IDP detects, in a Gopher server-to- client connection,
a hostname that contains more bytes than the specified maximum. The default is 64 bytes.
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Table 50: IDP Device Configuration: Protocol Thresholds and Configuration Settings (continued)

DescriptionSetting

Maximum Request length–Raises a protocol anomaly if IDP detects an HTTP request that contains more
bytes than the specified maximum. The default is 8192 bytes.

HTTP

Maximum Header length–Raises a protocol anomaly if IDP detects an HTTP header that contains more
bytes than the specified maximum. The default is 8192 bytes.

Maximum Cookie length –Raises a protocol anomaly if IDP detects a cookie that contains more bytes than
the specified maximum. The default is 8192 bytes.

Cookies that exceed the cookie length setting can match the protocol anomaly ”r;HTTP-HEADER-OVERFLOW”
and produce unnecessary log records. If you are getting too many log records for the
HTTP-HEADER-OVERFLOW protocol anomaly, increase the maximum cookie length.

Maximum Authorization length–Raises a protocol anomaly if IDP detects an HTTP header authorization
line that contains more bytes than the specified maximum. The default is 512 bytes.

Use this setting to tune results from the Auth Overflow attack object (key is HTTP:OVERFLOW:AUTH-OVFLW).

Maximum Content-type length–Raises a protocol anomaly if IDP detects an HTTP header content-type that
contains more bytes than the specified maximum. The default is 512 bytes.

Maximum User-agent length–Raises a protocol anomaly if IDP detects an HTTP header user-agent that
contains more bytes than the specified maximum. The default is 256 bytes.

Maximum Host length–Raises a protocol anomaly if IDP detects an HTTP header host that contains more
bytes than the specified maximum. The default is 64 bytes.

Maximum Referrer length –Raises a protocol anomaly if IDP detects an HTTP header referrer that contains
more bytes than the specified maximum. The default is 8192 bytes.

Use alternate ports as http service–If selected, the security module watches for HTTP traffic on the following
ports in addition to tcp/80: 7001; 8000; 8001; 8100; 8200; 8080; 8888; 9080. This setting is enabled by
default.

Maximum number of login failures per-minute–Raises a protocol anomaly if IDP detects, between a unique
pair of hosts, more login failures than the specified maximum. The default is 4 HTTP authentication failures
per minute.

This setting tunes the BRUTE_FORCE attack object.

Maximum number of 301/403/404 or 405 errors per-minute–Raises a protocol anomaly if IDP detects,
between a unique pair of hosts, more 301/403/404/405 errors than the specified maximum. The default is
16 HTTP errors per minute.

Maximum Packets per second to trigger a flood–Raises a protocol anomaly if IDP detects more ICMP
packets than the specified maximum. The default is 250 packets per second.

ICMP

Minimum time interval (in seconds) between packets–Raises a protocol anomaly if IDP detects ICMP
packets that have less than the specified minimum time interval between them. The default is 1 second.

Use this setting to tune the Flood attack object (ICMP:EXPLOIT:FLOOD).
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Table 50: IDP Device Configuration: Protocol Thresholds and Configuration Settings (continued)

DescriptionSetting

Maximum requests per session–Raises a protocol anomaly if IDP detects more IDENT (identification protocol)
requests than the specified maximum. The default is 1 request per session.

This setting tunes the Too Many Requests attack object (key is IDENT:OVERFLOW:REQUEST-NUM).

IDENT

Maximum Request length–Raises a protocol anomaly if IDP detects an IDENT request containing more
bytes than the specified maximum. The default is 15 bytes.

This setting tunes the Request Too Long attack object (key is IDENT:OVERFLOW:REQUEST).

Maximum Reply length–Raises a protocol anomaly if IDP detects an IDENT reply containing more bytes
than the specified maximum. The default is 128 bytes.

This setting tunes the Reply Too Long attack object (key is IDENT:OVERFLOW:REPLY).

Maximum number of payloads in an IKE message–Raises a protocol anomaly if IDP detects an IKE message
with a higher number of payloads. The default is 57 payloads.

This setting tunes detection with the TOO-MANY-PAYLOADS attack object (key is
IKE:MALFORMED:2MANY-PAYLOAD).

IKE

Maximum Line length–Raises a protocol anomaly if IDP detects an IMAP line containing more bytes than
the maximum. The default is 2048 bytes.

IMAP

Maximum Username length–Raises a protocol anomaly if IDP detects an IMAP username containing more
bytes than the maximum. The default is 64 bytes.

Maximum Password length–Raises a protocol anomaly if IDP detects an IMAP password containing more
bytes than the specified maximum. The default is 64 bytes.

Maximum Mailbox length–Raises a protocol anomaly if IDP detects an IMAP mailbox containing more than
the maximum. The default is 64 bytes.

Maximum Reference length –Raises a protocol anomaly if IDP detects an IMAP reference containing more
bytes than the specified maximum. The default is 64 bytes.

Maximum Flag length–Raises a protocol anomaly if IDP detects an IMAP flag containing more bytes than
the specified maximum. The default is 64 bytes.

Maximum Literal length–Raises a protocol anomaly if IDP detects a literal with more octets than the specified
maximum. In IMAP4 protocol, a string can be in one of two forms: literal and quoted. As defined in RFC
2060 4.3, a literal is a sequence of zero or more octets (including CR and LF), prefix-quoted with an octet
count in the form of an open brace ("{"), the number of octets, close brace ("}"), and CRLF. Valid range is
1 to 1,67,77,215. The default is 65,535 bytes.

This setting tunes detection with the imap_literal_length_overflow attack object (key is
IMAP:OVERFLOW:LIT_LENGTH_OFLOW).

Maximum number of login failures per-minute–Raises a BRUTE_FORCE protocol anomaly if IDP detects
more login failures than the maximum. The default is 4 IMAP login failures per minute.
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Table 50: IDP Device Configuration: Protocol Thresholds and Configuration Settings (continued)

DescriptionSetting

Maximum Password length –Raises a protocol anomaly if IDP detects an Internet Relay Chat (IRC) password
containing more bytes than the specified maximum. The default is 16 bytes.

IRC

Maximum Username length–Raises a protocol anomaly if IDP detects an IRC username containing more
bytes than the specified maximum. The default is 16 bytes.

Maximum Channel length–Raises a protocol anomaly if IDP detects an IRC channel name containing more
bytes than the specified maximum. The default is 64 bytes.

Maximum Nickname length–Raises a protocol anomaly if IDP detects an IRC nickname containing more
bytes than the specified maximum. The default is 16 bytes.
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Table 50: IDP Device Configuration: Protocol Thresholds and Configuration Settings (continued)

DescriptionSetting

Maximum length of Integer representation in BER encoding–Raises a protocol anomaly if IDP detects an
integer field of the LDAP BER containing more bytes than the specified maximum. The default is 4 bytes.

LDAP

Maximum number of left zeros for tag in BER encoding–Raises a protocol anomaly if IDP detects more
left zeros in any tag in LDAP BER encoding than the specified maximum. The default is 4 left zeros.

Maximum value of any LDAP tag in BER encoding–Raises a protocol anomaly if IDP detects a value for a
tag that can be seen in the LDAP BER encoding that is greater than the specified maximum. LDAP tags are
represented using 1 byte, with the top 3 bits reserved. The default is 31.

Maximum number of left zeros for length in BER encoding–Raises a protocol anomaly if IDP detects more
left zeros in any length field in LDAP BER encoding than the specified maximum. The default is 64 left zeros.

Maximum number of search results requested by LDAP client–Raises a protocol anomaly if IDP detects
an LDAP client request for more matching entries than the specified maximum. The default is 0 (indicating
no limit).

Maximum timelimit for search result requested by LDAP client–Raises a protocol anomaly if IDP detects
a time limit greater than the specified maximum. The time limit is the number of seconds before a client
request times out waiting for a response from the server. The default is 0 (indicating no limit).

Maximum length of an LDAP Attribute Descriptor–Raises a protocol anomaly if IDP detects a length of an
attribute descriptor field in an LDAP message containing more bytes than the specified maximum. The default
is 512 bytes.

Maximum length of an LDAP Distinguished Name–Raises a protocol anomaly if IDP detects a length of a
distinguished name field in the LDAP message containing more bytes than the specified maximum. The
default is 512 bytes.

Maximum value of Message id in any LDAP Message –Raises a protocol anomaly if IDP detects a message
ID greater than the specified maximum. The default is 2,14,74,83,647.

Maximum length of an LDAP message–Raises a protocol anomaly if IDP detects a LDAP message that will
be processed by the LDAP subsystem larger than the specified maximum. The default is 8100 bytes.

This setting tunes the MESSAGE_TOO_LONG attack object. If IDP raises this anomaly, it logs the event and
skips the message.

Maximum number of nested operators in an LDAP search request–Raises a protocol anomaly if IDP detects
a number of nested levels allowed in an LDAP search request filter argument greater than the specified
maximum. The default is 8 nested operators.

Maximum Number of login failures per-minute–Raises a BRUTE_FORCE protocol anomaly if IDP detects
more login failures than the maximum. The default is 4 LDAP login failures per minute.
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Table 50: IDP Device Configuration: Protocol Thresholds and Configuration Settings (continued)

DescriptionSetting

Maximum Sub-command length in RECEIVE-JOB Command–Raises a protocol anomaly if IDP detects in
an Line Printer Protocol (LPR) control file a sub command line containing more bytes than the specified
maximum. LPR is a TCP-based print server protocol used by line printer daemons (client and server) to
communicate over networks. An LPR client uses the LPR protocol to send a print command to an LPR server
(a line printer) at TCP/515. After the print command is received by the server, the client can issue
subcommands to the server and send control and data files. Control files tell the line printer which functions
to perform when printing the file; data files carry the payload. The default is 256 bytes.

LPR

Maximum Reply length from server–Raises a protocol anomaly if IDP detects an LPR control filename
containing more bytes than the specified maximum. The default is 64 bytes.

Maximum Control filename length–Raises a protocol anomaly if IDP detects an LPR control filename
containing more bytes than the specified maximum. The default is 64 bytes.

Maximum Data filename length–Raises a protocol anomaly if IDP detects a data filename containing more
bytes than the specified maximum. The default is 64 bytes.

Maximum Control file size–Raises a protocol anomaly if IDP detects an LPR control file size greater than
the specified maximum. The default is 1024 bytes.

Maximum Data file size–Raises a protocol anomaly if IDP detects an LPR data file size greater than the
specified maximum. The default is 64 bytes.

Maximum Banner string length–Raises a protocol anomaly if IDP detects an LPR banner string containing
more bytes than the specified maximum. A banner string is typically the filename of the print job. The default
is 32 bytes.

Maximum E-mail length –Raises a protocol anomaly if IDP detects an LPR control file e-mail address
containing more bytes than the specified maximum. After the file has printed, it is sent to the e-mail address
specified in the control file. The default is 32 bytes.

Maximum Symbolic link length –Raises a protocol anomaly if IDP detects in an LPR control file a symbolic
link containing more bytes than the specified maximum. A symbolic link is a file that points to another file
(entry) in a UNIX file system, but does not contain the data in the target file. When the LPR protocol receives
a symbolic link command in a control file, it records the symbolic link data for the print job filename to
prevent directory entry changes from reprinting the file. The default maximum is 128 bytes.

Maximum font length –Raises a protocol anomaly if IDP detects in an LPR control file a font name containing
more bytes than the specified maximum. The default is 64 bytes.

Maximum filename length for format related sub commands–Raises a protocol anomaly if IDP detects in
an LPR control file a format-related file name containing more bytes than the specified maximum. The default
is 32 bytes.
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Table 50: IDP Device Configuration: Protocol Thresholds and Configuration Settings (continued)

DescriptionSetting

Maximum Username length–Raises a protocol anomaly if IDP detects an MSN (Microsoft Instant Messaging)
username containing more bytes than the specified maximum. The default is 84 bytes.

MSN

Maximum Display name length–Raises a protocol anomaly if IDP detects an MSN display name containing
more bytes than the specified maximum. The default is 128 bytes.

Maximum Group name length–Raises a protocol anomaly if IDP detects an MSN group name containing
more bytes than the specified maximum. The default is 84 bytes.

Maximum User state length–Raises a protocol anomaly if IDP detects an MSN user state containing more
bytes than the specified maximum. A user state is a three-letter code that indicates the status of the user's
connection (online, offline, idle, and so on). The default is 10 bytes.

Maximum Phone number length –Raises a protocol anomaly if IDP detects a phone number containing
more bytes than the specified maximum. The default is 20 bytes.

Maximum Length of IP:port–Raises a protocol anomaly if IDP detects an IP:port parameter containing more
bytes than the specified maximum. An IP:port parameter indicates the IP address and port number of the
MSN server for a switchboard session. The default is 30 bytes.

Maximum URL length–Raises a protocol anomaly if IDP detects a URL containing more bytes than the
specified maximum. The default is 1024 bytes.

Maximum fragment length in MSRPC message–Raises a protocol anomaly if IDP detects an MSRPC (Microsoft
Remote Procedure Call) message with a fragment length greater than the specified maximum. The default
is 8192.

MSRPC

Maximum tower data length in endpoint mapper messages–Raises a protocol anomaly if IDP detects an
endpoint mapper message with a tower data length greater than the specified maximum. The default is
8192.

Maximum number of entries in an insert message–Raises a protocol anomaly if IDP detects an MSRPC
insert message with more entries than the specified maximum. The default is 100 entries.

Maximum Name length –Raises a protocol anomaly if IDP detects an NFS packet name containing more
bytes than the specified maximum. The default is 256 bytes.

NFS

Maximum Path length–Raises a protocol anomaly if IDP detects an NFS packet pathname containing more
bytes than the specified maximum. The default is 1024 bytes.

Maximum buffer length for read/write–Raises a protocol anomaly if IDP detects an NFS read/writer buffer
larger than the specified maximum. The default is 32,768 bytes.
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Table 50: IDP Device Configuration: Protocol Thresholds and Configuration Settings (continued)

DescriptionSetting

Minimum time (in seconds) between two requests–Raises a protocol anomaly if IDP detects the time
between two client-to-server NTP requests is greater than the specified maximum. Valid values range from
64 to 1024 seconds. The default is 0 seconds (which turns the feature off).

NTP

Maximum length for NTPv3 message–Raises a protocol anomaly if IDP detects an NTPv3 message containing
more bytes than the specified maximum. The default is 68 bytes.

Maximum length for NTPv4 message–Raises a protocol anomaly if IDP detects an NTPv4 message containing
more bytes than the specified maximum. The default is 68 bytes.

Maximum stratum value for any NTP peer–Raises a protocol anomaly if IDP detects a stratum value larger
than the specified maximum. The default is 15 bytes.

Maximum time since last update of Reference clock–Raises a protocol anomaly if IDP detects that the
NTP reference clock has not been updated in more time than the specified maximum. The default is 86,400
seconds.

Match timestamps on NTP request and response–Enables IDP to perform timestamp matching on client
requests and server responses. With this setting enabled, IDP expects the server response original timestamp
to match the client request transmit timestamp; otherwise IDP considers the packet a possible protocol
anomaly. This setting is enabled by default.

Maximum Authorization field length in NTP control message–Raises a protocol anomaly if IDP detects
that the length of the Authentication fields in an NTP control message is larger than the specified maximum.
The default is 20 bytes.

Maximum length of any NTP control variable–Raises a protocol anomaly if IDP detects that the length of
NTP control data variable name is larger than the specified maximum. The default is 128 bytes.

Maximum length of any NTP variable value–Raises a protocol anomaly if IDP detects that the length of
any NTP control data variable value is larger than the specified maximum. The default is 255 bytes.

Maximum length of buffer to store between control packets–NTP control messages can be split across
multiple UDP packets. This setting is the maximum number of characters that IDP stores in memory to
ensure continuity from one packet to the other. The default is 255 bytes.

Maximum time for an NTP Symmetric passive association to dissolve–A symmetric passive association
between two NTP peers must be dissolved after sending one reply. This setting is the time in seconds after
which IDP considers such an association as expired.The default is 900 seconds.
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Table 50: IDP Device Configuration: Protocol Thresholds and Configuration Settings (continued)

DescriptionSetting

Maximum Line length–Raises a protocol anomaly if IDP detects a POP3 line containing more bytes than
the specified maximum. The default is 512 bytes.

POP3

Maximum Username length–Raises a protocol anomaly if IDP detects a POP3 username containing more
bytes than the specified maximum. The default is 64 bytes.

Maximum Password length–Raises a protocol anomaly if IDP detects a POP3 password containing more
bytes than the specified maximum. The default is 64 bytes.

Maximum APOP length –Raises a protocol anomaly if IDP detects an APOP containing more bytes than the
specified maximum. The default is 100 bytes.

Maximum message number–Raises a protocol anomaly if IDP detects a POP3 message number that is
higher than the specified maximum. The default is 10,00,000.

Maximum number of login failures per-minute–Raises a BRUTE_FORCE protocol anomaly if IDP detects
more login failures than the specified maximum. The default is 4 POP3 login failures per minute.

Maximum number of authenticated failures per-minute–Raises a BRUTE_FORCE protocol anomaly if IDP
detects more login failures than the specified maximum. The default is 4 RADIUS login failures per minute.

RADIUS

Max-Forwards threshold–Raises a protocol anomaly if IDP detects maximum number of thresholds.SIP

Maximum registry key length–Raises a protocol anomaly if IDP detects an SMB registry key containing
more bytes than the specified maximum. The default is 8192 bytes.

SMB

Maximum number of login failures per-minute–Raises a BRUTE_FORCE protocol anomaly if IDP detects
more login failures than the specified maximum. The default is 4 SMB login failures per minute.
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Table 50: IDP Device Configuration: Protocol Thresholds and Configuration Settings (continued)

DescriptionSetting

Maximum Number of mail recipients–Raises a protocol anomaly if IDP detects an SMTP message containing
more recipients than the specified maximum. The default is 100 recipients.

SMTP

Maximum Username length in RCPT and MAIL–Raises a protocol anomaly if IDP detects an SMTP message
with a username containing more bytes than the specified maximum. The default is 256 bytes.

Maximum Domain name length in RCPT and MAIL–Raises a protocol anomaly if IDP detects an SMTP
message with a domain name containing more bytes than the specified maximum. The default is 64 bytes.

Maximum Path length in RCPT and MAIL–Raises a protocol anomaly if IDP detects an SMTP message with
a pathname containing more bytes than the specified maximum. The default is 256 bytes.

Maximum Command line length (before DATA)–Raises a protocol anomaly if IDP detects an SMTP message
with a command-line entry containing more bytes than the specified maximum. The default is 1024 bytes.

Maximum Reply line length from server (default)–Raises a protocol anomaly if IDP detects an SMTP
message with a reply line from the server containing more bytes than the specified maximum. The default
is 512 bytes.

Maximum Text line length (after DATA)–Raises a protocol anomaly if IDP detects an SMTP text line
containing more bytes than the specified maximum. The default is 1024 bytes.

Maximum number of nested mime multi-part attachments–Raises a protocol anomaly if IDP detects more
nested attachments than the specified maximum. The default is 4 nested mime multi-part attachments.

Maximum number of base-64 bytes to decode–Raises a protocol anomaly if IDP detects more bytes of
encoded mime data than the specified maximum. The default is 64 bytes.

Maximum length of the value for content-type's name attribute–Raises a protocol anomaly if IDP detects
a name attribute in the content-type header containing more bytes than the specified maximum. The default
is 128 bytes.

Maximum length of the value for the content-disposition's filename attribute–Raises a protocol anomaly
if IDP detects a filename attribute in the content-disposition header containing more bytes than the specified
maximum. The default is 128 bytes.

Look for email headers in message data–Controls whether IDP looks for e-mail headers in the message
data, which can occur when a bounced email contains an attachment. This setting is not enabled by default.

Validate RFC-3164 compliant timestamp format–If selected, the security module checks the timestamp
in syslog traffic to ensure that it is compliant with RFC 3164. If the timestamp is not compliant, the security
module considers the traffic a possibly anomaly. This setting is not enabled by default.

SYSLOG

Maximum number of login failures per-minute–Raises a BRUTE_FORCE protocol anomaly if IDP detects
more login failures than the specified maximum. The default is 4 TELNET login failures per minute.

TELNET

Maximum Filename length–Raises a protocol anomaly if IDP detects a filename containing more bytes
than the specified maximum. The default is 128 bytes.

TFTP
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Table 50: IDP Device Configuration: Protocol Thresholds and Configuration Settings (continued)

DescriptionSetting

Maximum Reason string length–Raises a protocol anomaly if IDP detects a VNC (Virtual Network Computing)
reason string length greater than the specified maximum. A reason string contains the text that describes
why a connection between a VNC server and client failed. The default is 512 bytes.

VNC

Maximum Display name length–Raises a protocol anomaly if IDP detects a VNC display name containing
more bytes than the specified maximum. The default is 128 bytes.

Maximum cut text length–Raises a protocol anomaly if IDP detects a VNC cut text buffer containing more
bytes than the specified maximum. The default is 4096 bytes.

Verify message after the initial handshake–Enables the security module to verify VNC connections after
the initial handshake. This setting is not enabled by default.

Maximum number of login failures per-minute–Raises a BRUTE_FORCE protocol anomaly if IDP detects
more login failures than the specified maximum. The default is 4 VNC login failures per minute.

Maximum Request length–Raises a protocol anomaly if IDP detects a WHOIS request containing more bytes
than the specified maximum. The default is 128 bytes.

WHOIS
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Table 50: IDP Device Configuration: Protocol Thresholds and Configuration Settings (continued)

DescriptionSetting

Maximum Message length–Raises a protocol anomaly if IDP detects a Yahoo! Messenger message with a
header that indicates more bytes for the total message than the specified maximum. The default is 8192
bytes.

YMSG

Maximum Username length–Raises a protocol anomaly if IDP detects a Yahoo! Messenger ID containing
more bytes than the specified maximum. The default is 84 bytes.

Maximum Groupname length–Raises a protocol anomaly if IDP detects a Yahoo! Messenger group name
containing more bytes than the specified maximum. The default is 84 bytes.

Maximum Crypt length–Raises a protocol anomaly if IDP detects a Yahoo! Messenger encrypted password
containing more bytes than the specified maximum. The default is 124 bytes.

Maximum Instant message length–Raises a protocol anomaly if IDP detects a Yahoo! Messenger message
containing more bytes than the specified maximum. The default is 1024 bytes.

Maximum Activity string length–Raises a protocol anomaly if IDP detects a Yahoo! Messenger activity data
type containing more bytes than the specified maximum. The default is 8000 bytes.

Maximum Challenge length–Raises a protocol anomaly if IDP detects a Yahoo! Messenger challenge
containing more bytes than the specified maximum. The default is 15 bytes.

Maximum Cookie length–Raises a protocol anomaly if IDP detects a Yahoo! Messenger cookie containing
more bytes than the specified maximum. The default is 84 bytes.

Maximum URL length–Raises a protocol anomaly if IDP detects a Yahoo! Messenger Web Name containing
more bytes than the specified maximum. The default is 400 bytes.

Maximum Conference message length–Raises a protocol anomaly if IDP detects a Yahoo! Messenger join
conference message containing more bytes than the specified maximum. The default is 1024 bytes.

Maximum Conference name length –Raises a protocol anomaly if IDP detects a Yahoo! Messenger conference
name containing more bytes than the specified maximum. The default is 1024 bytes.

Maximum E-mail length–Raises a protocol anomaly if IDP detects a Yahoo! Messenger new e-mail alert
containing an e-mail that has more bytes than the specified maximum. The default is 84 bytes.

Maximum E-mail subject length–Raises a protocol anomaly if IDP detects an Yahoo! Messenger subject
line containing more bytes than the specified maximum. The default is 128 bytes.

This setting tunes the Mail Subject Overflow attack object (key is CHAT:YIM:OVERFLOW:MAIL-SUBJECT).

Maximum Filename length–Raises a protocol anomaly if IDP detects a Yahoo! Messenger file transfer
containing a filename that has more bytes than the specified maximum. The default is 1000 bytes.

Maximum Chatroom name length–Raises a protocol anomaly if IDP detects a Yahoo! Messenger chat room
name containing more bytes than the specified maximum. The default is 1024 bytes.

Maximum Chatroom message length–Raises a protocol anomaly if IDP detects a Yahoo! Messenger chat
room message containing more bytes than the specified maximum. The default is 2000 bytes.

Maximum buddy list length–Raises a protocol anomaly if IDP detects a Yahoo! Messenger buddy list
containing more bytes than the specified maximum. The default is 8000 bytes.
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Table 50: IDP Device Configuration: Protocol Thresholds and Configuration Settings (continued)

DescriptionSetting

Maximum webcam key length –Raises a protocol anomaly if IDP detects an Yahoo! Messenger Webcam
key containing more bytes than the specified maximum. The default is 124 bytes.

Related Topics ■ Updating the IDP Detector Engine (NSM Procedure) on page 72

■ Configuring Traffic Anomalies Rulebase Rules (NSM Procedure) on page 47
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Chapter 9

Configuring Additional Intrusion Detection
and Prevention Features

■ Configuring Additional Intrusion Detection and Prevention Features
Overview on page 103

■ Enabling Intrusion Detection and Prevention Processing of Encrypted and
Encapsulated Traffic (NSM Procedure) on page 103

Configuring Additional Intrusion Detection and Prevention Features Overview

You can configure additional IDP features in NSM, including enabling IDP processing
of encrypted and encapsulated traffic. For more information on configuring the
following features, see the IDP ACM online Help.

■ Traffic interfaces

■ IDP in advanced deployment modes

■ Enable Spanning Tree Protocol

■ High availability deployments

■ Interoperability with Secure Access devices and Infranet Controllers

Related Topics NSM and Intrusion Detection and Prevention Device Management Overview on
page 5

■

■ Configuring Anti-Spoof Settings in Intrusion Detection and Prevention Devices
(NSM Procedure) on page 77

■ Enabling Intrusion Detection and Prevention Processing of Encrypted and
Encapsulated Traffic (NSM Procedure) on page 103

Enabling Intrusion Detection and Prevention Processing of Encrypted and
Encapsulated Traffic (NSM Procedure)

You can enable IDP processing of encrypted and encapsulated traffic through NSM.

Enabling SSL Decryption on page 1041.

2. Enabling GRE Decapsulation on page 104

3. Enabling GTP Decapsulation on page 105
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Enabling SSL Decryption

You can enable inspection of SSL traffic by first adding keys for the target SSL servers
to the IDP keystore and then enabling the IDP SSL decryption feature.

For an overview of the IDP SSL decryption feature and lists of supported encryption
algorithms and SSL ciphers, see the IDP Concepts & Examples Guide.

To add keys for target SSL servers to the IDP keystore:

1. Use SCP or FTP to copy your private key file to the IDP device. IDP does not run
an FTP server, so you have to initiate the FTP session from the IDP device.

2. Add the key to the IDP keystore.

3. Retrieve the key ID from the IDP keystore.

4. Add any other servers that use the same key.

To enable SSL decryption:

1. In the NSM Device Manager, double-click the IDP device to display the device
configuration editor.

2. Click  Sensor Settings.

3. Click the Run-Time Parameters tab.

4. Expand the Run-Time Parameters group.

5. Select Enable SSL decryption support.

6. Click OK.

Enabling GRE Decapsulation

To enable GRE decapsulation:

1. In the NSM Device Manager, double-click the IDP device to display the device
configuration editor.

2. Click Sensor Settings.

3. Click the Run-Time Parameters tab.

4. Expand the Run-Time Parameters group.

5. Select Enable GRE decapsulation support.

6. Click OK.
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Enabling GTP Decapsulation

To enable GTP decapsulation:

1. In the NSM Device Manager, double-click the IDP device to display the device
configuration editor.

2. Click Sensor Settings.

3. Click the Run-Time Parameters tab.

4. Expand the Run-Time Parameters group.

5. Select Enable GTP decapsulation support.

6. Click OK.

Related Topics ■ Configuring Additional Intrusion Detection and Prevention Features Overview
on page 103

■ NSM and Intrusion Detection and Prevention Device Management Overview on
page 5
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Part 3

Managing Intrusion Detection and
Prevention Devices

■ Managing Security Policies in Intrusion Detection and Prevention
Devices on page 109
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Chapter 10

Managing Security Policies in Intrusion
Detection and Prevention Devices

■ Assigning a Security Policy in an Intrusion Detection and Prevention Device (NSM
Procedure) on page 109

■ Validating a Security Policy (NSM Procedure) on page 110

■ Troubleshooting Security Policy Validation Errors (NSM Procedure) on page 110

■ Pushing Security Policy Updates to an IDP Device (NSM Procedure) on page 111

■ Troubleshooting Configuration Push Errors (NSM Procedure) on page 113

■ Disabling Rules (NSM Procedure) on page 114

■ Exporting Security Policies (NSM Procedure) on page 114

Assigning a Security Policy in an Intrusion Detection and Prevention Device (NSM
Procedure)

After you have created the necessary firewall and IDP rules within the security policy,
you must perform the following steps to assign a security policy.

To assign an existing policy to the IDP device:

1. In the NSM navigation tree, select Policy Manager > Security Policies.

2. In Device Manager, right-click the IDP device and select Policy > Assign Policy.

3. From the Security Policy Name list, select the security policy you just created.

4. Click OK.

For more information, see the IDP Concepts & Examples Guide or Network and Security
Manager Administration Guide.

Related Topics Intrusion Detection and Prevention Devices and Security Policies Overview on
page 25

■

■ Validating a Security Policy (NSM Procedure) on page 110

■ Troubleshooting Security Policy Validation Errors (NSM Procedure) on page 110
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Validating a Security Policy (NSM Procedure)

Validating a security policy can identify potential problems before you install it.

To validate a security policy:

1. In the navigation tree, select Device Manager. The Device manager appears.

2. Select Validate > Validate IDP Policy and select the device. A Job Manager
window displays job information and progress.

3. Click OK.

For more information, see either the IDP Concepts & Examples Guide or the Network
and Security Manager Administration Guide.

Related Topics Intrusion Detection and Prevention Devices and Security Policies Overview on
page 25

■

■ Assigning a Security Policy in an Intrusion Detection and Prevention Device (NSM
Procedure) on page 109

■ Troubleshooting Security Policy Validation Errors (NSM Procedure) on page 110

Troubleshooting Security Policy Validation Errors (NSM Procedure)

Problem If NSM identifies a problem in the policy during policy validation, it displays
information about the problem at the bottom of the selected rulebase. For example,
if you included a non-IDP capable security device in the Install On column of an IDP
rule, policy validation displays an error message. You can validate those errors and
troubleshoot them.

Table 51 on page 110 describes security policy validation errors and how to resolve
them.

Table 51: Troubleshooting: Security Policy Validation Errors

DescriptionError

Rule appears more than once.

To resolve this problem, delete the duplicate.

Rule Duplication

Rule shadowing occurs when two rules are designed to detect the same attack, and the first
rule is either a terminal match rule or contains a more severe action than the second rule.
In these cases, the second rule will never be applied.

To resolve this problem, modify or delete one of the rules.

Rule Shadowing
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Table 51: Troubleshooting: Security Policy Validation Errors (continued)

DescriptionError

Protocol mismatches occur when a service object that is specified in the Service column of
the security policy uses a different protocol from that specified by the default service binding
of the attack object for that rule. Remember that the service binding specifies the service
and port that the attack uses. Because two different protocols are specified, IDP cannot
match attacks for the attack object.

To resolve this problem, set Service to Default.

Protocol Mismatches

Any-Any-None rules are rules that specify any for the source and destination and none for
attacks. Because IDP must log all packets for all connections, this rule can cause severe IDP
performance penalties.

To resolve this problem, specify network objects for the destination and attack objects for
the attacks.

Any-Any-None Rules

Any-Any-One rules are rules that specify any for the source and destination and a single
attack object for attacks. Because IDP must look at all network traffic, this rule can cause
severe IDP performance penalties.

To resolve this problem, specify network objects for the destination.

Any-Any-One Rules

Rule contains options that are not supported on the target device.

To resolve this problem, upgrade the target device or remove the option from the rule.

Unsupported Options

Related Topics Intrusion Detection and Prevention Devices and Security Policies Overview on
page 25

■

■ Assigning a Security Policy in an Intrusion Detection and Prevention Device (NSM
Procedure) on page 109

■ Validating a Security Policy (NSM Procedure) on page 110

Pushing Security Policy Updates to an IDP Device (NSM Procedure)

You must run a device configuration update job (also called pushing an update) in
the following cases:

■ After you have revised the security policy assigned to an IDP device. The
configuration changes you make in NSM do not affect the IDP device until you
have successfully pushed the configuration to the IDP device.

■ If you have deleted the device from NSM and reinstall it. In these cases, the IDP
device does not retain the previous security policy assignment.

■ If you use the NSM Device Manager to change IDP device settings.

To push configuration updates to multiple IDP devices:

1. Select Devices > Configuration > Update Device Config to display the Update
Devices Options dialog box.
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2. Select the devices that you want to push configuration updates to and to set
update job options on. Table 52 on page 112 describes devices update job options.

3. Click OK.

Table 52: Devices Update Job Options

DescriptionTab

Run Summarize Delta Config–—Summarizes and runs the delta change in the configuration.General

Lock configuration during update—Locks configuration while updating device configuration.Netconf

Update to candidate config first before commit to running config—Updates the configuration
before committing.

Use confirmed commit—Enables commit confirmed.

Rollback candidate config to running config in error—Rollbacks when there is error generated
during the configuration.

Discard uncommitted changes when exclusive lock is available—Discards any uncommitted
changes during exclusive lock.

Show unconnected devices—Lists all devices that are not connected.ScreenOS and IDP

Update when device connects—Updates configuration when the devices are connected.

Firewall Device Options—Not applicable.

Standalone IDP device options—Includes the following option:

■ Restart IDP Profiler after Device Update—Restarts the Profiler.

ISG Device Options—Not applicable.

To push an update to a specific, single device:

1. In Device Manager, right-click the device that you want to push the update to
and select Update Device to display the Update Device Options dialog box.

2. Set update job options using Table 53 on page 112.

3. Click OK.

Table 53: Device Update Job Options

DescriptionOption

Updates the device whenever there exist a connection between the devices.Update When Device Connects

Restarts the profiler when the device gets updated.Restart IDP Profiler After Device Update

Updates IDP rulebase only.Update IDP Rulebase Only
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Table 53: Device Update Job Options (continued)

DescriptionOption

Does not allow this dialog box to appear again.Don’t Show This Dialog

For more information, see the IDP Concepts & Examples Guide.

Related Topics NSM and Intrusion Detection and Prevention Device Management Overview on
page 5

■

■ Troubleshooting Configuration Push Errors (NSM Procedure) on page 113

Troubleshooting Configuration Push Errors (NSM Procedure)

Problem Table 54 on page 113 provides tips for troubleshooting errors related to NSM
configuration push jobs.

Table 54: Troubleshooting: Configuration Push Errors

DescriptionError

The default timeout for IDP policy is 2400000 milliseconds (40 minutes).

When you first push a policy to a newly deployed IDP device, NSM must send a lot of
information (mostly attack definitions). In some cases, the update job can time out before it
completes.

To modify the timeout setting:

1. On the NSM Device Server, open the following file in a text editor:

/usr/netscreen/DevSvr/var/devSvr.cfg

2. Modify the following setting:

devSvrDirectiveHandler.idpPolicyPush.timeout 2400000

Timeout

Different versions of IDP use different detector engines. Not all attack objects are valid for all
versions of the detector engine. IDP indicates which attack objects in the security policy were
not valid for the loaded detector engine and, therefore, not loaded.

This message is for information purposes only and does not indicate a problem with the IDP
device or the policy.

The following attacks/groups
cannot be updated. Not
supported for version.

You try to load a policy that contains a firewall rulebase onto a standalone IDP device.

This message just means that IDP cannot process the firewall rulebase. The IDP rulebases
are still processed normally, assuming no other errors.

No firewall rules can be
updated for device in assigned
policy policyName.
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Table 54: Troubleshooting: Configuration Push Errors (continued)

DescriptionError

Setting the rule to log packets causes IDP to save packets until it is sure that they will not be
needed for a log entry. A rule that has any in the Source IP column and any in the Destination
IP column examines all traffic. So, IDP has to save a lot of packets all the time, which impacts
performance.

Rule #: Packet logging with
any/any rule has serious
performance implications.

For performance reasons, IDP does not spend resources recompiling a security policy that
has not changed.

Policy has not changed and
hence will not be updated.

Something has gone wrong with the policy compilation. Other error messages may indicate
why.

Failed to update device. Failed
to compile policy.

The device does not have a valid license. Unlicensed devices do not accept policy uploads.No license for idp.

Related Topics NSM and Intrusion Detection and Prevention Device Management Overview on
page 5

■

■ Pushing Security Policy Updates to an IDP Device (NSM Procedure) on page 111

Disabling Rules (NSM Procedure)

You can disable a rule without deleting it in cases where you run tuning experiments,
troubleshoot an issue, or otherwise need to make a quick or temporary modification.

To disable a rule, right-click inside the No. column (the first column) of the rule and
select Disable. The rule remains in the rulebase, but a gray diagonal stripe indicates
that it has been disabled. While the rule is disabled, NSM does not install the rule on
any devices.

To enable a rule, right-click inside the No. column (the first column) of the rule and
select Disable again to clear the check box. You can disable rule groups using the
same method. For more information, see the Network and Security Manager
Administration Guide.

NOTE: You cannot disable an entire security policy or a rulebase.

Related Topics NSM and Intrusion Detection and Prevention Device Management Overview on
page 5

■

■ Modifying IDP Rulebase Rules (NSM Procedure) on page 30

Exporting Security Policies (NSM Procedure)

You can export a security policy rulebase to an HTML file.
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To export a security policy to an HTML file:

1. Select the security policy and select File > Export Policy to display the Export
Policy dialog box.

2. Select the rulebases you want to export.

3. Select a directory in which to save the exported file.

4. Click Export to complete the operation.

Each export creates a new directory. The default directory name is
policyname_YYMMDD_HHMMSS. The export process puts each rulebase in a separate
HTML file in that directory.

Use an HTML browser to view the exported file. For more information, see the
Network and Security Manager Administration Guide.

Related Topics ■ Intrusion Detection and Prevention Devices and Security Policies Overview on
page 25

■ Assigning a Security Policy in an Intrusion Detection and Prevention Device (NSM
Procedure) on page 109
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Part 4

Monitoring Intrusion Detection and
Prevention Devices

■ Working with NSM Logs and Reports on page 119

■ Working with Intrusion Detection and Prevention Reporter Reports on page 133
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Chapter 11

Working with NSM Logs and Reports

■ NSM Logs and Reports Overview on page 119

■ Viewing Logs on page 119

■ Viewing Device Status on page 122

■ Viewing NSM Predefined Reports on page 125

■ Creating NSM Custom Reports on page 127

■ Configuring Log Suppression on page 130

NSM Logs and Reports Overview

IDP devices generate logs about device status based on built-in criteria and about
security events based on the security policy notification settings. These logs are
automatically sent to the NSM GUI server and can be viewed in the NSM log viewer.

IDP administration includes the following log-related tasks:

■ Viewing device status, logs, and reports

■ Configuring log suppression, if you want to reduce the number of identical log
files

Related Topics Viewing Logs on page 119■

■ Configuring Syslog Collection (NSM Procedure) on page 76

Viewing Logs

NSM logging tools provide a high-level view of the activity on your network, enabling
you to view summaries as well as detailed information. You can choose to view log
entries for an event that occurs across domains. This section includes the following
primary sections:

IDP Logs on page 1201.

2. Using NSM Log Investigator on page 120

3. Using NSM Audit Log Viewer on page 120
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IDP Logs

NSM collects logs from managed IDP devices and stores them in a central log
database. You can use NSM to view, manipulate, and export logs.

Table 55 on page 120 provides a reference of log views.

Table 55: Log Viewing Options

DescriptionLog Views

Logs based on notification options you set for security policy rules.

Logs related to device events, such as changes in the state of a traffic interface.

NSM Log Viewer / Log
Investigator

Logs produced by the Profiler feature.NSM Log Viewer / Log
Investigator

NSM Security Monitor

Logs generated by NSM related to the use of NSM to manage the IDP device.NSM Audit Log Viewer

Logs produced by the application volume tracking (AVT) feature.statview utility

Using NSM Log Investigator
Purpose You use the NSM Log Investigator to analyze aggregations of logs and drill down

based on properties of interest.

Action To display logs in NSM Log Investigator, select Investigate > Log Investigator.

TIP: For details on using NSM to modify aggregation or display options, see the NSM
online Help.

Using NSM Audit Log Viewer
Purpose You use the NSM Audit Log Viewer to track the administrative changes made to a

managed device. Log-entry details include the administrator that performed the
change, when the change occurred, and the job results.

Action To display the NSM Audit Log Viewer table, select Investigate > Audit Log Viewer
.

Table 56 on page 121 describes the columns in the Audit Log Viewer table.
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Table 56: NSM Audit Log Viewer Table

DescriptionColumn

The time the object was changed. The Audit Log Viewer displays log entries in order of time generated by
Greenwich Mean Time (GMT).

Time Generated

The name of the NSM administrator who changed the object.Admin Name

The name of the domain (global or subdomain) that contains the changed object.Admin Login
Domain

The final access-control status of activities is either success or failure.Authorization
Status

The command applied to the object or system, for example, sys_logout or modify.Command

For changes made to a device configuration or object, the Audit Log Viewer displays the object type, an
object name, and object domain.

Targets

For changes made to a device, the Audit Log Viewer displays the device name, object type, and device
domain.

For changes made to the management system, such as administrator login or logout, the Audit Log Viewer
does not display target or device data.

Devices

Additional information that is not displayed in other audit log columns.Miscellaneous

To display details of a configuration change, such as a changed IP address or renamed
device, select the audit log entry for that change in the Audit Log table and view
details in the Target View table, which appears below the Audit Log Viewer table.

Table 57 on page 121 describes the Target View table.

Table 57: NSM Audit Log Viewer: Target View Table

DescriptionColumn

To see additional details for an target view entry, double-click the entry. NSM displays the configuration
screen that the change was made in and marks the changed field with a solid green triangle.

Target Name

To set the table details for the target view entry, double-click the table. Enter or update the options.Table

Specifies the domain ID of the target view.Domain ID

To display details of a non-configuration event, such as adding the device,
auto-detecting a device, or rebooting a device, select the audit log entry for that
change in the Audit Log table and view details in the Device View table, which is
displayed below the Audit Log Viewer table.

Table 58 on page 122 describes the Device View table.
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Table 58: NSM Audit Log Viewer: Device View Table

DescriptionColumn

To see additional details for an device view entry, double-click the entry. NSM displays the Job Manager
information window for the job task.

Device Name

To set the table details for the device view entry, double-click the table. Enter or update the options.Table

Specifies the domain ID of the device view.Domain ID

Related Topics Viewing Device Status on page 122■

■ NSM Logs and Reports Overview on page 119

■ Configuring Syslog Collection (NSM Procedure) on page 76

Viewing Device Status

Table 59 on page 122 lists and describes device information that you can view through
the Device Monitor.

Table 59: Device Status Information

DescriptionColumn

Unique name assigned to the device in NSM.Name

Domain in NSM in which the device is managed.Domain

Model number of the device.Platform

Operating system firmware version running on the device.OS Version
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Table 59: Device Status Information (continued)

DescriptionColumn

Current configuration status of the device in NSM:

■ None—No state has been set (does not show in Device Monitor).

■ Modeled—The device exists in NSM, but a connection to the device
has not yet been established.

■ RMA—Equivalent to bringing the device into the Modeled state. RMA
results from an administrator selection in the UI when a device goes
down.

■ Waiting for 1st connect—NSM is waiting for the device to connect.
You must enter a command on the device to make it connect to NSM.

■ Import Needed—You must import the configuration of the device into
NSM. When you add a device for the first time, verify that your status
indicates “Import Needed” before you attempt to import the device.
During migration, this state indicates that import of the security device
configuration is still required.

■ OS Version Adjustment Needed—The firmware version detected
running on the device is different from what was previously detected
in NSM. This could happen in the event that the automatic adjustment
option was cleared during a change device firmware directive or an
Update Device directive was issued to an IDP device with a firmware
version mismatch.

■ Platform Mismatch—The device platform selected when adding the
DMI device in NSM does not match the device itself. A device in this
state cannot connect to NSM.

■ Device Firmware Mismatch—The OS version selected when adding a
DMI device does not match the OS version running on the device itself.

■ Device Type Mismatch—The type of device specified when adding the
device in NSM does not match the device itself. The device type might
indicate whether the device is part of a vsys device, part of a cluster,
or part of a virtual chassis. A device in this state cannot connect to
NSM.

■ Detected duplicate serial number—The device has the same sequence
number as another managed device. A device in this state cannot
connect to NSM.

■ Update Needed—An update to this device is required.

■ Managed—The device is currently being managed by NSM.

■ Managed, In Sync—The physical device configuration is synced with
the modeled configuration in NSM.

Config Status
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Table 59: Device Status Information (continued)

DescriptionColumn

■ Managed, Device Changed—The physical device configuration is out
of sync with the modeled configuration in NSM. Changes were made
to the physical device configuration (the configuration on the physical
device is newer than the modeled configuration).

■ Managed, NSM Changed—The modeled device configuration is out of
sync with the physical device configuration. Changes were made to
the modeled configuration (the configuration on the NSM is newer
than the physical device configuration).

■ Managed, NSM and Device Changed—Both device configurations
(physical and modeled) are out of sync with each other. Changes were
made to the physical device configuration and to the modeled
configuration.

■ Managed, Sync Pending—Completion of the Update Device directive
is suspended and waiting for the device to reconnect. This state occurs
only for ScreenOS devices that have the Update When Device Connects
option selected during the device update.

Config Status
(continued)

Connection status of the device in NSM:

■ Up—Device is currently connected to NSM.

■ Down—Device is not currently connected to NSM but has connected
in the past.

■ Never Connected—Device has never connected to NSM.

The Device Server checks the connection status of each device every
120 seconds by default. You can change this behavior by editing the
value for the devDaemon.deviceHeartbeatTimeout parameter in the
Device Server configuration file. Refer to the Network and Security
Manager Installation Guide for more information on editing
configuration files.

NOTE: If the network connection goes down for a period longer than six
to eight minutes, the device connection will permanently time out. If this
occurs and the device goes down for any reason, the device still appears
as Up in the Device Monitor.

Connection Status

Displays the current alarm status for each device in NSM:

■ If device has any alarms, the most severe alarm severity is displayed
(either Major or Minor).

■ None—The device has no alarms.

■ Unknown—The device status is unknown. For example, the device
might not be connected.

■ N/A—The device's alarm is not pollable or discoverable, for example,
this column shows "N/A" for ScreenOS and IDP devices.

■ Alarm is colored:

■ Red for Major.

■ Orange for Minor.

■ Green for Ignore, None, Unknown, or N/A.

Alarm
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Table 59: Device Status Information (continued)

DescriptionColumn

Displays the inventory status for hardware on the device:

■ In Sync—The inventory information in the NSM database is
synchronized with the information on the device.

■ Out Of Sync—The inventory information in the NSM database is not
synchronized with the information on the device.

■ N/A—The connected device is a ScreenOS or IDP device, or the device
is not connected and imported.

H/W Inventory
Status

Displays the inventory status for software on the device:

■ In Sync—The inventory information in the NSM database is
synchronized with the software on the device.

■ Out Of Sync—The inventory information in the NSM database is not
synchronized with the software on the device.

■ N/A—The connected device is a ScreenOS or IDP device, or the device
is not connected and imported.

S/W Inventory
Status

Displays the inventory status for software on the device:

■ In Sync—The inventory information in the NSM database is
synchronized with the licenses on the device.

■ Out Of Sync—The inventory information in the NSM database is not
synchronized with the licenses on the device.

■ N/A—The connected device is a ScreenOS or IDP device, or the device
is not connected and imported.

License Inventory
Status

The first time the security device connected to the NSM device server.First Connect

The last time the security device connected to the NSM device server.Latest Connect

The last time the security device disconnected from the NSM device server.Latest Disconnect

Related Topics Creating NSM Custom Reports on page 127■

■ NSM Logs and Reports Overview on page 119

Viewing NSM Predefined Reports

You can use the predefined reports to validate the effectiveness of your security
policies.

Table 60 on page 125 describes NSM DI/IDP predefined reports. These reports are
related to attacks.

Table 60: NSM DI/IDP Predefined Reports

DescriptionReport

Those attacks that are detected most frequently within the last 24 hours.Top 100 Attacks (last 24 hours)
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Table 60: NSM DI/IDP Predefined Reports (continued)

DescriptionReport

Those attacks that are prevented most frequently within the last 24 hours.Top 100 Attacks Prevented (last 24 hours)

IP addresses that have most frequently been the source of an attack during the
last 24 hours.

Top 20 Attackers (All Attacks - last 24
hours)

IP addresses that have most frequently been prevented from attacking the network
during the last 24 hours.

Top 20 Attackers Prevented (All Attacks -
last 24 hours)

IP addresses that have most frequently been the target of an attack during the
last 24 hours.

Top 20 Targets (last 24 hours)

IP addresses that have most frequently prevented attacks during the last 24 hours.Top 20 Targets Prevented (last 24 hours)

Number of attacks by severity level (set in attack objects).All Attacks by Severity (last 24 hours)

Number of attacks prevented by severity level (set in attack objects).All Attacks Prevented by Severity (last 24
hours)

All attacks detected during the last 7 days.All Attacks Over Time (last 7 days)

All attacks prevented during the last 7 days.All Attacks Prevented Over Time (last 7
days)

All attacks detected during the last 30 days.All Attacks Over Time (last 30 days)

All attacks prevented during the last 30 days.All Attacks Prevented Over Time (last 30
days)

All attacks categorized as “critical” detected during the past 24 hours.Critical Attacks (last 24 hours)

All attacks categorized as “critical” prevented during the past 24 hours.Critical Attacks Prevented (last 24 hours)

All attacks categorized as either “critical” or “ medium” detected during the past
24 hours.

Critical through Medium Attacks (last 24
hours)

All attacks categorized as either “critical” or “medium” prevented during the past
24 hours.

Critical through Medium Attacks Prevented
(last 24 hours) (last 24 hours)

IP addresses that have most frequently performed a scan of a managed device.Top 50 Scan Sources (last 7 days)

IP addresses that have most frequently been the target of a scan over the last 7
days.

Top 50 Scan Targets (last 7 days)

New hosts listed in the Profiler over the last 7 days.Profiler - New Hosts (last 7 days)

New ports listed in the Profiler over the last 7 days.Profiler - New Ports (last 7 days)

New protocols listed in the Profiler over the last 7 days.Profiler - New Protocols (last 7 days)

The total number of log entries generated by specific rules in your IDP policies.
You can use the Top Rules report to identify those rules that are generating the
most log events. This enables you to better optimize your rulebases by identifying
those rules that are most and least effective. You can then modify or remove
those rules from your security policies.

Top IDP Rules
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Table 61 on page 127 describes Profiler predefined reports. These reports are related
to activity by hosts in your network.

Table 61: NSM Profiler Predefined Reports

DescriptionReport

Ten source and destination IP addresses that appeared most frequently in the
Profiler logs.

Top 10 Peers by Count

Ten source and destination IP addresses that had the highest number of hits in
the Profiler logs.

Top 10 Peers with maximum hits

Table 62 on page 127 describes the predefined application volume tracking reports.
The reports are related to application use in your network.

Table 62: NSM: Application Volume Tracking Reports

DescriptionReport

Applications with the highest volume in bytes in the past 24 hours.Top 10 Applications by Volume

Application categories with the highest volume in bytes in the past 24 hours.Top 10 Application Categories by
Volume

Applications with the highest volume in bytes in the past 1 hour.Top 5 Applications by Volume over
Time (last 1 hour)

Application categories with the highest volume in bytes in the past 1 hour.Top 5 Application Categories by
Volume (last 1 hour)

Source IP addresses with the highest volume in bytes in the past 1 hour.Top 5 Source by Volume over Time
(last 1 hour)

Destination IP addresses with the highest volume in bytes in the past 1 hour.Top 5 Destination by Volume over
Time (last 1 hour)

Related Topics Creating NSM Custom Reports on page 127■

■ NSM Logs and Reports Overview on page 119

Creating NSM Custom Reports

Purpose You use custom reports if you require a view of data not covered by predefined
reports.

Action To create a custom report:

1. In the NSM navigation tree, select Investigate > Report Manager.

2. Select a pre-defined report with data similar to what you ultimately want to save.
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3. Select File > Save As.

4. Use pre-defined report as a template and example, complete the configuration
options, and click OK to save the new report settings.

Table 63 on page 129 describes configuration options.
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Table 63: Custom Report Configuration Options

DescriptionFieldTab

Specify a name for the report as you would like it to appear in the NSM navigation tree.NameGeneral

Specify a name for the report as you would like it to appear at the top of the report.Report Title

Select a report type:

■ Count-Based—Displays total current activity to date. For example, the Top Scan
Targets report is a count-based report that displays the total number of scans
currently recorded against a specified number of destination IP addresses.

■ Time-Based—Displays activity over time. For example, the Attacks Over Time
report is a time-based report that measures the top attacks recorded in log records
over a specified period.

■ Sum-Based—Displays the sum of the activities to date.

Type of Report

In reports, columns are the same as log fields.Columns for
Report

You can configure a report to display all available data from either a specific date and
time or during a specific time interval. For example, if you suspect that your network
was attacked on September 15 at 6:00 PM, you could set the Starting At Time Period
Duration report field in the options on a Top Screen Attacks report to that time, then
generate the report. If you are not sure of the exact date or time of the attack, but know
it occurred during the past 2 days, set the Duration field in the Time Period Duration
report options on a Top Screen Attacks report to two days, then generate the report.

NOTE: The data that you can display in each report is limited by the amount of log
information available.

Time Period

Typically, the top 50 occurrences of each data type are displayed in each report. You
can configure a report to display more or fewer data points depending upon the level
of detail you need. For example, if you want to obtain a more precise view of the top
occurrences of events, you would configure a lower data point count (such as 25).

NOTE: The minimum data point count that you can configure in all reports is 5; the
maximum data point count is 200.

Data point count

Select from the following choices:

■ Horizontal bar (default)

■ Pie

■ Line

■ Vertical bar

Chart type

In the first selection box, specify whether to save in the My Reports or Shared Reports
node.

In the second box, select the Others folder or type a new folder name.

Save Report In

The columns you selected on the General tab are passed through. Select the column
with the cursor to display the corresponding Filter Settings controls.

Columns for
Report

Filter

Specify filter values related to column settings.Filter Settings
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TIP: For information on deleting custom reports, organizing report folders, exporting
reports, and using the NSM guiSvrCli.sh command line utility and Linux cron utility
to automate reporting jobs, see the NSM online Help.

Related Topics NSM Logs and Reports Overview on page 119■

■ Intrusion Detection and Prevention Reporter Overview on page 133

Configuring Log Suppression

You can configure log suppression if you want to reduce the number of logs displayed
in the NSM log viewer. If you enable log suppression, NSM displays a single record
for multiple occurrences of similar events, along with a count of all such occurrences.

To enable and configure log suppression:

1. In the NSM Device Manager, double-click the IDP device to display the
configuration editor.

2. Click Sensor Settings.

3. Click Load-Time Parameters.

4. Complete the settings related to log suppression using Table 64 on page 130.

Table 64: IDP Configuration: Log Suppression Settings

DescriptionSetting

Log suppression is enabled by default. Use this setting to turn log suppression off and on.Enable log suppression

When log suppression is enabled, multiple occurrences of events with the same source IP,
service, and matching attack object generate a single log record with a count of occurrences.
If you enable this option, log suppression combines log records for events with the same
destination IP.

Include destination IPs when
performing log suppression

This number represents the number of identical log records received before suppression
starts. The default is 1 (meaning log suppression begins with the first redundancy).

Number of log occurrences after
which log suppression begins

When log suppression is enabled, IDP must cache log records so that it can identify when
multiple occurrences of the same event occur. This number represents the number of log
records in the IDP Management Server that IDP tracks for log suppression. The default is
16384 log records.

Maximum number of logs that
log suppression can operate on

When log suppression is enabled, the IDP device maintains a count of multiple occurrences
of the same event. This number represents the number of seconds that pass before IDP
reports a single log entry containing the count of occurrences. The default is 10 seconds.

Time (seconds) after which
suppressed logs will be reported

Determines the limit for logs stored on the IDP device. The default is 50,000. The minimum
value is 1,000. The maximum is 65,535.

Maximum number of logs that
can be stored
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Table 64: IDP Configuration: Log Suppression Settings (continued)

DescriptionSetting

Determines the limit for packet captures stored on the IDP device. The default is 10,000.

The minimum value is 100; the maximum is 1,000 packets. The maximum is 65,535.

Maximum number of packet
captures that can be stored

Related Topics ■ NSM Logs and Reports Overview on page 119

■ Configuring Syslog Collection (NSM Procedure) on page 76
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Chapter 12

Working with Intrusion Detection and
Prevention Reporter Reports

■ Intrusion Detection and Prevention Reporter Overview on page 133

Intrusion Detection and Prevention Reporter Overview

IDP reports are representations of log data, aggregated and sorted to facilitate network
and security analysis. The standalone IDP solution supports both centralized,
aggregated reporting through NSM and on-box reporting for a singular IDP device
instance through IDP Reporter.

You can perform the following reporting tasks:

■ View predefined reports on attacks.

■ Generate reports based on criteria you specify

■ Create jobs that regularly generate predefined or custom reports and e-mail them
to customers or other third-party organizations.

For more information on using IDP Reporter, see the IDP Reporter User’s Guide.

Related Topics ■ NSM Logs and Reports Overview on page 119

■ Creating NSM Custom Reports on page 127

■ Configuring Load-Time Parameters (NSM Procedure) on page 79
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